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Dear Learner,

Congratulations for having chosen the course on Web Development.  This course is
aligned with National Skill Qualification Framework (NSQF) of the Job Role: Web
Developer.

This course is specially designed keeping in your needs in mind.  We have ensured
that the course contents are presented in a simple, clear and logical manner.  We
expect you that as a Web Developer you would be able to design and maintain web
pages that include static and dynamic content. This includes the design, layout and
coding of a website.

We are confident that you will enjoy learning this course.

I hope you will find this material informative, interesting and useful.  We wish you all
the very best for a bright and successful future.

NIOS Course Team
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1

BASICS OF OFFICE
PRODUCTIVITY TOOLS

Now-a-days most of the airports, railways, offices, schools, college were using
computers for fast transaction and reduced paper work.  As a learner, you should
know about how to use computers for creating documents, doing calculations and
making presentations.  You can use office productivity tools for doing these tasks.
The office productivity tools or programs enable you to accomplish the basic tasks
such as creating formatted documents, doing calculations, storing data and making
presentations. There are many Office suites available in the market such as Microsoft
Office, Neo Office, OpenOffice, LibreOffice, Google Docs etc. In this lesson we
shall learn about open source software and prepare documents, spreadsheet and
presentation.

OBJECTIVES

After reading this lesson, you will be able to:

• define open source software;

• create text documents;

• open and save documents;

• format document;

• print the document;

• use spreadsheet for analysis and calculations;

• use basic inbuilt functions like Sum, Average, Max, Min, Count;
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• print the spreadsheet;

• make presentations using Impress with animation and transition effects.

1.1 OPENOFFICE

OpenOffice.org (OO.o), is an open-source office suite. It is free and its source code
is also available for modification.  It can be copied and redistributed.  The default
format of the OpenOffice suite file is Open Document Format (ODF).

Fig 1.1 : Office Suite

The OpenOffice.org suite contains a word processor (Writer), a spreadsheet (Calc),
a presentation application (Impress), a drawing application (Draw), a formula
editor (Math), and a database management application (Base).  In this lesson you
will learn about OpenOffice.org suite packages such as Writer, Calc and Impress.

Fig 1.2 : OpenOffice
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1.2 OPENOFFICE.ORG - WRITER

OpenOffice Writer is a word-processing application which helps you to create, edit
and print the text documents for example - writing letters, books, thesis etc.

1.2.1 OpenOffice Writer
To open the writer software you follow the steps:

1.2.2 The Writer Window Components
The following screen shows the components of the writer window.

Step 1: Click on Start -> All Programs

Step 2: Select OpenOffice 4.1.2

Step 3: Click on OpenOffice Writer

Fig 1.3 : Open Office Writer
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1. Title Bar – It is the topmost bar of the window which contains the name of
the file with the package name.

2. Menu Bar- It is placed below the title bar and contains all the menus and sub-
menus with the options.

3. Standard Toolbar – This toolbar contains all the commonly used commands
of the word processor such as New, Open, Close etc.

4. Formatting Toolbar – This toolbar contains all the formatting commands used
to make the text attractive and beautiful such as bold, italic, underline etc.

5. Horizontal Ruler – It enables the user to set the left and right margins of the
Writer document.

6. Vertical Ruler - It enables the user to set the top and bottom margins of the
Writer document.

7. Status bar  – It contains the information of the number of pages in an opened
document.  Status bar usually displayed at the bottom of the document.

Fig 1.4 : Writer Window components
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8. Work Area – It is the area where the user can type the text.

9. Vertical Scrollbar – It helps the user to scroll the screen up and down direction.

10. Horizontal Scrollbar –  It helps the user to scroll the screen in left and right
direction.

11. Zoom slider – It is used to zoom in and zoom out the screen. It works as
magnifier.

1.2.3 Create a Document

You follow these steps to create a new file in OpenOffice Writer.

1. Click on File menu.

2. Select Text Document Option.

Fig 1.5: Create a new document

The Writer window will open a new file with the name “Untitled 1”. You can change
the name of the file.

1.2.4 Save a Document
To save the Writer file, you follow these steps:

1. Click the File menu.

2. Select Save As option.
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3. Select the save location and give appropriate name to a file.

4. Click on Save button.

Your file will be saved at the selected location. Writer file is saved with .odt
extension. Do you know the extension of Microsoft word document? It is .doc
or .docx. You can also use Save As option, for saving a document. Save option
is used to save the changes in the document whereas Save As option is used
to give a new name to a file or create another copy of the same file.

Fig 1.6 : Saving a document

1.2.5 Open a Document
To open the existing file, following steps will be used:
1. Click on File Menu.
2. Select Open option.
3. Choose the required file and Click on Open button.

Fig 1.7 : Opening a New Document
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1.2.6 Format a Document
When you create a text document, the word processing software has already set
the default settings such as margins, font style and size, and the line spacing. But
these settings can be changed as per the user requirement using formatting options
available.  Fig 1.8 depicts formatting toolbar.

Fig 1.8 Formatting Toolbar

The formatting toolbar helps you to change the appearance of the document. The
commonly used commands used to make the text file more beautiful and attractive
are as follows:

1. Apply Style – It is used to apply different text styles, like Heading 1, Heading
2....

2. Font Name – It helps to apply different font types on the text.  Times New
Roman is the default font used in Writer.

3. Font Size – Font size starts from 6 to 99.  Default font size is 12.

4. Formatting options- The formatting options are bold, italic and underline.  You
can make the text bold, italic and underlined.

5. Alignment- It enables you to align the text left, right, center and justify on the
screen. By default the text is left aligned.

6. Numbering and Bullets – It helps you to insert the text in listing form. There
are two types of lists: Numbered list and Bulleted list.

7. Text Color – It helps you to make the text in different colours.

The following screen shows the formatted text:

Fig 1.9 : Formatted text document
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1.2.7 Print a Document
To print a document you follow the steps below:

1. Click on File menu.

2. Select Print option.

3. Print dialog box opens.

4. Set the options like number of copies you require, page number to be printed
etc.,  as per your need then click on Print button.

Fig 1.10 : Print a document

Now your document will be printed.  This printed copy of your document is the hard
copy of the document.

1.2.8 Close a Document
To  close  the file,  click  on  File menu,  and then select Close option as shown in
Fig 1.11.
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Fig 1.11 : Closing the document

1.2.9 Close the application
To close the application, follow the steps:

1. Click on File menu.

2. Select the Exit option.

Before closing the application it will ask you to save the
changes in the document.  If you select the discard option
then changes will not be saved but application window will
be closed.  If you select save option then it will save your
document and the application window will be closed.

Fig 1.12 : File Menu



10 :: Basics of Office Productivity Tools

Notes

WEB DEVELOPMENT

INTEXT QUESTIONS 1.1

1. Open Office is a ____________ software.

A. Open Source B. Proprietary C. Shareware D. None

2. Default text size of the writer document is______________________.

A. 8 B. 10 C. 12 D. 14

3. Writer files are saved with the extension.

A.  .doc B.  .fil C.  .odt D.  .wri

4. Which of the following helps you to set left and right margins of a document?

A. Standard toolbar B. Formatting toolbar

B. Horizontal ruler D. Vertical ruler

5. Which option is used to save changes in a document?

A. Save it B. Save As C. Print D. Open

1.3 OPENOFFICE.ORG –CALC
OpenOffice Calc is a spreadsheet application software used to calculate, analyze,
and manage data. It provides inbuilt and user defined functions to perform simple
and complex calculations.

1.3.1 OpenOffice Calc
To open Calc click on Start button �  All Programs �  OpenOffice 4.1.2 �
OpenOffice Calc � Select Spreadsheet.

Fig 1.13 : Spreadsheet application
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1.3.2 The Calc Window Components

Fig 1.14 : Calc window components

1. Title Bar

2. Menu Bar

3. Standard Toolbar

4. Formatting Toolbar

The usage of title bar, menu bar, standard toolbar and formatting toolbar is as
same as  in OpenOffice writer.

5. Address Bar – The contents of active cell can be seen and modified in address
bar.

6. Rows-In calc rows are horizontally placed on the worksheet and referred by
the numbers like 1,2,3…. and so on.

7. Columns – In calc columns are vertically placed on the worksheet and referred
by the alphabets like A,B,C…. and so on.

Active Cell-where
the user can insert
the data.
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8. Worksheet – It is the combination of rows and columns.

9. Vertical Scrollbar – It helps the user to scroll the worksheet in up and down
direction.

10. Horizontal Scrollbar -  It helps the user to scroll the worksheet in left and
right direction.

11. Zoom Slider – It is used to zoom in and zoom out the screen. It works as
magnifier.

12. Sheet Tabs – It shows the number of sheets included in a workbook. By default
there are three worksheets included in a workbook but you can add more
worksheets.

Cells are the intersection of rows and columns in a worksheet.  Every cell in a
worksheet is referred by a cell address. Address or reference of a cell is the
combination of row and column. Example – A1, where “A” is the column and “1”
is the row.  Each calc file is called as workbook.

1.3.3 Create a New Workbook
To create a new workbook in Calc, follow the steps:

1. Click on File menu.

2. Select New -> Spreadsheet.

Fig 1.15 : New workbook
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The new spreadsheet with the name “Untitled 1” (as shown in Fig 1.15) will open
but you can change the name of the worksheet.

1.3.4 Save a Workbook
To save the workbook in Calc, use the following steps:

1. Click on File menu.

2. Select Save As option. Save As dialog box opens (as shown in Fig 1.16).

Fig 1.16 : Saving a Workbook

3. Give a name to the file.

4. Select the location to save the file.

5. Click on Save button.

The workbook in Calc is saved with .ods extension.

1.3.5 Open a Workbook
The following steps will be used to open an existing workbook:

1. Click on File menu.

2. Select Open option.  Open dialog box opens (as shown in Fig 1.17).
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3. Choose the required file and click on open button.

Fig 1.17 : Opening a Workbook

1.3.6 Enter Data in a worksheet
In Calc, you can enter data in cells.  You already know the selected cell is called as
an active cell.  The data can be entered or edited in an active cell. You can enter
text, numbers and functions in the cell.  Fig 1.18 shows some spreadsheet data
entered.

Fig 1.18 : Spreadsheet data
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You can modify / delete the entered data. To delete the data in a cell: select the cell
and press Delete button.

1.3.7 Functions in Calc

Functions in Calc are the inbuilt formulas which helps the user to calculate the data

values correctly. Functions always start with the “=” (equal to) sign followed by the

function name and range of values.  In calc there are lot of functions are available

like mathematical, database, date and time, information etc.

Commonly used functions are:

1. Sum – used to calculate the total of values in a range.

Syntax : =Sum(A1:G1)

2. Average - used to calculate the average of values in a range.

Syntax : =Average(A1:G1)

3. Max – used to find the maximum value from a range of values.

Syntax : =Max(A1:G1)

4. Min– used to find the minimum value from a range of values.

Syntax : = Min(A1:G1)

5. Count – used to count the number of values from a range of values.

Syntax : =Count(A1:G1)

The collection of consecutive cells is called as cell range. Let us understand the

working of spreadsheet by this example.  Fig 1.19 shows the data in the spreadsheet.

Now using this data you can calculate the total marks, average, maximum, minimum

marks of students.

Note: the data in a cell can be formatted using options present on the

formatting toolbar.
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Fig 1.19 : Use of function

To calculate the total, place the cursor on H3 and select functions  and select
SUM function from functions.

 Fig 1.20 : Functions

You can use AVERAGE function for finding average. For finding the maximum and
minimum marks you can use MAX and MIN function like = MAX(C3:G3) and
=MIN(C3:G3).
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1.3.8 Print a Worksheet
To print the worksheet, follow the steps:

1. Click on File menu.

2. Select the Print option. Print dialog box opens (as shown in Fig 1.21).

3. Choose the printer, range and copies then click Print button.

1.3.9 Close a Workbook
To close the workbook click on File menu -> select Close option.

Fig 1.21 : Printing a workbook
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Fig 1.22 : Closing a workbook

The workbook will be closed.

1.3.10 Exit Calc application
To close the Calc application, follow the steps:

1. Click on File menu.

2. Select the Exit option.

Fig 1.23 : Exit calc
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INTEXT QUESTIONS 1.2

1. Open Office Calc is a ____________ software.

 A. Database B. Presentation

C. Word Processor D. Spreadsheet

2. A Workbook in Calc saved with the extension ____________ .

A. .xls B. .wbk C. .cal D.  .odc

3. The formula   =sum(A1:P3) will find the sum of values ________.

A. in the cells A1 and P3.

B. in the cell range A1 to P3.

C. in the cell range A1 to P3 except A1 and P3.

D. out of the range A1 to P3.

4. By default there are ___________________ worksheets in Calc.

A. 1 B. 2 C. 3 D. 6

1.4  OPENOFFICE.ORG –IMPRESS

OpenOffice Impress is a presentation software which enables you to create your

own multimedia presentations. In impress you can create animated presentations

including audios and videos.

1.4.1 OpenOffice Impress

Following steps will be used to open the impress software:

1. Click on Start button.

2. Select All programs option.

3. Click on OpenOffice 4.1.2.

4. Choose OpenOffice Impress.
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Fig 1.24 : OpenOffice Impress

Fig 1.25:  Impress window components

1.4.2 The Impress Window Components
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1. Title Bar

2. Menu Bar

3. Standard Toolbar

The usage of title bar, menu bar and standard toolbar is as same as  in
OpenOffice Writer and Calc.

4. View Pane – This toolbar contains all the views in which presentation can be
seen such as Normal, Outline, Notes, Handout, and Slide Sorter view.

5. Work Space – The current slide will be shown in work space of Impress
window.

6. Slide Pane - All the inserted slides are displayed in this pane.

7. Horizontal Scrollbar - It helps the user to scroll the slide in left and right
direction.

8. Layout Pane– All the layouts are visible in this pane which is selected at the
time of presentation creation.

9. Vertical Scrollbar – It helps the user to scroll the slide in up and down direction.

10. Drawing Toolbar - It helps the user to include any drawing objects in the
slides.

11. Zoom Slider – It is used to zoom in and zoom out the screen. It works as
magnifier.

There are five views in Impress:

1. Normal View – This is the default view which helps the user to work with
each slide individually.

2. Outline View – This view displays all the headings, sub headings and lists
included in all the slides of a presentation.

3. Notes View – This view helps the user to insert the notes for the reference
purpose on each slide.

4. Handout View – This view helps the user to give the highlights of the
presentation to the audience.

5. Slide Sorter View – This view displays the thumbnails of the slides and helps
the presenter to arrange them in any chronological order.

1.4.3 Create a New Presentation
There are two ways to create a new presentation:

1. Empty Presentation – will open a blank presentation.
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2. From template – will open the presentation with the predefined backgrounds
and themes.

Follow the steps to create a new presentation:

1. Select the type of presentation.

Fig 1.26 : Select the type of presentation

2. Select the presentation background and click on Next button.

Fig 1.27 : Presentation Wizard

3. Select the transition effect and the presentation type.
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Fig 1.28: Transition effect

Transition effect is the effect which is applied on the slides when one slide enters
and other slide exit from the slide show.

4. Click on Create button.

The following window will appear on the screen.

Fig 1.29 : Presentation Screen

1.4.4 Save a Presentation
To save the presentation, follow the steps:

1. Click on File menu.

2. Select the Save option. Save As dialog box opens.

3. Choose the location to save file.

4. Give a relevant name to your presentation.
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5. Click on save button.

Your presentation will be saved with .odp extension.

Fig 1.30 : Save As dialog box

1.4.5 Open a Presentation
To open an existing presentation, follow the steps:

1. Click on File menu.

2. Choose Open option. Open dialog box opens.

3. Select the presentation to be opened.

4. Then click on Open button.

Fig 1.31 : Open a presentation
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1.4.6 Close a Presentation

To close the opened presentation following steps will be used:

1. Click on File menu.

2. Select the Close option.

Fig 1.32 : Close a presentation

The current presentation will be closed.

1.4.7 Adding, Deleting slides in a presentation
To add the slides in the presentation:

1. Click on Insert menu.

2. Select Slide option.
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Fig 1.33 : Inserting a slide

To delete slides in the presentation, follow these steps.

1. Select the slide to be deleted in the Slides pane on the left side of the screen.

2. Press delete button from the keyboard.

1.4.8 Animations in Impress

Animations are the moving effects which can be applied to a text or image included

in a slide.  You can add animation effects to your presentation.  Follow the steps to

add animation effects.

1. Click on Slide Show menu.

2. Select Custom Animation option.
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                                                                                   Fig 1.34 : Select custom animation

3. Select the animation effect.

4. Set the speed of the animation effect.

5. Click on OK button.

Fig 1.35 :Select the animation effect
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The selected animation effect will be applied to the selected image or text.

1.4.9 Slide Show

The Slide show feature of Impress software helps you to run all the slides as a show

with embedded animation effects.

To run the slide show, follow the steps:

1. Click on Slide Show menu.

2. Select Slide Show option or press F5 key from the keyboard.

Fig 1.36 : Choose Slide show

The slide show will run on the screen.
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Fig 1.37 : Slide show

1.4.10 Exit Impress application

To close the Impress application, follow the steps:

1. Click on File menu.

2. Select the Exit option.

3. The Impress window will be closed.

Fig 1.38 : Exit impress
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INTEXT QUESTIONS 1.3

1. OpenOffice Impress is a ____________ software.

A. Database  B. Presentation

C. Word Processor D. Spreadsheet

2. ___________ view is used to arrange the order of the slides in a presentation.

A. Normal B. Outline

C. Slide Sorter D. Handout

3. A presentation in OpenOffice.org Impress is saved with the
_________extension.

A. .odc B. .odp

C. Odx D. .odpp

4. ______________________ key is used to run the Slide Show in Impress.

A. F5 B. F12

C. F4 D. F6

WHAT YOU HAVE LEARNT

In this lesson you have learnt about what is an open source software,  open office
productivity tools and also learnt how you can format the document in different ways.
You have also learnt that OpenOffice Writer is a word-processing application used
to create the text documents used for writing letters, books, thesis etc.  Open office
Calc help us in calculations by using functions like sum, max, min, count etc.  Using
Open Office Impress you can make attractive and animated presentations.

TERMINAL EXERCISE

1. What is an OpenOffice.org?

2. What is the use of OpenOffice Writer?

3. What is the difference between OpenOffice Calc and OpenOffice Impress.

4. Explain any two functions of Calc with example.

5. Write a short note about views of OpenOffice Impress application.

6. Give the extension of the files of OpenOffice

a) Writer b) Calc c) Impress.
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ANSWERS TO INTEXT QUESTIONS

1.1

1. A. Open Source

2. C. 12

3. C . odt

4. B. Formatting Toolbar

5. B. Save As

1.2

1. D. Spreadsheet

2. D .ods

3. B. In the cell range A1 to P3

4. C. 3

1.3

1. B. Presentation

2. C. Slide Sorter

3. B. .odp

4. A. F5



32 :: Basics of HTML and CSS

Notes

WEB DEVELOPMENT

2

BASICS OF HTML AND CSS

HTML (Hypertext Markup Language) is a language having collection of keywords
called ‘Tags’ used to create a web document. It is a platform independent language
that can be used on any platform such as Windows, Linux, Macintosh, and so on.

Do you know that it is essential to mark-up the different elements (headings, body,
paragraphs, tables, and so on) of the document with the HTML tags to display a
document on the web? The elements may include one or more attributes that are
included inside the tag. For Example: attribute - align (left, right, center and justify)
can be used to align the text inside paragraph. To view a mark-up document, user
has to open the document in a browser.

HTML also provides tags to make the document look attractive using graphics, font
size and colors. You can make a link to the other document or the different section
of the same document by creating hypertext links, known as hyperlinks. All the
web sites in the web that consist of web pages are created using HTML.  In this
lesson we shall learn to create, save and view a HTML document and also learn
about CSS.

OBJECTIVES

After reading this lesson, you will be able to :

• create, save and view a HTML document;

• format a web page;

• use of graphics in HTML document;

• use of hypertext links, making text/image links to external/same document.
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2.1 CREATING, SAVING AND VIEWING HTML DOCUMENT

Websites consisting of webpages are created using the language Hypertext Markup

Language (HTML). Each HTML document corresponds to a single web page.

HTML document is written in the form of HTML elements consisting of ‘tags’. An

HTML tag has a left angular bracket (<), followed by name of the tag, and closed

by a right angular bracket (>). Tags are not case-sensitive i.e. there is no difference

in small and capital letters in tags. HTML elements can be categorized as container

elements and empty elements.

Container Elements: Tags which have both the opening and closing i.e. <TAG>

and </TAG> are called container elements. The closing tag is the same as the opening

tag, except for the slash (/) mark. Container Elements hold the text and other HTML

tags in between the tags. The <HTML>, <HEAD>, <TITLE> and <BODY> tags

are all container tags.

Example:

<BODY>

This is a container tag. It holds both the text and HTML tag

</BODY>

Empty Elements: elements which have no content are called empty elements.
Empty elements do not have closing tags. <HR>, which is used to draw Horizontal
rule across the width of the document, line break <BR> tags are empty tags.

2.1.1 Creating a HTML document

The essential elements that are required to create a HTML documents are:

• HTML Element

• HEAD Element

• BODY Element

HTML Element

Every HTML document must include the opening <HTML> tag at the top of the
file, and the closing </HTML> tag at the very end of the file. An HTML document
has two distinct parts HEAD and BODY element.

The Format is:

  <HTML>

<HEAD>
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————

————

</HEAD>

<BODY>

————

————

————

</BODY>

  </HTML>

HTML Attributes

HTML elements can have attributes that provide additional information about an
element. Attributes are always specified in the start tag and come in name value
pairs like: name=“value”, eg: <BODY BGCOLOR= “yellow”>

HEAD Element

The Head element contains an unordered collection of information about the HTML
document.  It comes after the HTML start tag. It contains TITLE element to give
the document a title that displays on the browsers title bar at the top.

BODY Element

The BODY element contains all the text and graphics of the document with all the
HTML tags that are used to control and format the page.

An HTML document, web page can be created using a text editor, Notepad, WordPad
or any HTML editor. All the HTML documents should have the extension .htm or
.html. A web browser like Internet Explorer or Mozilla Firefox or Chrome or Safari
Netscape Navigator/Communicator is required to view the document.

Example: It’s my first web page

Follow the steps to create an HTML document and view in browser:

Step-1: Open text editor Notepad (click on start → AllPrograms → Accessories
→Notepad).

Step-2: Enter the following lines of code:

<HTML>

<HEAD>
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<TITLE>

My first Page

</TITLE>

</HEAD>

<BODY>

WELCOME TO MY FIRST WEB PAGE

</BODY>

</HTML>

Step-3: Save the file as myfirstpage.html (go to File, choose SaveAs, type: All
Files give File name: ‘myfirstpage.html’. Click save.

Step-4: Viewing document in web browser (open Internet Explorer, click on File→
Open →  Browse select the file myfirstpage.html Click Open.click OK.)

Fig. 2.1 : Shows creating and saving the HTML document using Notepad
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Fig. 2.2 : Viewing HTML document myfirstpage.html in browser

Attributes used with <BODY>

� BGCOLOR: used to set the background color for the document.

Example:

<BODY BGCOLOR="yellow">

Your document text goes here.

</BODY>

� MARGINS: set the left hand/right hand margin of the document.

LEFTMARGIN: set the left hand margin of the document.

Example:

<BODY LEFTMARGIN="60">

This document is indented 60 pixels from the left hand side of the page.

</BODY>

� TOPMARGIN: set the top margin of the document.

Example:

<BODY TOPMARGIN="60">

This document is indented 60 pixels from the top of the page.

</BODY>

� BACKGROUND: used to point to an image file with an extension .gif(Graphic
Interchange Format), .jpeg(Joint Photographic Expert Group) that will be used
as the background of the document. The image file will be tiled across the
document.
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Example: An HTML document attribute.html that shows the use of attributes
with the <BODY> tag

<HTML>

<HEAD>

<TITLE>

Use of Attributes with the Body Tag

</TITLE>

</HEAD>

<BODY BACKGROUND="computer.gif" text="blue"  TOPMARGIN="75"
LEFTMARGIN="75">

Your document text will be indented 75 pixels from the left hand and 75 pixels
from the top of the page. The background image computer.gif will be tiled across
the document. Your image and HMTL document should present at the same place.

</BODY>

</HTML>

N.B: Ensure that image “computer.gif” is available in the same path where the
attribute.html is stored.

Fig 2.3 : Use of Attributes with the body tag
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N.B: Attributes BACKGROUND and BGCOLOR are declared as Deprecated
(Deprecated tags and attributes are those that have been replaced by other, newer,
HTML constructs.) in HTML 4.0.

Browsers should continue to support deprecated tags and attributes, but eventually
these tags are likely to become obsolete and so future support cannot be guaranteed.
Therefore it is suggested to avoid using this tag further. All these deprecated attributes
can be replaced by style-sheet controls, discussed in later point of this lesson.

INTEXT QUESTIONS 2.1

1. The language that is used to create document on the World Wide Web is:

A. HML B. HTML C. UML D. VRML

2. HTML is a __________________ language.

A. markup B. programming

3. An HTML document has two distinct parts _________ and _________.

A. Start and End B. Head and tail

C. Head and Body D. Start and close

4. In which part of a web page <TITLE> tag to be used ______________.

A. head B. body

C. footnote D. anywhere

2.2 FORMATTING WEBPAGE

HTML tags used for formatting a web page are:

Section Heading:<H1>————<H6>

Headings are used to define the structure of the document.  HTML has six header
tags <H1>, <H2>———<H6>.  These can be used by you to specify section
headings. Text with header tags is displayed in larger and bolder fonts than the normal
body text by a web browser. Every header leaves a blank line above and below it
when displayed in browser.

Example: An HTML document, headings.html shows the different section
headings.

 <HTML>

<HEAD>
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<TITLE>

Section Heading

</TITLE>

</HEAD>

<BODY>

<H1> This is Section Heading 1 </H1>

<H2> This is Section Heading 2 </H2>

<H3> This is Section Heading 3 </H3>

<H4> This is Section Heading 4 </H4>

<H5> This is Section Heading 5 </H5>

<H6> This is Section Heading 6 </H6>

</BODY>

</HTML>

Fig. 2.4 : Viewing HTML document headings.html in browser
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Some peculiarities about the web browser on viewing HTML document text:-

� Browsers ignore extra space within HTML document

Browsers ignore any additional space you type, and compress the text as if the space
did not exist. For Example: You can have text  “My First
Page” in HTML document but in browser it displays, “My First Page”.

� Browsers ignore your extra line and paragraph breaks

Generally you press enter when you want to create line and paragraph breaks, but
it will not be displayed when you view the document in browser.

In order to control your paragraph and line breaks <P> and <BR> tags are used.

2.3 USING PARAGRAPH TAG:<P>

This tag <P> indicates a paragraph, used to separate two paragraphs with a blank
line.

Example:

<P> Welcome to the world of HTML </P>

<P> First paragraph.

Text of First paragraph goes here </P>

Output:

Fig. 2.5 : Using paragraph tag



Basics of HTML and CSS :: 41

Notes

WEB DEVELOPMENT

Here, two paragraphs are separated with a line. But web browser ignores the line
breaks in the second paragraph that can be controlled by putting <BR> tag.

2.4 USING LINE BREAK TAG: <BR>

You can use empty tag<BR> at places where the text needs to start from a new

line and not continue on the same line. To get every sentence on a new line, it is

necessary to use a line break.

Example:

<BODY>

National Institute of Open Schooling <BR>

       A 31, Institutional Area, Sector – 62 <BR>

Distt - GautamBudh Nagar, Noida, Uttar Pradesh, India

</BODY>

Output:

Fig. 2.6 : Using <BR> tag

2.5 USING PREFORMATTED TEXT TAG:<PRE>

You can use <PRE> tag, where it requires total control over spacing and line breaks
such as typing a poem. Browser preserves your space and line break in the text
written inside the tag.
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Example:

<BODY>

<PRE>

National Institute of Open Schooling

                   A 31, Institutional Area, Sector – 62

Distt - GautamBudh Nagar, Noida, Uttar Pradesh, India

</PRE>

</BODY>

Output:

Fig. 2.7 : Using <PRE> tag

2.6 USING HORIZONTAL RULE TAG:<HR>

An empty tag <HR> is basically can be used by you to draw lines and horizontal
rules and to separate two sections of text.

Example:

<BODY>

Your horizontal rule goes here.

<HR>

The  rest of the text goes here.

</BODY>

Output:

Your horizontal rule goes here.

The rest of the text goes here.
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<HR> accepts following attributes:

� SIZE: Determines the thickness of the horizontal rule. The value given is a pixel
value.

Example:<HR SIZE="3">

� WIDTH: Specifies an exact width of HR in pixels, or a relative width as
percentage of the document width.

Example:<HR WIDTH="50%">, horizontal rule 50% of the page width will
be displayed on your screen.

� COLOR: Set the color of the Horizontal rule.

Example:<HR COLOR="BLUE">

Example of <HR> with its attribute:

<HR  WIDTH="50%" SIZE="3"  COLOR="BLUE">

N.B: Attributes SIZE, WIDTH and COLOR are declared as Deprecated
(Deprecated tags and attributes are those that have been replaced by other, newer,
HTML constructs.) in HTML 4.0.

2.7 CHARACTER FORMATTING TAGS

You can apply character formatting tags to specify how a particular text should be
displayed on the screen to distinguish certain characters within the document.

The most common character formatting tags are:

• Boldface <B>: displays text in BOLD.

Example: Welcome to the <B> Internet World </B>

Output: Welcome to the Internet World

• Italics <I>: displays text in Italic.

Example: Welcome to the <I> Internet World </I>

Output: Welcome to the Internet World

• Subscript <SUB>: displays text in Subscript.

• Superscript <SUP>:displays text in Superscript.

• Small <SMALL>: displays text in smaller font as compared to normal font.

• Big <BIG>: displays text in larger font as compared to normal font.
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2.8 USING SOME SPECIAL CHARACTERS

You can make use of certain special characters while creating document. These
are called HTML entities.  Some are listed in the table below:-

Following are some special character:

  Symbols

©, ®

¼, ½, ¾,

÷, <, >,<=, >=

&

�,�,�

& nbsp

All these special character must be ended with a semicolon;

Example:<PRE>

The copyright symbol is: &COPY;

The registered rank is: &REG;

</PRE>

Output: The copyright symbol is:©

The registered rank is:®

2.9 USING LIST IN WEB PAGE

HTML supports several ways of arranging items in lists. The most commonly used
are:

• Ordered List (Numbered List)

• Unordered List (Bulleted List)

Ordered List <OL>

Ordered list also called as Numbered list, is used to present a numbered list of
item in the order of importance.

You have to begin ordered list with the <OL> followed by an <LI> list item
tag.

Entity

&copy, &reg

&frac14, &frac12, &frac34

&divide, &lt, &gt, &le, &ge

&amp

&spades, &clubs, &hearts

insert space
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Example: An HTML document orderedList.html shows the use of Ordered List

<HTML>

<HEAD>

<TITLE>

       An Ordered List

</TITLE>

</HEAD>

<BODY>

<H1><U> Various Terms Used In Internet</U></H1>

<OL>

<LI> WWW-World Wide Web</LI>

<LI> URL-Uniform Resource Locator</LI>

<LI> HTTP-Hypertext Transfer Protocol</LI>

<LI> FTP-File Transfer Protocol</LI>

<LI> HTML-Hypertext Markup Language</LI>

</OL>

</BODY>

</HTML>

Fig. 2.8: Viewing HTML document orderedList.html in browser



46 :: Basics of HTML and CSS

Notes

WEB DEVELOPMENT

2.9.1 Attributes of <OL> tag:

� COMPACT: render a list in compact form.

� TYPE: allows marking list items with different types. By default the list Item
markers are set to numbers 1,2,3… so on.

Other values of TYPE attribute are:

Attribute

Type = A

Type = a

Type = I

Type = i

Type = 1

� START: used for lists that need to start at values other than 1. START always

specified in default numbers, and is completed based on TYPE before display.

For example, If START =5 it would display either an ‘E’, ‘e’, ‘V’, ‘v’, or ‘5’

based an TYPE attribute.

2.9.2 Unordered List <UL>
Unordered List also called as bulleted list can be used by you to present list of items
marked with bullets. An unordered list starts with in <UL> followed by <LI> (List
Item) tag. Use of <UL> is very similar to <OL> (ordered list).

Example:Use of Unordered List and Various Attributes

<HTML>

<HEAD>

<TITLE> Use of Unordered List </TITLE>

</HEAD>

<BODY>

<UL>

<LI> FRUITS</LI>

<UL>

<LI> Apple</LI>

<LI> Mango</LI>

<LI>Orange</LI>

Description

Capital letter eg. A, B, C………

Small letter eg. a, b, c,………

Uppercase Roman Numbers eg. I, II, III……

Lowercase Roman Numbers eg. i, ii, iii……

  eg.  1, 2, 3………….
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</UL>

<LI> VEGETABLE</LI>

<UL>

<LI>Brinjal</LI>

<LI> Cabbage</LI>

<LI> Tomato</LI>

</UL>

</BODY>

</HTML>

Fig. 2.9: Displaying Unordered Lists in browser

The unordered list also used the attributes COMPACT and TYPE = CIRCLE or
DISC (filled Circle used as a bullet).

INTEXT QUESTIONS 2.2

1. Which of the following is a line break tag:

A.<lb> B.<br>  C.<hr>      D.<break>

2. HTML has ______________ header tags.

A. 6 B. 7 C. 5 D. 8
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3. The ________ tag is used for bulleted, unordered list.

A. <UL> B. <OL> C.<BL> D. <UO>

4. In order to create an ordered list we can use the tag:

A. <ul>….</ul> B.<p>….</P>

C.<A>….</A> D.<ol>…..</ol>

2.10 USING GRAPHICS IN WEB PAGE <IMG>

Graphics enhance user acceptability and aesthetic value of a document. It makes
the document interesting and easier for you to understand. You can use three image
formats in web pages: GIF(Graphics Interchange Format), JPEG(Joint Photographic
Experts Group), and PNG(Portable Network Graphics).

Image tag is an empty tag (only start tag, no end tag) and is written as:

<IMG SRC = "image_URL">

Here SRC represents – source of the image file and image_URL  represents the
image file name with its location.

Example:<IMG SRC="file:///C:/NIOSlogo.GIF">

Here,  image is available in the Hard Drive C: on the local hard disk. This SRC
attribute is mandatory for the <IMG> tag.

Other attributes used with <IMG>are: -

� HEIGHT AND WIDTH

� ALT

� BORDER HEIGHT and WIDTH

Height and width of an image can be controlled by using the HEIGHT and WIDTH
attributes in the <IMG> tag as follows:

Example:<IMG SRC= "NIOSlogo.gif” HEIGHT="320" WIDTH="240">

You can use ALT to give alternative text that can be displayed in place of the image.
This is required when you need to stop display of images while retrieving a document
in order to make the retrieval faster, or when the browser does not support graphics.
It is also used a tool tip – displaying description of the image when the mouse is
over the image. It is mandatory to use alt attribute with every image. If the image is
for decoration then alt = " " may be used.

Example:<IMG SRC="NIOSlogo.gif" ALT = "Logo of NIOS ">

BORDER
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Border around the image can be controlled by using BORDER attribute of <IMG>
tag. By default image displays with a thin border. You can also change the
thickness or turn the border off the value in pixels should set to BORDER attribute.

Example:<IMG  SRC="NIOSlogo.gif" BORDER=0>

BORDER =0 to turn the border off

Example:<IMG SRC="NIOSlogo.gif" BORDER=3>

BORDER=3 to make the border thickness to 3

N.B: Border attribute is now declared as Deprecated (Deprecated tags and
attributes are those that have been replaced by other, newer, HTML constructs.) in
HTML 4.0.

2.11 WORKING WITH LINKS: <A> ANCHOR TAG

Web pages are linked to one another through hypertext links. Your section of text or
image in the HTML document can be linked to an external document or to a specific
place within the same document. The text or image that provides such linkage is
known as hypertext or Hotspot.

You can create links also.  HTML provides <A> Anchor Tag to create links. The
format of using anchor tag is as follows:

<A HREF ="URL"> Make Me The Link </A>

HREF (Hyper Link Reference) is a mandatory attribute used to refer the URL
of the resource. URL (Uniform Resource Locator) is an address tells the browser
about the file to link to. It identifies file locations (Addresses) on the web or on the
local hard drive. These addresses can be those of HTML documents or elements
such as images, scripts, applets and other files. It is enclosed in quotes.

Linking a text to a website / an external document

Example:

<A HREF = "http://www.nios.ac.in">Link to Website of NIOS</A>

In the above example the link text “Link to Website of NIOS” would appear
underlined and in a color different from any other text in the document to distinguish
a link from normal text. Also you would find that the mouse pointer changes into a
hand like symbol when taken over the hyperlink.

Linking an image to website
An image can be linked to a website or an HTML document.
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Example:

<A HREF = "http://www.nios.ac.in" ><IMG SRC="NIOSlogo.GIF" BORDER=3>
</A>

Linking (jumping) to a specific place within the same document
Sometimes, it is required for you to jump different sections in the same document.
For this it needs two steps, first identify section with a name and then jumps to the
location using the name used.

The syntax is:

1. <A HREF= "#section_name"> link to another section of the same document
</A>

This link text jumps to the section named with HREF on click. The # symbol
before the section name is must.

2. <A NAME= "section_name"> Beginning of the section </A>

The NAME attribute is used to identify a section with a name. It is an unique
identifier within the document for the anchor.

You can also jump to a specific section of different document specifying the
path on HREF attribute.

Example:

Within the same document:<A HREF="#section_name">

Same folder, but different document:<A HREF="document.html#
section_name">

Different folder, different document: <A HREF="folder/document.
html#section_name">

A different server: <A HREF= "http://www.nios.ac.in/foldername/
document.html#section_ name">

Attributes used with <A> Anchor Tag
TITLE

This attribute is used to provide additional/advisory information (expand on the
meaning of the link). The anchor text is supposed to “name” the link, while the title
text provides information about where the link will send the user.

Title attribute must be used with non descriptive links like ‘click here’ or ‘Read More’.
Title attribute increase site’s usability and accessibility level.
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Example: Use of Anchor Tag

<HTML>

<HEAD><TITLE> Use of Anchor Tag</TITLE></HEAD>

<BODY>

<A HREF="http://www.nios.ac.in" TITLE="Click here to access National Institute
of Open Schooling(NIOS) website"> Click here to Access NIOS Website</A>

</BODY>

</HTML>

Fig. 2.10 : Example using Anchor Tag <A> in Browser

2.12 IMAGE MAPPING

The technique of making link(s) in different parts of an image to several pages is
called as image mapping.  You simply specify which areas of the image should link
to where.

The <map> tag is used to define a client-side image-map. An image-map is an image
with clickable areas. The required name attribute of the <map> element is associated
with the <img>’s usemap attribute and creates a relationship between the image
and the map. The <map> element contains a number of <area> elements that defines
the clickable areas in the image map.
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Example:

<HTML>

<BODY>

<P>Click on the sun or on one of the planets to watch it closer:</P>

<IMG SRC="PLANETS.GIF" WIDTH="145" HEIGHT="126" ALT="PLANETS"
USEMAP="#PLANETMAP">

<MAP NAME="PLANETMAP">

<AREA SHAPE="RECT" COORDS="0,0,82,126" ALT="SUN"
HREF="SUN.HTM"">

<AREA SHAPE="CIRCLE" COORDS="90,58,3" ALT="MERCURY"
HREF="MERCUR.HTM">

<AREA SHAPE="CIRCLE" COORDS="124,58,8" ALT="VENUS"
HREF="VENUS.HTM">

</MAP>

</BODY>

</HTML>

Source: http://www.w3schools.com

N.B:Ensure that image “Planets.gif” and the page sun.htm, mercur.htm and
venus.htm are available in your system at one place.

There are three different shapes (commonly termed “hot spots”) that can be used
in image maps. Those are as follows:

- RECT

- CIRCLE

- POLYGON

2.13 CASCADING STYLE SHEETS (CSS)

Cascading Style Sheets, generally referred to as CSS, is a simple design language
intended to simplify the process of making web pages presentable. CSS is created
and maintained through a group of working people called as  World Wide Web
Consortium or W3C.

CSS is easy to learn and understand, but it provides powerful control over the
presentation of an HTML document. Most commonly, CSS is combined with the
markup languages HTML or XHTML.
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The Advantages of CSS are:

•    CSS handles the look and feel part of a web page. Using CSS, you can control
the color of the text, the style of fonts, the spacing between paragraphs, how
columns are sized and laid out, what background images or colors are used, as
well as a variety of other effects.

• CSS saves time : You can write CSS once and then reuse same sheet in multiple
HTML pages. You can define a style for each HTML element and apply it to
as many webpages as you want.

• Pages load faster - If you are using CSS, you do not need to write HTML tag
attributes every time. Just write one CSS rule of a tag and apply to all the
occurrences of that tag.

• Easy maintenance - To make a global change, simply change the style, and all
elements in all the web pages will be updated automatically.

• Superior styles to HTML - CSS has a much wider array of attributes than HTML,
so you can give far better look to your HTML page in comparison of HTML
attributes.

• Multiple device compatibility - Style sheets allow content to be optimized for
more than one type of device. By using the same HTML document, different
versions of a website can be presented for handheld devices such as Personal
Digital Assistants (PDAs) and cell phones or for printing.

•   Global web standards - Now HTML attributes are being deprecated and it is
being recommended to use CSS. So its a good idea to start using CSS in all the
HTML pages to make them compatible to future browsers.

Types of CSS

The three types of CSS style declaration are as follows:

1. Internal (Embedded) Styles are defined in the <HEAD> section of the current
web page.

           Declaration: <STYLE type="text/css"></STYLE>

2. Inline Styles are defined within the HTML markup of a particular page element.

           Example: <A href=" " style="text-decoration: none;">

3. External Styles are written in a separate document and then attached to one or
more web pages.

              Example: <LINK rel="stylesheet" type="text/css" href="styles.css" />
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2.13.1 Applying CSS to a HTML document

Here, you will learn CSS, its syntax and how it is applied to a HTML document
through an example.  It explains how to create an HTML file, a CSS file and how
to make them work together.

The resulting HTML page, with colors and layout, all done with CSS.

Step I:Create an HTML document style.html

<HTML>

<HEAD>

<TITLE>My First Styled Page</TITLE>

</HEAD>

<BODY>

<!— Site Navigation Menu —>

<UL>

<LI><A HREF="absolute.html">About Me</A></L1>

<LI><A HREF="http://www.nios.ac.in">My School</A></LI>

<LI><A HREF="myfriends.html">My Friends</A></LI>

<LI><A HREF="contactme.html">Contact Me</A></LI>

</UL>

<!— Main content —>

<H1>My First styled page</H1>

<P>Welcome to my styled page!</P>

<P>It lacks images, but at least it has style. I feel it is very easy to apply colors to

my page.</P>

<P>Quite interesting!</P>

</BODY>

</HTML>
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Fig. 2.11 : Viewing HTML document style.html in browser

Step 2:Adding Some Colors
You probably see some black text on a white background, but it depends on how the
browser is configured. So one easy thing you can do to make the page more stylish
is to add some colors.

You need to add a <style> element to the HTML file. The style sheet will be inside
that element. Go back to the editor notepad(click on start’ >
AllPrograms’!Accessories’!Notepad) -> open the HTML document ‘style.html’
and add the following five lines in the head part of the HTML file then Save the file.
The lines to add are shown in bold.

<HTML>

<HEAD>

<TITLE>My first styled page</TITLE>

<STYLE Type="text/css">

BODY {

COLOR : Purple;

BACKGROUND–COLOR: #d8da3d}

</STYLE>

</HEAD>

<BODY>

[etc.]
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The first line says that this is a style sheet and that is written in CSS (“text/css”).
The second line says that you add style to the “body” element. The third line sets
the color of the text to purple and the next line sets the background to a sort of
greenish yellow.

Style sheets in CSS are made up of rules. Each rule has three parts:

1. The selector (in the example: “body”), which tells the browser which part of
the document is affected by the rule;

2. The property (in the example, ‘color’ and ‘background-color’ are both
properties), which specifies what aspect of the layout is being set;

3. and the value (‘purple’ and ‘#d8da3d’), which gives the value for the style
property.

The example shows that rules can be combined. You have set two properties, so
you could have made two separate rules:

body { color: purple }

body { background-color: #d8da3d }

but since both rules affect the body, you only wrote “body” once and put the
properties and values together.

The background of the body element will also be the background of the whole
document. You have not given any of the other elements (p, li, address…) any explicit
background by default they will have none (or: will be transparent). The ‘color’
property sets the color of the text for the body element, but all other elements inside
the body inherit that color, unless explicitly overridden. Apart from the list of links at
the top, the text should now be purple against a greenish yellow background.

Now save this file (use “Save” from the File menu) and go back to the browser
window and open to get the page as shown below.

Fig. 2.12 : Viewing HTML document style.html in browser after adding

color to the body of the document using CSS
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Step 3:Adding Fonts

Another thing that you can do easily to make some distinction in the fonts, for the
various elements of the page.  So let us set the text in the “Georgia” font, except for
the h1 heading.

On the web, you can never be sure what fonts your readers have on their computers;
you add some alternative fonts as well.

Open the file style.html and add the following lines:

<HTML>

<HEAD>

<TITLE>My first styled page</TITLE>

<STYLE Type="text/css">

  BODY {

FONT - FAMILY : Georgia, "Times New Roman",

Times, Serif;

COLOR: purple;

BACKGROUND_COLOR: #d8da3d }

HI {

FONT_FAMILY : Helvetica, Geneva, Arial, SunSans_Regular, Sans_Serif}

</STYLE>

</HEAD>

<BODY>

[etc.]

Step 4:Adding a Navigation Bar

The list at the top of the HTML page is meant to become a navigation menu. Many
websites have some sort of menu along the top or on the side of the page and this
page should have one as well. You will put it on the left side, because that is a little
more interesting than at the top.

The menu is already in the HTML page. It is the <ul> list at the top. The links in it
do not work, since our “Website” so far consists of only one page, but that does not
matter now. On a real website, there should not be any broken links, of course.

You need to move the list to the left and move the rest of the text a little to the right,
to make room for it. The CSS properties you use for that are ‘padding-left’ (to move
the body text) and ‘position’, ‘left’ and ‘top’ (to move the menu).
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<HTML>

<HEAD>

<TITLE>My first styled page</TITLE>

<STYLE TYPE="text/css">

  BODY {

PADDING_LEFT: 11em;

    FONT_FAMILY: Georgia, “Times New Roman”,

          Times, serif;

    COLOR: Purple;

    BACKGROUND_COLOR: #d8da3d }

H1 {

    FONT_FAMILY: Helvetica, Geneva, Arial,

    SunSans_Regular, Sans_Serif }

</STYLE>

</HEAD>

<BODY>

[etc.]

Fig. 2.13 : Viewing HTML document style.html in browser after

adding Navigation Bar using CSS
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Step 5: styling the Links

The navigation menu still looks like a list, instead of a menu. Let’s add some style to
it. You will remove the list bullet and move the items to the left. You will also give
each item its own white background and a black square.

In this example blue color is used for links and purple color for visited links.

1. <HTML>

2. <HEAD>

3. <TITLE>My first styled page</TITLE>

4. <STYLE TYPE="text/css">

5. BODY {

6. PADDING-LEFT: 11em;

7. FONT-FAMILY: Georgia, “Times New Roman”,

8.    Times, serif;

9. COLOR: purple;

10. BACKGROUND-COLOR: #d8da3d }

11. UL.NAVBAR {

12. LIST-STYLE-TYPE: none;

13. PADDING: 0;

14. MARGIN: 0;

15. POSITION: absolute;

16. TOP: 2em;

17. LEFT: 1em;

18. WIDTH: 9em }

19. H1 {

20. FONT-FAMILY: Helvetica, Geneva, Arial,

21. SunSans-Regular, sans-serif }

22. UL.NAVBAR LI {

23. BACKGROUND: white;
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24. MARGIN: 0.5em 0;

25. PADDING: 0.3em;

26. BORDER-RIGHT: 1em solid black }

27. UL.NAVBAR A {

28. TEXT-DECORATION: none }

29. A:LINK {

30. COLOR: blue }

31. A:VISITED {

32. COLOR: purple }

33. </STYLE>

34. </HEAD>

35. <BODY>

36. [etc.]

Fig. 2.14 : Viewing HTML document style.html in browser

after styling links using CSS
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Traditionally, browsers show hyperlinks with underlines and with colors. Usually,
the colors are similar to what we specified here: blue for links to pages that you
have not visited yet (or visited a long time ago), purple for pages that you have already
seen.

In HTML, hyperlinks are created with <a> elements, so to specify the color, you
need to add a style rule for “a”. To differentiate between visited and unvisited links,
CSS provides two “pseudo-classes” (:link and :visited). These are called “pseudo-
classes” to distinguish these from class attributes, that appear in the HTML directly,

e.g., the class="navbar" in our example.

Step 6: putting the style sheet in a separate file

You now have an HTML file with an embedded style sheet. But if our site grows,
you probably want many pages to share the same style. There is a better method
than copying the style sheet into every page: if we put the style sheet in a separate
file, all pages can point to it.

To make a style sheet file, you need to create another empty text file using notepad.
Store the html code of line no. 5 to 32 of step 5 is mystyle.css.

Choose “Save As…” from the File menu; make sure that you are in the same
directory/folder as the style.html file, and save the style sheet as “mystyle.css”.

Now go back to the HTML document remove everything from the <style> tag upto

</style> tag and replace it with a <link> element, as follows:

<HTML>

<HEAD>

<TITLE>My first styled page</TITLE>

<LINK REL="stylesheet" href="mystyle.css">

</HEAD>

<BODY>

<!— Site navigation menu —>

<UL CLASS="navbar">

<LI><A href="aboutme.html">About Me</A></LI>

<LI><A href="http://www.nios.ac.in">My School</A></LI>

<LI><A href="myfriends.html">My Friends</A></LI>

<LI><A href="contactme.html">Contact Me</A></LI>
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</UL>

<!— Main content —>

<H1>My first styled page</H1>

<P>Welcome to my styled page!</P>

<P>It lacks images, but at least it has style.</P>

I feel it is very easy to apply colors to my page.

<P>Quite interesting!</P>

</BODY>

Fig. 2.15 : Viewing HTML document style.html in browser after

applying CSS stored in an external file
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This will tell the browser that the style sheet is found in the file called “mystyle.css”
and since no directory is mentioned, the browser will look in the same directory where
it found the HTML file.

If you save the HTML file and reload it in the browser, you will notice that there is
no change: the page is still styled the same way, but now the style comes from an
external file.

INTEXT QUESTIONS 2.3

1. Syntax to make a text link is:

A. <A HREF="URL"> text describing link </A>

B. <HREF="URL"> text describing link </A>

C. <A> text describing link </A>

D.  None of the above

2. _______ tag is used to add images to HTML documents.

A. <IMG> B. <IMAGE>      C.< Add_img> D.<AD_IMG>

3. Border around the image can be controlled by using __________ attribute of
image tag.

A. border B. Background C.image D. IMG

WHAT YOU HAVE LEARNT

In this lesson you have learnt how to create, save and view a simple HTML document.

You have learnt that HTML elements can be categorized as container elements and

empty elements. Now you can create simple HTML document using HTML

elements.  You have also learnt to format a web page and use hypertext links. You

have learnt about image mapping i.e.the technique of making your links in different

parts of an image to several pages, and applying CSS to a HTML document.
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TERMINAL EXERCISE

1. Create an HTML file for the following web page as shown in figure:

2. What is HTML?  Why do you need HTML?

3. Define CSS? What are the advantages of using CSS?
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4. Write a HTML file to create the following web page:

5. Write the tag that is used to place images in a web page. Give five attributes
that you can associate with this type of tag. Define Image Maps.

6. Explain Hypertext links. What is the method to link a specific place within the
same document?

ANSWER TO INTEXT QUESTIONS

2.1

1. B.  HTML

2. A.  markup

3. C.   Head and Body

4. A.   Head
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  2.2

1. B.<br>

2. A. 6

3. A. <UL>

4. D. <OL>....</OL>

  2.3

1. B.<HREF=”URL”> text describing link </A>

2. A. <IMG>

3. A. BORDER
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3

INTRODUCTION TO MULTIMEDIA

When you visit any website, what do you like about it?  It is true that good use of
color contrasts, rich in content and graphics, animation, audio, video and interactive
websites always create a good impression of the website in the visitors’ minds.
Therefore, there is a need for you to integrate the above features in a website. This
can be achieved by using Multimedia. In general terms, multimedia can be defined
as the integration of two or more media elements with computing technology to convey
information. These media elements may be sound, animation, graphics, hypertext
or video. Do you know multimedia makes the learning process easier? In this lesson
we shall learn about the components of a multimedia package, multimedia usage in
various fields and hardware, software requirements for multimedia system.

OBJECTIVES

After reading this lesson, you will be able to:

list out components of a multimedia package;

describe the usage of multimedia in various fields;

explore features of  multimedia system;

identify hardware and software requirements for multimedia system.

3.1 COMPONENTS OF A MULTIMEDIA PACKAGE

The main feature of any multimedia application is its human interactivity.
This means that it allows you to choose from different options available.
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For instance, you can  interact with a particular program by clicking on various icons
and links. The program subsequently reveals detailed information on that particular
subject. This is done by creating GUI (Graphical User Interface).

The components of a multimedia package are:

TEXT

It is one of the most popularly used mediums of appearance. In 99% of the occasions,
text provides the core structure to the package.

A major drawback of using text is that it is not attractive as compared to the other
components. It is very hard to read directly from the screen, for that reason many
TEXT TO SPEECH software are developed.

We can also provide hypertext which contains links to another text and provides a
choice to the user for reading the information in detail.

PICTURES/ GRAPHICS

You can enhance the overall look of a multimedia package by using pictures. Pictures
can be created by using any of the following ways: By using a drawing tool like
MS PAINT (from Microsoft Inc.), using digital scanners, or original photographs
taken with the help of a web camera or its equivalent. The size of these images can
be sometimes very large. It is based on some factors like; the size of the image in
terms of pixels, resolution, i.e., dots per inch (dpi) and number of colors that the
system monitor can display at one time.

VIDEO AND SOUND

Sound is used to set the rhythm or a mood in a package. Speech gives an effect of
a language (pronunciation for instance).

Sounds are stored in various sound file formats like MP3 and can be easily
transmitted through the Internet. You can record sound through a microphone or
from any other medium like tape or cassette player onto the PC.

Some of the factors affecting the size of sound files are:

● You can use any of the method for storage, whether it is in compressed format,
resolution, i.e., bit rate, whether the sound is mono or stereo, the quality of
sound desired.

● If pictures can paint a thousand words then motion pictures can paint a million.
Your video can be incorporated in a website in the form of digital animation
or recorded video files. Link to particular videos on other sites (e.g. youtube)
can also be given.
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3.2  USAGE OF MULTIMEDIA IN DIFFERENT FIELDS

Multimedia applications have become an integral part of computer industry
in almost all fields. The table below lists the usage of multimedia in some
common fields :

3.3 BROWSER SUPPORT

The first Internet browsers had support for text only, and even the text support was
limited to a single font in a single color. Then came browsers with support for colors,
fonts and text styles, and support for pictures was also added.

The support for sounds, animations, and videos is handled in different ways by various
browsers. Some multimedia elements are supported, by the browser and some require
an extra helper program (a plug-in).

Table 3.1 : Usage of Multimedia in different fields

Education

• Tutorials containing the subject
material in the form of text and
images can be stored on CDs and
distributed to students.

• Teachers can also upload tutorials
for different courses on internet.

• Students can download the course
material from internet.

• Virtual Labs for conducting Biology
/ Physics / Chemistry experiments.

• Usage of software applications to
develop presentations, animation, e-
learning modules, video games.

Entertainment

• Video-on-demand
lets you select and
watch a video of
your choice.

Computer Games on
• CD-ROMs
• Proprietary

systems
(X-Box,
Playstation)

Music on

• MP3 Players.

• ipods.

World Wide Web

• WWW provides easy
and interactive access
for multimedia
applications.

• Reference of medical
facilities.

• Reference of  World
Atlas.

• Interactive multimedia,
including sound, video,
and 3-D animation to
provide information
and illustrate the
concepts.

• LIVE telecast of
cricket matches.

• Results of
Examination.

Business

• A lot of  business can be done
on internet. Organizations can
sell consumer products,
software, hardware and
educational products on
internet. Buyers can view
product images and demos and
order products on internet (also
called as Home shopping).

• Job openings published by
various organizations.

• Video Teleconference: Video
conferencing allows people
sitting at two or more locations
to interact via two-way video
and audio transmissions
simultaneously.

• Virtual reality: Virtual Reality is
a technology that allows a user
to interact with a computer-
simulated environment, (real or
imaginary) with the help of
visual experiences, displayed on
a computer screen through
speakers, headphones etc.
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3.4 MULTIMEDIA FORMATS

Multimedia elements (like sounds or videos) are stored in media files. The most
common way to discover the type of a file is to look at the file extension. When a
browser sees the file extension .htm or .html, it will treat the file as an HTML file.
The .xml extension indicates an XML file, and the .css extension indicates a style
sheet file. Pictures are recognized by extensions like .gif, .png and .jpg.Animation/
video files also have their own formats with different extensions like: .swf, .wav,
.mp3, and .mp4.

INTEXT QUESTIONS 3.1

1. Which of the following is an example of multimedia application?

(a) Video Games

(b) Online Tutorials

(c) A DVD Movie, being watched on computer

(d) People sitting at two different locations and interacting via two-way video
and audio

(e) MP3 Music file downloaded from internet

(f) All of the above

2. GUI stands for _________

(a) Graphical user Interface

(b) Graphical user Internet

(c) Graph user Interface

(d) Graph user internet

3.5 DESIRABLE FEATURES OF A MULTIMEDIA SYSTEM

• Real time delivery of data: Multimedia applications contain large files, which
need to be processed at high speed. For  example a user watching his digital
pictures on the computer wants the system to open the pictures as quickly as
possible.

• Data Representation: File formats that support multimedia should be easy to
handle and allow for compression/decompression in real-time.

Multimedia Development Tools

They are required for building applications and reviewing some of the products that
are commercially available.
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Presentation Tools

These tools are necessary to present multimedia presentations. Presentation tools
are tools like overhead projectors. These tools actually improve the overall effect
and helps the speaker to get his message across the audience in a professional manner.

Authoring Tools

These in contrast with the presentation tools, support features such as layout, graphic
design, animation control of branching and navigation. These help the end user to
easily move through the application. Text authoring tools may also provide screen
design help to harness the layout of text, and images and places where user
interaction is required.

3.6 HARDWARE AND SOFTWARE REQUIREMENTS FOR
MULTIMEDIA

Hardware requirements of the multimedia computers

Multimedia computers should support the capturing, editing and viewing of video
and audio data and provide facilities for the transfer of these data types between
computers either through modems or through local and wide area networks.

Below is the list of minimum requirements for a multimedia PC

Table 3.2 Hardware requirements of the multimedia computers

HARDWARE

Processor

Memory

Hard Disk

Graphics card

USB port

NIC (Network Interface Card)

Capture devices

Storage Devices

Output Devices

MINIMUM  REQUIREMENT and EXAMPLES

core i5

4 GB or more

500 GB or more

atleast 512 MB RAM/1GB

At least one USB port

For Multimedia data transmission over the
network

Video camera, Video recorder,  Microphone,
keyboard, mouse, scanner, etc.

Hard disks, CD-ROMs, DVD-ROMs, etc.

Speakers, SVGA (Super Video Graphics
Adapter), Hi-Resolution monitors, color
printers etc.
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3.7 CHALLENGES FOR MULTIMEDIA SYSTEMS

• Information storage

Multimedia files have large size, e.g., a movie file. There must be sufficient
storage (hard disk, memory) in your system to store such files.

• Information retrieval

Another issue in multimedia is information retrieval. e.g. in a movie file, it’s a
tedious procedure to search video sequences and find the desired frames out
of the large video file.

• Processing Power

Your CPUs must be powerful enough to execute large amount of multimedia
data.

• Network Speed

You have to use high speed network so that large amount of multimedia data
can be transmitted synchronously. For example, an image may take a long time
to download but the user may take few seconds to have a look at it. This means
fast networks are required to handle multimedia data.

• Multimedia Handling Capability

Multimedia data may be captured in analog form but it is always represented
digitally by a computer after Analog–Digital conversion and Sampling. The
computer systems used by multimedia applications must have enough storage,
memory capacity and sound & video handling capability.

EXAMPLES

Paint application provided in Windows to draw
images.
PowerPoint software-to develop presentations.
Flash software-to develop animation.
Photoshop software-to develop Graphics.
Dreamweaver software-to develop websites.
Audacity software-to develop sound.
Moviemaker software-to edit videos.

Windows, Mac OS, Linux etc…

Internet Explorer, Firefox, Chrome etc…

Table 3.3 Software requirements of the multimedia computers

SOFTWARE

Authoring Tools (tools that help
in developing multimedia
applications).

Operating System

Internet Browser
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• Compression Techniques

Multimedia files are very large in size. In order to save your storage space and
transmission time over the network, different techniques for handling different
data types of multimedia data are employed e.g., video compression and audio
compression techniques.

• Data Synchronization

Different elements of multimedia need to be synchronized before transmission
e.g., playback of video and audio in a movie or animation should be proper so
that lip synchronization is proper.  Similarly, playback of animation and audio
should be synchronized properly in video games. This requires proper sequencing
of video frames in correct order.

• LIVE Telecasts

Transmitting LIVE multimedia information e.g. LIVE cricket match, imposes
many constraints on the multimedia systems in terms of video and audio capturing
and transmission.

INTEXT QUESTION 3.2

1. State True or False for the following:

a. Multimedia files are generally compressed in order to prevent large file
sizes.

b.  Employees of different branches of an office can communicate with each
other using teleconference facility.

c. Video, presentations and animation are not part of multimedia applications.

d. Video camera, CD player, DVD player, and Virtual reality devices are
Multimedia devices.

2. Fill in the blanks.

a. To develop video applications _____________________ software is
used.

b.    XML files have __________________ extension.

WHAT YOU HAVE LEARNT

In this lesson, you have learnt about what is multimedia and how you can use it.
You also have learnt about components of multimedia package, usage of multimedia
in different fields, hardware and software requirements for a multimedia system
and the challenges faced by multimedia applications.
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TERMINAL EXERCISE

1. Explain the usage of multimedia in business over Internet.

2. Explain the hardware configuration of a computer supporting multimedia
applications.

3. Explain the need of high speed data transmission of multimedia data over
network.

4. Explain the challenges faced by multimedia applications.

5. You are given a task to design the front page of a newspaper on computer.
With the help of diagram, describe how you would use different elements of
multimedia for publishing industry e.g. Text, Images etc.

ANSWERS TO INTEXT QUESTIONS

 3.1

1. (f) All of the above

2. (a) Graphical User Interface

 3.2

1. (a) True (b) True (c) False (d) True

2. (a) Moviemaker (b) .xml
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4

MACROMEDIA FLASH

You must have seen animated movies like Tom & Jerry, Doraemon, ChhotaBheem
etc. Have you ever thought how are these movies made? Which software is used
to create such animations? Well, there are many software available in the market
for creating dynamic animations but in this lesson you will be learning one of the
simplest ones – Macromedia Flash 8. It is one of the most popular technologies being
used on the Internet to create interactive web pages and mobile app interfaces.

Before starting with Flash, let us first define an animation.You all must have created
drawings using MS Paint, Tux Paint or any other drawing software. If you create a
series of such drawings with minor differences and then scroll these drawings or
pictures in sequence, it becomes an animation. (For example, to show a ball moving
from one place to another, you can create a series of images/drawings of the ball
where in each image, the position of the ball is a bit different from the previous one.
When you will scroll these pictures/drawings in sequence, it will appear as if the
ball has moved from one place to another. Hence, an animated movie with the ball
moving from one place to another is created.)  Macromedia Flash 8 is one such
software package which helps you to create very interesting animated movies. It is
very dynamic software as sounds, videos, images and animations together can be
incorporated in one document.

OBJECTIVES

After reading this lesson you will be able to:

 start Macromedia Flash;

 list the components of Flash Window;
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 identify various tools in the Tools Panel;

 use the Timeline;

 create a Flash document using frame by frame animation;

 save and open a Flash document.

4.1 HOW TO START FLASH 8?

To begin with, you can download the trial version of Macromedia Flash 8 from the
Internet. The trial version is available free of cost. If you like the software, then
you can purchase it later.

It is very easy to begin working in Flash. The steps are as follows:

1. Click Start button.

2. Click Macromedia->Macromedia Flash 8.

The opening screen of Flash 8 appears on the screen. (Fig 4.1)

Fig 4.1 : Opening screen of Flash 8
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The opening screen that appears will have the following three columns:

 Open a Recent Item - to open a document that was previously created and
saved.

 Create New - to create a new document

 Create from Template - to create a new document from predefined templates
provided by Flash 8

Since we have to start a new document, click Flash Document option under Create
New column. A new blank file by the name Untitled-1 opens as shown in the fig
4.2.

Fig 4.2 : Flash Window

You must have noticed in Fig 4.2 that the Flash window is having various components.
Let us now learn about these components. But before discussing them, you must
know two very important terms concerned with animations. These are Object and
Frame.  Although you might have heard these terms, but let us understand them
with reference to animations.

Anything that you add to a Flash document is called an object. So an object can be
an image, a line, or a piece of text box or any other shape that you draw on the
stage.

  

  

  

  

File Name (Untitled-1)

Property Inspector

      Menu Bar

Tool Panel

Stage
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An individual picture in a sequence of images being animated is called a frame.
Each frame in an animated movie is slightly different from the previous one. When
these frames are displayed in a timed sequence, the objects in the frame appear to
be changing either in position or shape. This is how an animation is created. These
frames are displayed one by one on the screen for a short but fixed time period.

4.2 COMPONENTS OF FLASH WINDOW

The various components of the Flash window are as follows:

Menu Bar
The Menu Bar contains the menu tabs that help to perform various commands and
functions. File, Edit, View, Insert, Modify, Test, Commands, Control, Window and
Help are the menu tabs that are present on the menu bar of the flash window.

Stage
It is the rectangular workspace area of the Flash window. Any type of graphic, text
and/or video clip is placed in this area to create a drawing or an animated movie.

Grid
It is the sequence of intersecting horizontal and vertical lines on the stage.  You can
place and align objects at a particular position on the stage using the gridlines. Hence,
drawings or any other graphic can be created as per scale.

By default, gridlines are not visible on the stage. To make the grid visible, select
View -> Grid -> Show Grid.

Rulers
The rulers are present on the top and left sides of the stage.  When the rulers are
displayed and you move an element on the stage, lines indicating the dimensions
of the element appear on the rulers. By default, the rulers are also not displayed in
the Flash window. To show or hide rulers, select View-> Rulers.

Tools Panel
On the left side of the Flash window is the Tools Panel.  It contains tools to create,
edit and colour the objects. You can select any tool by simply clicking on it.

You will also notice that the Tools Panel is divided into four sections. These are
Tools, View, Colors and Options. Let us have a quick look at these sections:

 The Tools section contains selection and drawing and painting tools. Some of
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the tools in this section are Arrow tool, Line tool, Rectangle tool, Eraser tool
etc.

 The View section contains zooming tools such as Hand tool and Magnifier tool.

 The Colors section contains tools for changing colours such as Stroke color
and Fill Color.

 The Options section contains modifiers for the currently selected tool. These
are used to set various options for the selected tool.

Fig  4.3: Tools Panel

You will learn more about various tools in the Tools Panel later in this lesson.

Property Inspector
It is a panel present at the bottom of the Flash window. You can use this panel in
two ways:
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(i) When the stage is blank i.e., you have just opened a blank document: In this
case, you can change the settings of the stage like the stage size, ruler unit, background
colour of the stage, frame rate etc.

(ii) When any tool is selected to create an object on the stage: In this case, it displays
the properties of the selected tool.  Hence, you will see different properties for each
selected tool in the Property Inspector.  For example, if you select an Oval tool,
colour, thickness and style of line, fill colour, scale etc. these properties will be
displayed  (as shown in Fig 4.4).

Fig 4.4 : Property Inspector showing properties of an Oval Tool

Expand/Collapse icon

You can click the Expand/Collapse icon above the Property Inspector to collapse
it and minimize its size. To expand the Property Inspector back to normal size, click
the same icon again.   To expand /collapse the property inspector press Ctrl + F3.

Timeline
Timeline is a fixed pane above the workspace or stage. It is used to set the sequence
of the movie being created. You can assemble various objects on the stage in a step-
by-step order using the timeline so that the order of events can be viewed. You will
learn about various parts of timeline later in this lesson.

  Expand/Collapse icon
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4.3 Movie Properties
You must have noticed that any object or entity in this world has got certain features
or properties. For example, a bag may have properties like size, colour, price etc.
Similarly a painting may have properties like colours being used, canvas type etc.
Can you name some properties of the movie that you want to create in Flash 8?

A movie being created in Flash also has certain properties like title of the movie,
background colour, dimensions, description of the movie etc., Flash allows you to
set and edit these properties by following the steps given below:

To change the properties of the Flash movie document, follow the steps given below:

1. Click Modify->Document  (Fig 4.5).

The Document Properties dialog box appears (Fig 4.6).

Fig 4.5: Document option

Fig 4.6: Document Properties dialog box



82 :: Macromedia Flash

Notes

WEB DEVELOPMENT

2. In the Document Properties dialog box you may specify any or all of the
following movie properties:

o Specify the title of movie in the Title text box.

o Specify the description of the movie in Description text box.

o The default size of the stage is 550 X 400 pixels. In the Dimensions text
box, you may alter the size of the stage that appears in the Flash Window.

o The default background color of the stage is white. You may choose any
other color from the Color palette of Background Color.

o Frame rate is the speed with which the frames in an animated movie move.
That is why the speed of the movie is measured in frames per second
(fps) and it is known as frame rate. The default frame rate in Flash 8 is
12 fps. If you wish to change it, specify the desired speed of the movie in
the Frame rate text box.

o You can choose the unit for ruler from the Ruler units list box. The default
unit is pixels but you can change it to inches, points, centimeters, etc.

o If you want the properties of the current document to be applied to all
new document that are created henceforth, then click Make Default
button at the bottom of the dialog box.

3. Once you have made the desired changes, click OK. The edited properties
will be applied to the current movie document.

INTEXT QUESTIONS 4.1

1. Fill in the blanks:

a. In Macromedia Flash 8, the default frame rate is ________ frames per
second.

b. Anything that you add to the Flash document is called____________.

c. ______________ is used to show / edit the properties of the selected
tool.

2. State True or False.

a. An individual picture in a sequence of images being animated is called a
frame.

b. Tools panel contains tools to create, edit and colour the objects.
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4.4 DRAWING TOOLS IN FLASH

Do you remember the MS Paint interface window? You must have seen  Tool bar
on that window that contained tools like line tool, brush tool, eraser tool etc. to draw
various figures.

Likewise in Flash window, the tools section of the Tools Panel also contains various
tools to draw images. In fact, the tools in Flash 8 have additional options and properties
to create a variety of drawings.

Before starting to create an image using these tools, you should know that every
shape consists of an outline and the fill. The outline is called the line or stroke. The
inside area of the shape is called the fill. You can even choose the colour of the
stroke and the fill separately. In Fig. 4.7, the line or stroke is of pink colour while the
fill is of green colour.

Fig 4.7 : Outline and Fill of an object

The tools to choose the line colour and fill colour are given in the Colours section
of the Tools Panel. These tools are:

Stroke Color 
This tool is used to choose the outline colour or the line colour of the object being
drawn.

Fill Color 
This tool is used to choose the colour that will fill the object. Each of the tools in the
Tools Panel can be selected by clicking on it. Thereafter, if required you select any
properties from the Property Inspector and any of the available options form the
Options section of the Tools Panel. Finally you will click and drag the mouse pointer
on the stage to draw the desired shape.

Let us now learn some of the commonly used drawing tools in Flash 8.

4.4.1 Line Tool 
The line tool is used to draw straight lines. Follow the steps given below to draw
straight lines on the stage:

1. Click once on the line tool and select it.

  

 

Outline (pink)

Fill (green)
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2. In the Property Inspector panel, click on the arrow next to Stroke color.
Choose the desired colour from the colour palette.

3. The line to be drawn can be in various styles like a bold line, dotted line, dashed
line etc.  Choose the desired Stroke style.

4. Click on arrow near Stroke height. A slider appears. Choose the appropriate
thickness of the line by dragging the slider.

5. After selecting the desired properties, position the mouse pointer at the point
from where you want to start drawing the line on the stage.

6.  Click and drag the cursor keeping the mouse button pressed.

7. Release the mouse pointer. The line of the chosen style, colour and thickness
appears on the screen (Fig 4.8).

Fig  4.8 : Using the Line Tool

4.4.2 Rectangle Tool 

Rectangle tool is used to draw rectangles and squares by following the steps given
below:

1. Click the Rectangle Tool.

2. Select the Stroke Color, Stroke Style and Stroke Height from the Property
Inspector panel.

 
 

 
 

 

 

Line Tool

 

 

Stroke color

Stroke height Stroke style
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3. Click the arrow next to Fill Color. Choose a colour to fill the rectangle from
the colour palette.

4. Click and drag the mouse pointer on the stage.

5. Release the mouse button when the rectangle of desired size is drawn on the
stage (Fig 4.9).

Fig 4.9 :  Using the Rectangle tool

4.4.3 Oval Tool

You can draw circles and ovals using this tool. The steps to use the Oval tool are:

1. Click and select the Oval tool.

2. In the Property Inspector panel, choose the Stroke color, Fill Color, Stroke

height and Stroke style.

3. Bring the mouse pointer on Stage. Click and drag till the circle or oval of desired

shape is drawn.
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Fig 4.10 : Using Oval Tool

4.4.4 Polystar Tool 

Another interesting tool provided by Flash is the PolyStar tool. It is used to draw
polygons and stars by following the steps given below:

1. Click and hold the mouse button on the Rectangle tool (Fig 4.11)

Fig 4.11 : Drop Down Menu of Rectangle tool
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2. Select the PolyStar tool from the drop-down menu.

3. From the Property Inspector panel, choose the Stroke Color, Stroke Fill
and Stroke Style.

4. Click the Options button in the Property Inspector panel. The Tool Settings
dialog box appears (Fig 4.12).

Fig 4.12: Tool Settings dialog box

5. Select the Star or Polygon that you want to draw from the Style list box.

6. If you want to draw the polygon, type the Number of Sides in the textbox.  If
you want to draw a star, type the desired number of points in the Star Point
Size text box. It should be a number between 0 and 1. You should keep in mind
that a smaller number will create a star with sharper points. Click OK after
you have made the desired settings.

7. Click and drag the mouse pointer on the stage to draw a polygon or a star of
the desired size (Fig 4.13).

Fig 4.13 : Using the PolyStar tool
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4.4.5 Pencil Tool 

This is a freehand drawing tool that allows you to draw lines in three modes:
Straighten, Smooth and Ink.

Straighten: This is used to draw straight lines. When you draw a line using this
mode, the line will automatically straighten even if you have not drawn a straight
line.

Smooth: This option is used to draw curved lines with smooth edges.

Ink: This option helps to make freehand drawings without any alterations.

Follow the steps given below to use Pencil tool:

1. Click and select the Pencil tool on the Tools Panel.

2. From the Property Inspector, select the Stroke Color, Stroke Style and
Stroke Height.

3. Choose the desired modifier (Straighten, Smooth or Ink) from the Options
section of the Tools panel.

4. Click and drag the mouse pointer on the stage to draw the desired shape. In
Fig 4.14 below, notice the difference in the edges of the drawing when you
choose Straighten, Smooth or Ink modifiers respectively.

Fig  4.14 :  Using Pencil Tool

Straighten Smooth Ink



Macromedia Flash  :: 89

Notes

WEB DEVELOPMENT

4.4.6 Paint Bucket Tool
The Paint Bucket tool is used to fill desired colours in the closed objects and also to
fill the areas that are not completely closed.

Follow the steps given below to colour the shapes:
1. Select the Paint Bucket tool.
2. In the Property Inspector panel, click on the arrow next to Fill Color. The

colour palette appears. Select the desired colour.
3. Bring the mouse pointer on the stage and click inside the object that you want

to colour.

4.4.7 Brush Tool 

You can paint with thick brush like strokes on the stage using the brush tool.  Follow
the steps given below to use the Brush tool:

1. Click and select the Brush tool.

2. Select Fill Color from the Property Inspector panel.

3. From the Options section of the Tools Panel, choose the Brush Size and Brush
Shape.

4. Click and drag the mouse pointer on the stage.

4.4.8 Eraser Tool
You all know the use of an eraser. It is used to erase or rub the pencil marks. In
Flash also, the eraser has the same function. It is used to erase the lines and fills of
an object from the stage. When you select the Eraser tool, the following modifiers
appear in the Options section of the Tools Panel:

 Erase Mode modifier: This modifier gives the following options to erase (Fig
4.15).

Fig 4.15 : Erase Mode Modifiers
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o Erase Normal:  to erase all lines and fills from wherever the eraser is passed
through.

o Erase Fills: to erase only the inside portion or fill of an object. The lines remain
unaffected.

o Erase Lines:  to erase only the lines. The fill remains unaffected.

o Erase Selected Fills: to erase only those fills which are selected. The
unselected fills and even lines remain unaffected.

o Erase Inside: to erase the inner portion of the object.

The Fig 4.16 shows the use of Eraser tool with various Erase mode modifiers
selected.

Fig 4.16: Use of Eraser with different Erase Mode Modifiers

 Eraser Shape modifier: This is used to select the shape and size of the eraser.

Follow the steps given below to use the Eraser tool:

1. Click and select the Eraser tool.

2. Select one of the options from the Eraser Mode modifier in the Options
section of the Tools panel.

3. Select the eraser’s shape and size from the Eraser Shape modifier.

4. Click and drag on the stage to erase the object or its part.

Erase Normal Erase Fills Erase Lines

Erase Inside No Eraser Tool UsedErase Selected Fill
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4.4.9 Text Tool

Do you think that Flash can only be used to draw objects? Is there any means by
which you can type your name or any other text on the stage? Yes, surely you can
do that by using the Text tool. In fact, we can type text in various colours, font styles
and sizes. To use this tool, follow the steps given below:

1. Select the Text Tool.

2. From the Property Inspector panel, select the desired Font Style, Color, Size,
etc.

3. Now, when you bring the mouse pointer on the stage, the cursor changes to a
‘+’ sign.

4. Click and drag the mouse pointer to get a text box of desired length. A cursor
will appear in the beginning of the text box.

5. Type the text.

Fig 4.17: Using the Text tool
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4.5 SELECTION TOOLS

While creating a drawing or an animation, you will come across situations when
you will have to move, colour, cut or copy a portion of an object. To select a part or
whole of the drawing on the stage, the selection tools are present in the tools sections
of the Tools panel. Let us learn some of these tools.

4.5.1 Arrow tool
It is used to select single or multiple objects on the stage. When you select the object
using this tool, white dots appear on the selected object. There are different ways
to select different types of objects. First, click and select the Arrow tool. Then-
 To select a text box or a filled shape, just click anywhere on the object.
 To select objects within a rectangular area, drag a rectangle around the object

that you want to select.
 To select a filled shape and its outline, double click the fill.
 To select connecting lines, double click on anyone of the lines.

4.5.2 Lasso Tool 

This tool (also known as Free Hand Selection Tool) is used to select irregular
areas of the objects drawn on the stage.
To do a freehand selection with the Lasso tool, follow the steps given below:
1. Select the Lasso tool.
2. Drag the cursor on the stage to specify the boundary of selection.
3. End the selection approximately near the point where you started.

Fig 4.18 : Freehand selection using Lasso tool



Macromedia Flash  :: 93

Notes

WEB DEVELOPMENT

You can even do a selection in geometrical shapes using the Lasso tool. Follow the
steps given below to do so:

1. Select the Lasso tool.

2. Click the Polygon Mode modifier from the Options area of the Tools panel.

3. Click on the stage to set the starting point.

4. Click at the point where you want the first line to end.

5. Continue setting end points for additional line segments.

6. Double-click to close the selection area.

Fig 4.19 : Geometrical Shape selection using Lasso tool

4.6 TIMELINE

As mentioned earlier, Timeline is a fixed pane above the workspace. It is the
component of the Flash window, where you actually work with frames. The objects
in various frames are set in the required order through the timeline to form an
animated movie.
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Major Components of Timeline

You should refer to Fig 4.20 for understanding the major components of Timeline in
Flash window.

 

  

 

  

 

Fig 4.20 : Timeline

Playhead: It is depicted by a red rectangle with a red vertical line below it. The
playhead shows the current frame on the stage. As the movie plays, the playhead
moves from one frame to another till the last frame is reached.

Frames: A series of vertical rectangles on top of the Timeline represent the
numerous frames in a movie. You will notice in the fig 4.20 that every fifth frame
in the timeline has a light grey fill and is marked with a frame number. This helps
us to keep track of the number of frames being included in the Flash movie. To
insert a frame press F5 function key.

Keyframe: It is a critical point in the animated movie as this is the point where
any change in the object is reflected. It may be a change in shape, position, colour
or appearance of the object. The frames with black dots on the timeline are
keyframes.   To insert a keyframe press F6 function key.

Current Frame Textbox: It is a textbox that gives the current frame number i.e.
the number of the frame which is currently being displayed on the stage.

Frame Rate textbox: The frame rate of the movie shows the speed of the movie
i.e. the number of frames per second that the movie will play. This textbox is present
at the bottom of the Timeline. The default frame rate is 12 frames per second (fps).
As discussed before, this can be modified using the Document properties dialog
box.

Elapsed Time: This textbox shows the time (in seconds)elapsed for the movie to
run from first frame to the current frame.

Keyframe

PlayheadTimeline

Current Frame

Frame rate

Elapsed Time
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4.7 CREATING FRAME BY FRAME ANIMATION IN FLASH

You have learnt that when the frames are displayed in a sequence, the animation is
created. Also, each frame is slightly different from the previous one.  In an animated
sequence, any frame where actually the change of any form, in object is seen is
known as a keyframe. For example, if you see a ball moving, it will be change in
the position of the object. On the other hand, if you see the person talking, the shape
of the lips will be changing.

4.7.1 Inserting a frame or a keyframe
While creating a movie several frames and/or keyframes have to be inserted.  The
steps to insert a frame or a keyframe are:

1. In the Timeline window, click on the rectangular placeholder where you want
to insert a frame or a keyframe.

2. Select  Insert -> Timeline.

3. Choose Frame or Keyframe from the submenu.

Fig 4.21 : Frame / Keyframe option

4.7.2 Deleting a Frame
The steps to delete a frame are:

1. Click on the frame to be deleted in the
Timeline.

2. Right click and select Remove Frames
from the shortcut  menu.(Fig 4.22)

Fig 4.22 : Shortcut menu to delete frame
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4.7.3 Creating Frame By Frame Animation
You can create various types of animations using Macromedia Flash. But in this
lesson you will be learning the simplest animation – that is Frame by Frame
animation. In this type of animation, you will change the contents of each frame
manually.

As an example, let us create a sequence of multi-coloured stars that change colours.
Open a new Flash document by clicking File->New->Flash Document and then
follow the steps given below:

1. Click and hold the mouse button on the Rectangle tool.

2. Select the PolyStar tool from the drop-down menu.

3. In the Property Inspector window, select the properties of the star like Fill
Color (blue) and Stroke Color (purple).

4. Click the Options button in the Property Inspector panel. The Tools Settings
dialog box appears. Select the Style as Star.

5. Type the desired number of points in the Star Point Size text box.

6. In the Timeline you will see that the Playhead is on the first frame with a black
dot on it. That means this first frame is the keyframe. Click and drag the mouse
pointer on the stage to draw a star of the desired size. (Fig 4.23 (a))

Fig 4.23 (a) : Drawing a star
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7. In the Timeline, click to the right of the black dot. This is the second frame in
the Timeline (Fig. 4.22(b)).

8. Select Insert->Timeline ->Keyframe. A new keyframe is inserted. You will
also see a black dot on this frame.

9. Select the Arrow tool and then click anywhere on the stage. This removes all
the selections in the frame so that you can further make drawings for your
animated movie.

10. Repeat steps 1 – 9 to draw stars with different Fill Color, Stroke Color and
Star Point size.  Thereafter, insert the keyframes. You will insert ten such
keyframes (Fig 4.23(b)).

Fig 4.23(b) : Flash Document with 10 frames

11. If you want to preview the animation created till now, select Control->Test
Movie. You will see the stars appearing one by one like disco lights. Are you
not excited to see that you have learnt to create a simple animation in Flash?

12. Let us also animate some text in the same document. Insert another keyframe,
select Arrow tool and click anywhere on stage.

13. Select the Text tool.

14. In the Property Inspector window, set the Font Style, Font Size and Font
Color.
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15. Click on stage and type S (Fig 4. 23(c )).

Fig 4.23(c) : Animating Text

16. In the Timeline, click to the right of the black keyframe dot. This is the next
frame in the Timeline.

17. Select Insert->Timeline->Keyframe.

18. Click anywhere on the stage. This removes all the selections in the frame.

19. Repeat steps 12- 17 and type T, A, R, S on the stage. You will now have fifteen
keyframes in your movie (Fig. 4.23(d)).
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                 Fig 4.23(d) : Animation with 15 frames

20. To play the movie, click on the first frame in the Timeline window. Select
Control - >Play(Fig 4.23(e)).  You can use Enter key to play the movie and
use Ctrl + Enter to preview the animation.

Fig 4.23(e) : Animating Stars and Text together
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4.8 SAVING AND OPENING A FLASH DOCUMENT

To save a file in Flash, follow the steps given below:

1. Click File-> Save As. The Save As dialog box appears.

2. Select the drive and folder where you want to save your file.

3. Type the file name in the File name text box.

4. Click Save button. The files in Flash are saved with a .fla extension.

You can also use Ctrl+Shift+S to save a file for the first time.

Fig 4.24 : Save As dialog box

To open an already saved Flash document, follow the steps given below:

1. Click File->Open .

2. Select the drive and folder where you saved your file.

3. Select the file that you want to open.

4. Click Open button.
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INTEXT QUESTIONS 4.2

1. Fill in the blanks

a. The shortcut key to save the file for the first time is _________________.

b. The rectangular workspace area in the Flash window is called _________.

c. The shortcut key to preview an animation is
_______________________.

d. _____________ tool is used to draw stars.

e. The outline of an object is called a _____________ while the inside of an
object is called a _______________.

2. State whether the following statements are True or False.

a. By default, the rulers and grids are displayed in the Flash Window.

b. The grid option is in View menu.

c. Line tool is used to draw freehand lines.

d. An octagon can be drawn with an Oval tool.

e. Shift key is used to draw a perfect square.

f. Press Enter key to play the movie.

WHAT YOU HAVE LEARNT

In this lesson, you have learnt about animations. This lesson is explained how to
start working in Macromedia Flash 8. Following this, the lesson covered the major
components of a Flash Window and also explained the key terms associated with
animated movies. Then you have learnt about the Tools Panel, Timeline and various
drawing and selection tools. Finally, with the help of an example, you learnt to create
a simple Frame by Frame animation.

TERMINAL EXERCISE

1. Write the steps to insert a frame in a Flash document.

2. Name two selection tools.

3. Name all the components of the Timeline.
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4. Label all the components of the Flash window in the following screenshot.

5. What is the use of Timeline in a Flash Window? Is it the permanent part of the
Flash Window?

6. Name the four sections of the Tools Panel.

7. Which tool is also known as free hand selection tool? Write the steps to select
a portion of a drawing using this tool.

8. Name all the modifiers of an Eraser tool.
9. What is the difference between Line tool and Pencil tool?
10. Write the steps to draw a hexagon (a closed shape with 6 sides) in a Flash

document.

11. Lab Activity
a. For our Independence Day, the teacher has asked you to draw the Indian Flag

in the Flash Window. She also wants you to animate it such that first orange,
then white and then green portions of the flag appear. Complete the task.

b. Delhi is under severe smog due to pollution. Draw a poster on ‘Stop Pollution’
using Macromedia Flash 8.
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ANSWERS TO INTEXT QUESTIONS

4.1

1. Fill in the blanks:
a. 12
b. object
c. Property Inspector

2. a. True
b. True

  4.2
1. a. Ctrl+Shift+S

b. Stage
c. Ctrl+Enter
d. Polystar
e. line or stroke, fill

2. a. False
b. True
c. False
d. False
e. False
f. True
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5

DREAMWEAVER

Web design is a similar process of creation, with the intention of presenting the content
on electronic web pages, which the end-users can access through the internet with
the help of a web browser. A number of website designing software tools are available
in the market. Some of the popular tools are Microsoft Web Matrix, Adobe
Dreamweaver etc. In this lesson we will discuss about Dreamweaver in detail.
Dreamweaver is a web editor which is used by experienced webmasters to design
websites. It uses “WYSIWYG” interface (where “WYSIWYG” stands for “What
You See Is What You Get”) which means that you can create your website and see
the results on your computer screen as you work.

OBJECTIVES

After reading this lesson, you will be able to:

 create a webpage using Dreamweaver software;

 format a webpage;

 design a webpage;

 manipulate graphics and image objects in webpage;

 incorporate audio and video objects in a webpage;

 create a web form;

 create a new project (defining a site).
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5.1 ADOBE DREAMWEAVER

Adobe Dreamweaver is a HTML editor for designing, coding, developing, and
managing websites and webpages for various applications. The interface provided
in Dreamweaver is very convenient for editing and revising the webpages to design
more effective websites. It supports web technologies such as CSS, Javascript  and
various server-side scriping languages. It provides effective and attractive
presentation of information to users on website.

When you are working in Dreamweaver, the commands and icons translate your
work in HTML code automatically. You need not to write the HTML code for each
and every work.

Starting Dreamweaver

To open Dreamweaver (on Windows 7\Vista), click on Start All Programs
Adobe Dreamweaver.

Fig 5.1 : Starting Dreamweaver

Use the Welcome screen to quickly open recent files, create new documents, and
launch a browser to view online videos.  When you launch Dreamweaver for the
very first time, the program automatically opens a dialog box asking you to choose
which file extensions should be associated with the project, and then displays the
newly updated default designer layout. After the program is opened, you can switch
to another available layout option by choosing Window  Workspace Layout, or
by clicking the Workspace Switcher menu on the Application bar.
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5.1.1 Creating a Page

1. Choose FileNew to launch the new document window, shown in the Fig.
5.2.  This dialog box is divided into various columns to assist you with selecting
the desired file type, such as a Blank Page or Page from Template.

2. In the column on the left, select the type of document you want to create. The
default document type is set to Blank Page. If you are unsure which type to
select, select Blank Page.

3. In the Page Type column, select the desired document type, such as HTML or
CSS.

4. In the Layout column, choose <none> to build your own custom layout or select
one of the preset layout options from the list.

In addition to creating a new document through the File menu, you can also create
a new document using the Welcome screen.

When the Welcome screen is visible, the quickest way to create a new blank
document is to click one of the file types in the create new column. Click the HTML
link, for instance, and a new untitled document window appears, complete with
basic HTML structural code, ready for adding content and saving with a filename
and an extension.

Fig 5.2: Adobe Dreamweaver’s Environment
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 Application bar: The Application bar contains the following

 Dreamweaver logo i.e., DW,

 menus,

 a layout menu which is used for choosing different code and design views,

 a workspace switcher menu for toggling between the workspace layout
options,

 a search field for finding help in Dreamweaver,

 and a CS Live Services button that provide quick links to services such as
BrowserLab, Acrobat.com, and CS News and Resources.

 Insert panel: Insert panel appears at the top of the panel dock when it is visible,
it displays a variety of icons for adding objects such as images and tables into
an open file.

Document window: Document window is the working window where you can
design and edit a document. It can be divided into two parts “Code View” where
the document source code is written and “Design view” where the actual design is
shown.

Document toolbar: The toolbar consists the following buttons for quick links:

 Code

 Split

 Design view

 Live Code

 Live View settings.

 Coding toolbar: Coding toolbar provides special coding icons to the left edge
of the Code view area which is particularly useful for users who frequently
use code shortcuts.

 Standard toolbar: Standard toolbar provides shortcut links to common tasks
on the File and Edit menus, such as New, Open, Save, Save All, Print, Cut,
Copy, Paste, Undo, and Redo. To toggle toolbar on and off, choose View
ToolbarsStandard.

 Style Rendering toolbar: This toolbar has shortcut icons to show how a page
would look using different media types, presuming the page uses CSS
(Cascading Style Sheets) specific to those media types. For instance, the <body>
tag may have different CSS attributes for handheld devices, such as a
BlackBerry, versus screen media, such as a browser. To view this toolbar, choose
ViewToolbarsStyle Rendering.

 Properties inspector: The contents of property inspector change according
to the contents selected in your document. Select an object or text in Design
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or Code view, and then add or change properties of that selection in the
Properties inspector.

 Files panel: Files panel is used to access and manage all site files, assets, and
folders etc..

 Tag selector: Using tag selector you can see the hierarchy of tags around a
selection or wherever you have placed the insertion point on the page. Click
any tag in the Tag selector to select tag and its contents quickly.

 Panel groups: All related panels are combined into a single panel group within
the panel dock with individual tabs.

5.1.2 The Document Window

The Document Window is a WYSIWYG (What You See Is What You get)
editor.  You can insert graphics, create tables, and add many other common elements
that make up a typical web page in the Document window.  The Document window
is made up of several parts, some of which are always visible and others are appear/
disappear accordingly.

The Document window has the following features:

1. Document tab bar

The Document tab bar is available just below the Application bar and displays the
document filename tab of an open file. When multiple files are opened, the tabs of
every open file are displayed from left to right inside the tab bar. When an open
page is linked to other documents, such as an external CSS style sheet, a server
script, or an include file, the names of these dynamically related files will appear
in an extended area of the document tab directly below the tab of each open
document.

2. The Document toolbar

The Document toolbar is available at the top of open document and just below the
Document tab bars (shown in Fig 5.3); and displays options and details associated
with the active document. Just below the Document toolbar a new browser
Navigation toolbar is shown, which allows to navigate through your linked documents
when Live View is activated.

Fig 5.3: Document toolbar
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The Document toolbar has various buttons and icons that display different views of
your page, as well as quick links for other features such as adding a page title and
previewing the page in a browser. When your mouse over each button or menu icon,
a tool tip appears which gives name and function of that button/menu icon. Click on
the menu icons to select options from their submenus.

 Code view: This view can be used to write the code or edit HTML, CSS,
JavaScript, server-side programming code (for example, PHP, ASP, or CFML),
and other code in the open Document window (shown in Fig. 5.4). The default
display font for text in Code view is 9-point Courier New.

Fig 5.4 : Code view

 Split view: Split view can be used to see simultaneously both Design and Code
views in the open Document window (shown in Fig 5.5). Resize the two panes
by clicking and dragging the divider bar between them.
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Fig 5.5 : Split view

Fig 5.6: Design view
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 Live Code: Live Code button used to select objects in Design view (shown in
Fig 5.6) and identify the corresponding code in Code view when Live view is
enabled.

 Live View: This option allows you to see your code, along with any dynamic
content, live in Design view by clicking the Live view button or choosing
ViewLive View.

 Inspect: This button works with Live view to help you identify CSS markup
in your HTML. When this is enabled, the Inspect mode allows you to move
your mouse over various page elements to view the CSS box model attributes
for any block-level element.

The Status Bar
Dreamweaver’s Status bar has many features like Tag selector (is on the bottom
left edge of the document window) allows for easy tag and tag content selection
and on the bottom-right edge of the status bar (shown in Fig 5.7) you can see the
current size (in pixels) of the document window, as well as a file size and estimated
file opening time reflecting the file preferences for projected site visitors.

Fig 5.7 : Status bar

Tag Selector

The elements in HTML, such as <B> (to bold text) are also referred to as tags.  At
the bottom of Dreamweaver’s document window, the Tag Selector displays a range
of tags depending on where the cursor is in the current document. To select a tag in
the Tag Selector,  just click it.  Anything in-between the tags will be selected in the
Document Window.

Menu Bar

Menu Bar  (shown in Fig 5.8) consists of File, Edit, View, Insert, Modify, Format,
Commands, site, Window, and Help.  To select a menu item, Click the item you
desire from the displayed drop-down menu. (You can see File menu on Fig 5.9).

Fig 5.8: Menu bar
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Fig 5.9: File Menu

5.1.3 Panels and Properties Inspector

Dreamweaver’s panels helps to organize, select from, and modify content, as well
as to provide access to common features and functions. The most frequently used
panels are the Insert panel, Files panel.  All panels are available in the panel dock
area, either individually or inside a panel group. You can open, resize, reposition,
undock, redock, and close any panel and panel groups to customize your workspace.

Using the Panel Docks
Dreamweaver has many panels to help the user and a user can open and close most
panels using the Window menu. Panel groups are sets of related panels combined
as separate tabbed layers in a single panel, either inside or outside the dock.
 Access each panel by clicking the tab at the top of the panel group.
 Create new and modify existing panel groups by dragging and dropping panels

to their new locations.
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 Expand and collapse panel groups by double-clicking any of the tabs in the group.

If docked to the right or left side of the Dreamweaver workspace, you can undock
panels or entire panel groups by clicking the tab of a panel or the grey unused area
next to the panel tabs within a panel group, and dragging the panel or panel group to
the new location, either inside or outside the dock.

The Insert Panel
The Insert panel (shown in the Fig 5.10) has several sets of buttons for adding
common objects such as hyperlink, email link, and table etc. By default, the common
set of buttons is displayed; you can access other sets through the drop-down menu
at the top of the panel.

Fig 5.10 : Insert Panel

When a particular button is clicked, correct code is automatically added to your page
for the object or action selected.  For example, to insert a link, click the hyperlink
icon and select the desired file path to link; the appropriate HTML code is added to
your page, such as <a href =“index1.html”>.

To add any of the objects or assets in the Insert panel to an open document, select
one of the categories (such as Common, Layout or Forms) and then do one of the
following:

 Click an icon to insert the object.

 Click the icon and select an option from the icon’s drop-down menu to insert
the object.

Some icons insert an object (or perform an action) automatically, whereas others
open object- or action-specific dialog boxes prompting you to select a file or add
attributes or parameters to the object or action. When inserting objects from the
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Insert panel into Code view instead of Design view, you may also encounter the
Tag editor. In that case, enter the appropriate information and click OK to add the
object to your page.

The Files Panel

Files panel is used to manage all your site files and folders, view both remote server
and local file listings, access other files on your hard drive, and manage sites within
Dreamweaver. Files panel are used to locate and open all your site files for each
project you work on Dreamweaver.

Properties Inspector

The Properties inspector is the panel which is used for adding HTML and CSS
formatting and other attributes/properties to selected objects in your document.
Properties inspector (shown in Fig 5.11) contents change according to the object or
text selected in Code or Design view. For instance, when you are working with text,
the Properties Inspector displays properties related to text, such as the size of text,
the style (bold, italic, normal), justification (left, center, right), color, and so forth. If
you are working with a graphic, the type of graphic is displayed, the width and height,
whether it is acting as a hyperlink, and so forth.  The Properties Inspector allows
you to view and modify properties.  At the bottom of the Properties Inspector is a
small arrow, Click it to see more properties.

Fig 5.11: Properties Inspector

The properties displayed in this example deal with text Templates

Dreamweaver has created a simple and fast way to manage the look of your website
with a master file process called templates. You can create the overall design of
your website into one file, called a template, and then use that file as the base for
creating all the other pages on your site. You can also create a new file or a template.
The file extension of a Dreamweaver file is .html or .htm and for Template, file
extension is .dwt.

Templates also give you the ability to control which parts of the template-based pages
on your site can be edited and which parts remain fixed across all the pages on a
site:
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 The editable regions on a template are defined areas for specific parts of a
web document that have different content on each page of the site, such as the
page header, the main text of the page, or a subnavigation element. You need
to define and name each editable region in the template. This helps you to keep
track of the content that should be placed inside it when you create template-
based documents.

 The uneditable areas of a template, by contrast, are the parts of the layout
and design that are constant throughout the website. You do not need to define
uneditable areas in the template as you do with editable regions. . For example,
your navigation and company logo placement should be in the same location
from page to page throughout the site; these areas would be uneditable on any
template-based pages. Uneditable areas are particularly useful tool when you
work in a team with other designers, writers, and web developers.

Instead of modifying individual elements on each of the pages on managed site web
designer only need to edit and save the template, which results Dreamweaver
automatically updates the elements on all the pages which are utilized by the
template.

5.1.4 Setting Page Properties

Dreamweaver lets you set a page’s default formatting properties for a single page
in the Page Properties dialog box. This is helpful if you are creating a single file
and want to centralize CSS and other formatting options within that file. However,
if you plan on using the same styles for an entire website, it is strongly recommended
that you use a single linked external CSS file instead.

Right click mouse on the document window and click on page properties option;
you can set title, size, and color of page fonts, visited links, page margins, and
background links.

Fig. 5.12 : Setting Page Properties
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Tag
Tag instructs the browser to perform a specific function that is coded in a particular
tag. For example, paragraph tag, header, body tag etc.  It is a set or rules i.e.
commands which drags a particular execution. A tag name is enclosed in < > and
end by </  >.  For example, Head tag is shown as <head> and is used to type the
heading for the typed text. Similarly <body> tag is used to write the body of the
matter to be written.

Using DIV
DIV divides a webpage into a number of sections each of which is capable of
containing independent code but together appears as one page.

Fig 5.13 : Sections of webpage

For example, highlights and news section are two divisions where in each divided
area, you can type text, insert images etc. The contents in one division can be treated
as single entity i.e. moved, copied as one unit.

 INTEXT QUESTIONS 5.1

State True/False for the following :

1. DIV tag divides a webpage into a number of sections.

2. Body tag displays the title of the document.

3. Tag is used to perform a specific function

5.1.5 Inserting/ Adding Text

In the design view you can type the text and can do editing i.e. insert character,
delete character etc. or copy and paste text from other text editor or link to a file.

My webpage A test webpage

Highlights
News Section
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Fig 5.14 Adding text

Formatting Text

You can beautify the text by applying the following through the Property Inspector.
1. Font.
2. Size.
3. Indent.

4. Section Heading. Out of h1-h6. Select text in text  paragraph

5. Type

6. Color for background color of text

7. Alignment – You can also align the text in left, right, centre.

8. Lists – Text can also be formatted as a list. The list items are used to arrange
a group of similar items together in a webpage.

Lists are of two types – Unordered lists (Bulleted) and Ordered lists (Numbered).
(You may recall that in lesson 2 you have learnt about ordered and unordered lists).

The bulleted and numbered lists are classified as either unordered or ordered:

 Unordered: A bullet precedes all the list items.

 Ordered: The list type can be Number (1, 2, 3), Roman Large (I, II, III), Roman
small (i, ii, iii),  uppercase letters (A, B, C), or lower case letters  (a, b, c).
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9. Horizontal Rule
Select HTML  Horizontal Rule in the Insert bar. The attributes like width, height,
align of the line can be changed in Property Inspector.

Other commonly used formatting commands are bold, italic, underline.

5.1.6 Inserting Images/ Objects

 There are lot of ways you can insert an image from a file.   To insert an image
stored on your computer, select Insert  Image

Fig 5.15 : Inserting Images

Choose the desired image file from your computer.

Fig 5.16 : Image Source
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On clicking the image, you can change brightness, contrast of the image through
the property inspector.

Creating Placeholders for inserting Images

You can create an area of your choice to place an image.  For this choose,

Insert   Image   Image Placeholders.

Aligning with Images

You can align the image with text at a specific positions. Click on the Image in Design
View   change in Alignment attributes of the image. For example, top, bottom,
left, right. You can also resize them using cropping tool in picture tool bar.

5.1.7 Inserting Hyperlink

Suppose you want to refer some other text, images, and web links while working in
a webpage. But all these can not be accommodated in the same page. The Hyperlink
commands allow creating a link to an image, text, object, website or other document
in same computer or outside the computer i.e., on Internet. Hyperlinks allows to
link an object, text or file which when clicked, displays the linked text, image, file
etc.  To hyperlink text or an image, select the text or image to be hyperlinked, right
click and click Make Link.

In the dialog box that opens, select the file you want to link to, or enter a URL if you
want to link to an external page, in the URL field.

Fig 5.17 : Inserting hyperlink
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The other method for inserting hyperlink:

 You can also select the text, Insert  Hyperlink then hyperlink window (Fig. 5.18)
will be opened.

Fig 5.18 : Inserting hyperlink

 In the text box, type the text which is to be displayed as a hyperlink in the
document.

 In the Link text box, type the filename to link or you can browse to select the
folder and filename.

 In the drop down box, select the window in which you want to display the
contents of hyperlinked item.

 In Title text box, enter a caption for the hyperlink.

The hyperlinked text, word, image is underlined. When you click on the hyperlink
in browser i.e. in Internet explorer, Mozilla Firefox, Google Chrome etc. the linked
object will be displayed.

5.1.8 Formatting Techniques

To change the various attributes of the object in Property Inspector, select Format
 Inspector.  The Point to File icon allows creating links to other image, files,
object, text, document/ file in a web page using document-relative paths.  You can
also give new links using site root-relative paths.

To see the linked document, you can choose an option from the Target pop-up menu
in Property Inspector. These are:

 _blank loads the linked document in a new browser window.

 _parent loads the linked document in parent window that contains the link.

 _self loads the linked document in the same or window as the link. This is the
default target also.

 _top loads the linked document in the full browser window removing all frames.
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5.1.9 Understanding Paths

The path to a file is very crucial in website as it can be stored on different locations
i.e., local or another location on the Internet.

(i) Absolute path

Here, the documents are referred using the complete URL (Uniform Resource
Locator) of the linked document. For example, http://www.nios.ac.in/support/
dreamweaver/contents.html

(ii) Document Relative Path

Document relative paths are useful when the current document and the linked
document are in the same folder.

For example, dreamweaver/content.html.

5.1.10 Working with Tables

Tables are very important in a webpage. These are used to store and display data in
tabular form.

To create a simple table in Dreamweaver, follow these steps:

1. Place your cursor where you want the table to appear on the page.

2. Choose InsertTable.

You can also click the Table icon on the Layout category of the Insert panel.
The table dialog box appears, as shown in Fig. 5.19.

3. Specify the following attributes for the new table:

Rows and Columns: Enter the number of rows and columns for your table.

Table Width: Enter a fixed width in pixels or a percentage width between 1 and
100 percent.

Border Thickness: Enter the size, in pixels, for the table border to remove a border,
set the thickness to 0.

Cell Padding: Enter a number in pixels to increase the space between the cell’s
walls and its contents.

Cell Spacing: Enter a number in pixels to increase the thickness of the walls of the
table between the cells (an intersection of row and column).
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Fig 5.19 : Simple Table Creation

4. (Optional) Choose header for the table.
5. In the accessibility area, fill in the following fields:

 Caption: Enter a title for the table, which appears outside the table cells,
directly above the first table row.

 Summary: Type a description for your table. This information is added
to the opening Table tag and appears hidden from view in a browser but
can be read by screen readers.

6. When you finish, click OK to create your table.

Table Operations

1. Importing and exporting tabular data.

You can import the data from an application and saved in a delimited text format
separated by commas, tabs, semi-colons etc.  Data can be imported in a table
in Dreamweaver.

File  Import   Tabular Data or Insert   Table Objects   Import
Tabular Data

Fig 5.20: Import Tabular Data
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Similarly, data can be exported from Dreamweaver into a text file with contents of
adjacent cells separated by comma, semicolon, colons etc.

File  Export  Export table   filename to export.

Click Save button

2. For inserting a table, choose Insert  Table

3. Add Rows/Columns.

Fig 5.21 : Add / Delete Row

You can add, delete row/column using menu options as shown above. Right Click
on cell, choose “Table”.  Place mouse on its further options, a list of options are
available.

1. Merge Cells—Select the cells to be merged and click on merge cells icon in
Properties bar.

2. Split Cells - Select the cells to be splitted and click on Split cells icon in Properties
bar.

3. Change height of Cells.

4. Set table properties - Click on the table. Set table properties in Property bar as
shown in Fig 5.22.
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Fig 5.22 Table Properties

5. Sort Tables. Select table  Commands  Sort table

You can sort the rows / columns in a table.  For that select the order as ascending
(from A to Z) or descending (Z to A).

5.1.11 Using Forms

You might have seen that different forms are opened while browsing on Internet,
seeking information from visitors.  Forms are designed to input data from the user
so that data can be stored for future use. To insert a form, type Insert  Form

A rectangular area marked with red dashes displays on screen. Its area grows as
you keep on adding various objects/ fields into it.

Fig 5.23: Forms
Then to add various form objects, select the desired one. These are:
1. Text field  is used to store text data. You can specify the size of the text occupied

by the text field. You can give a name to text field.
Choose Insert  Form  Text field
In label, type a name for text field e.g.  Roll-No.

2. Radio button -  It allows to choose one option among the available options
3. Check box - To choose more than one option out of many available options,

checkbox is used.
4. List Item - Suppose you have to choose one option among the given large

number of options.
5. Button -  To submit the contents entered in the form, select the radio button as

Submit form.
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5.1.12 Layers

While designing a web page, you need to add multiple objects in a documents.  You
can place objects in front, behind, background and place them in different layers so
that you can work on them independently and at the same time they can be displayed
together as a one.

INTEXT QUESTIONS 5.2

1. State True or False for the following:

a. Radio button is used to choose more than one option out of many available
options.

b. Caption is used to display the title of the table.

c. Images cannot be hyperlinked with another window.

2. Fill in the blanks.

a) _____ is designed to input data from the user so that data can be stored
for future use.

b) _____ divides a browser in to multiple independent windows.

5.2 CASCADING STYLE SHEET (CSS)

Cascading Style Sheets (CSS) is a style sheet language used for describing the look
and formatting of a document written in a markup language.  You have learnt about
CSS in lesson 2.  Dreamweaver CS6 formats text with CSS as the default text styling
method (instead of HTML tags) because CSS has been implemented in all modern
browsers including the top five:  Firefox, Internet Explorer, Opera, Safari, and
Google Chrome.

To create a new CSS file follow these steps:

Choose File  New , then select Blank Page and then  select CSS.

Click on Create button as shown in Fig 5.24.
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Fig 5.24 : Create a new CSS file

5.2.1 CSS Styles Panel

The CSS Styles panel displays all the styles used with the document (with the option
to view only the styles associated with the current selection using its current view).
In fig 5.25 you can see the styles or rules (body, td, th; and body) which were applied
using the Page Properties dialog. You can also edit properties within those rules
when selected in the CSS Styles panel  (shown in Fig 5.25) and even add new ones
using the Add Property option in the Properties pane.

Fig 5.25 : CSS Style Panel
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1. In the CSS Styles panel, single click the body rule to see the properties associated
with it

2. Select the left column for font-family. The changes should take effect
immediately on the document.

3. Now click on the Edit Style... icon  to open up the CSS rule definition dialog.

4. Change the font and click OK.

5. Now in the CSS Styles panel select body, td, th and click on Add Property in
the Properties pane.

6. In the drop-down list, select font-weight and give a value of bold (shown in
fig 5.26).

Fig 5.26 : CSS Style Panel - for bold

All of the text in the document will become bold.

7. With the font-weight property selected, click on the Delete CSS
Property icon   to remove  it.

The CSS rule definition dialog will be a commonly used tool for creating and edit
style definitions.

5.2.2 Classes

Classes allow you to assign styles to specific tags within your document.
Dreamweaver uses classes for non tag-specific styles applied through the Property
Inspector (other than bold or italic which are applied through specific tags such
as b or strong and em or i).  To Change selected text color and size follow these
steps

1. Drag and select the first sentence in the first paragraph.

2. In the Property Inspector, select a large size.

3. Next, still within the Property Inspector, select a color of #000000.

The Property Inspector also now shows a new selection in the style drop-down
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marked style1. If you look at the source code for the selection, you will see a new
span was added and given the new style in the form of a class.

Checking the source of the embedded style in the document head will reveal the
new class definition.

 .style1 {

    font-size: large;

    color: #000000;

}

As a class, you can now select any other text within the document and easily apply
the same style using the Style drop-down in the Property Inspector.

Renaming Style:

To rename the style follow the following steps:

1. Select the text defined as style1.

2. In the Property Inspector, select Rename in the Style drop-down. The Rename
Style dialog box will appear(shown in Fig. 5.27).

3. If not already selected, select style1 in the Rename style drop-down.

Fig 5.27 : Rename Style

4. Give a new name for the style1.  Eg. Type first-reference

5. Click OK.

The results panel will appear showing that all instances of the style have been
renamed from style1 to first-sentence.  Classes can also be defined within the CSS
Styles panel. There are two ways to do this. You can work with the tags and classes
(attributes) first, or define style first.

To assign a class to a tag you can use the Tag Inspector panel.

1. Select the  p tag in text html document.

2. Open the Tag Inspector panel (Window Tag > Inspector).

3. Select the attributes tab if not already selected.
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4. In the Tag Inspector panel, expand the CSS/Accessibility pane if not expanded
already. There you should see options for defining class, id, style, and title.

5. In the class field, type text hello to give the P tag a class called hello.

6. Repeat for the last paragraph in the document.

Note: The Tag Inspector Panel can also be used to add multiple classes to one
element.
1. Select one of the p tags that has a class of hello.
2. In the CSS Styles panel select new_style.css in the All Rules pane.
3. Click on the new CSS Rule icon . The New CSS Rule dialog box will open

with all the necessary selections already made.
4. Click OK.
5. In the CSS Rule Definition dialog  box define a style for the hello class giving

it a Type style of italic.

Selected paragraphs in the document will be displayed as italic.

 Saving a page
To save a page select File   Save As.  This will save the file. Check the file
extension as .html or .htm.  This also uploads the webpage on Web server.

 Closing the document
To close the document select File  Close.  It will close the currently opened file.

 Opening the document
To open the document select File  Open.  Select the filename with pathname.
The selected file will be opened.

 Viewing the document in Browser
In Internet Explorer bar, view the contents in browser.

 INTEXT QUESTIONS 5.3

1. Fill in the blanks:

(a) Unordered list is also known as _______ list.

(b) Property Editor allows _______and ______common properties of the
selected object in the document.

(c) ____loads the linked document in a new, unnamed browser window.

(d) ___________ is a style sheet language used for describing the look and
formatting of a document written in markup lanaguage.
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2. State True or False for the following:

(a) Hyperlinks can link any two or more pages.

(b) URI stands for Uniform Resource Identifier.

(c) Absolute path and relative path is same.

(d) You can’t use background image.

5.3 CREATING A NEW PROJECT

5.3.1 Defining a site

Dreamweaver is a powerful tool to create a websites and organize the files which
are used to create a website. So the first and foremost thing is you have to do is
define a site while creating a new project within Dreamweaver

1. Create a folder on your hard disk and name it. You can copy in a few images
or files if you want. For example “css” folder, an “images” folder, a “js”
(JavaScript) folder, and a “fonts” folder just in case you want to use custom
fonts on your site

2. Click on Site   New Site as shown in Fig 5.28, 5.29.

Fig 5.28 : New Site
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Fig 5.29 : Name for Site

Site Name - Type  in your site name here
Local Site Folder - This is where all the files for the site are stored, the one
which you created earlier. Browse for this folder and click on select.

3. After entering your site a name and selecting the Local Site folder, click on
“Save” button to set up your Dreamweaver site.

4. Dreamweaver displays the folder contents in the Files panel (as shown in Fig
5.30) on the right side. In Fig 5.30 you can see that files are well managed and
Dreamweaver knows where to search for files.

Fig 5.30: Folder Contents
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Now you can start developing web pages, adding text, images, video, and anything
else your website needs.

WHAT YOU HAVE LEARNT

In this lesson you have learnt about creating a website using the web authoring tools
Dreamweaver. You have also learnt how the tools can be used to design a webpage
without writing the html code. The tool itself converts the icons into html language
code.   The frames divide the webpage into different windows. You have also come
to know how forms can be designed by using tools like text box, radio button,
checkbox, list box.  You have also learnt  using tables, linking different information,
pictures from various media and the importance of hyperlinks in a webpage and
their usage to links pages, images, websites, audio, video.

TERMINAL EXERCISE

1. Design a webpage with the following information:
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2. Design the following form

3. What is Dreamweaver’s ‘Document Window’ and why do you need it?

4. Distinguish between

a) Absolute path and Relative path

b) Ordered list and unordered list

5. Explain about Properties Inspector?

 ANSWERS TO INTEXT QUESTIONS

5.1

1. True.

2. False.

3. True.

5.2

1. (a) False.

(b) True.

(c) False

2. (a) Form (b) Frame
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5.3

1. (a) Bulleted

(b) editing, Viewing

(c) _blank

(d) CSS

2. (a) True

(b) True

(c) False

(d) False
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6

WEB HOSTING AND
LEGAL ASPECTS

In the previous lesson, you have learnt about Dreamweaver tool, which helped you
in designing your webpages.  Once you have designed your web pages, you must
know the next step i.e., host your files on Internet. In this lesson, we shall learn
about what is web hosting, types of web hosting(i.e. free web hosting service, shared
web hosting service, dedicated web hosting, cloud hosting and clustered hosting),
the process of buying a domain and their registration.

OBJECTIVES

After reading this lesson you will be able to

• list features of ISP;

• define the process of buying a domain and their registration;

• identify various website policies;

• describe the website content contribution policy and content review policy.

6.1 WEB HOSTING

A web hosting service is a type of Internet hosting service that provides individuals,
organizations and users with online systems for storing information, images, videos,
or any content accessible via the web.  Now we will learn about types of hosting.
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6.1.1TYPES OF HOSTING

• Free Web Hosting Service: As the name says, it is free, sometimes include
advertisement-supported web hosting, but it provides extremely limited
functionality as compared to paid hosting. Free web hosts will either provide
a sub-domain (yourname.example.com) or a directory (www.example.com/
~yourname).

Table 6.1 : List of some free web hosts

Host name Website

Netfirms www.netfirms.com

FreeServers www.freeservers.com

Tripod www.tripod.com

Webs.com www.webs.com

• Shared Web Hosting Service: It is a paid service.  Website is placed on the
server where numerous other websites are also hosted.

• Dedicated Web Hosting Service: It is paid service and  you can get your own
webserver with full control over it. However, no need to own the server.

• Cloud Hosting: It is a new type of hosting platform that provides the user
powerful, scalable and reliable hosting based on clustered load-balanced servers
and utility billing. A cloud hosted website may be more reliable than hosting
alternatives since other computers in the cloud can compensate when a single
piece of hardware goes down.

• Clustered hosting:  Here, multiple servers host the same content, with an
objective of  better resource utilization. Clustered servers are a perfect solution
as it provides high-available dedicated hosting, or creating a scalable web
hosting solution. A cluster may separate web serving from database hosting
capability.

6.2 TERMS ASSOCIATED WITH WEBSITE HOSTING

The commonly used terms associated with web hosting are, web hosting services,
file storage space and bandwidth.

To make your website live, you transfer your website files to a webserver. A web
server is a computer connected to the Internet and running server software. The
software lets the computer use the Hypertext Transfer Protocol (HTTP) to serve
HTML files to web browser clients. Unless your company or organization has a
web server, you must use the services of a web hosting provider. After you choose
a server to host your files, you will need to select file transfer software and upload
the files to the web server.
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Internet Service Provider

Web hosting service or Internet Service Provider (lSP) is the company that hosts
your web pages on a Web server, so that they become available to anyone who knows
your URL. Web hosting services provide web server space only, and are capable
of hosting a complex commercial site. ISPs provide dial-up access and offer web
server space as part of the access package. Small websites (around 15-20 pages of
content) do not need much more than 1- 2 MB of server space to hold all of the
HTML pages and graphics. Your ISP should provide at least 10 MB of space so
that your web page has room to grow. Larger or more complex sites need more server
space, especially if you have downloadable files, archives, lots of graphic content,
or databases.

Shopping for an ISP can be a confusing experience, as no two are exactly alike. Do
some research and learn about offerings from different vendors. The following
sections discuss the features you should seek in an ISP.

Easy Dial-Up

Choose an ISP that allows connection with their network by placing a local phone
call. Make sure that your provider has enough Points of Presence (POP) to make
dialling easy. Points of Presence (POPs) are dial-up access points of service
provider’s network. The service provider should have at least one POP available
so you can dial a local number to access the network.

The number of times your site is accessed by you or user is called bandwidth. If
you are expecting a lot of hits (millions of page views) to your site you will need to
get the most bandwidth you can afford.

Data card/mobile broadband

A Mobile broadband modem, also known as data card. This type of modem that
allows a laptop, a personal computer or a router to receive internet access via mobile
broadband connection instead of using telephone(Dial-up) or cable television lines.

Free Utility Software

ISP provides a File Transfer Protocol (FTP) application for uploading files. Some
ISPs provide HTML editors and other software as well.

Accessible Technical Support

Although technical support is not necessarily a feature, but it is an absolute necessity.
Make sure that ISP has competent, accessible customer service.
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Additional E-mail Addresses

All access accounts come with at least one e-mail address, called a Post Office
Protocol 3 (POP3) account. If you are part of a group, you may want an account
that has more than one mailbox so that each person receives his or her own e-mail.

Personal versus Commercial Accounts

Personal ISP accounts generally are less expensive than a business account. The

personal account necessarily requires disk space, fewer features, and can have more

complex URL, such as www.webserver.com/users/yourname/. Once you buy a

domain name, your ISP usually upgrades you to a commercial account. For

commercial accounts pay more for their services, so make sure you receive more

facilities.

SQL Database Support

While planning for any type of e-commerce or customized data presentation, you

need database support. Databases that understand Structured Query Language

(SQL) are the most common and powerful type of database.

Secure Socket Layer (SSL)

Secure Socket Layer (SSL) is an Internet communications protocol that allows

encrypted transmission of data between the user and the server. SSL is necessary if

you are planning on setting up an electronic commerce site or transmitting other

sensitive data. Encrypting the data ensures the information cannot be read if the

transmission is intercepted.

Multimedia Capabilities

Streaming is a server-based technology that transmits audio video content in a

continuous stream to the user, allowing the content to be played while it is

downloading, rather than waiting for its complete download. The success of these

technologies depends on the speed and quality of the user’s connection to the

Internet. The user needs the correct streaming media player to view the content.

CGI Script Capabilities

The Common Gateway Interface (CGI) is the communications bridge between the

Internet and the server, using the programs called scripts, CGI can collect data sent
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by a user via the Hypertext Transfer Protocol (HTTP) and transfer it to a variety of
data processing programs including spreadsheets, databases, or other software
running on the server. The data processing software can work with the data and
send a response back to CGI, and then onto the user, as shown in Fig. 6.1 (Common
Gateway Interface Architecture).

Fig 6.1 Common Gateway Interface Architecture

The program that transfers the data is called as CGI script. You can write CGI scripts
in a variety of programming languages. If you are not already familiar with writing
CGI scripts, enlist the assistance of a programmer, or you should have master
programming skills in addition to your HTML skills.

Buying a Domain Name

The Domain Name System (DNS) is a hierarchical distributed naming system for
computers, services, or any resource connected to the Internet or a private network.
It associates various information with domain names assigned to each of the
participating entities. A Domain Name Service resolves queries for these names
into IP addresses for the purpose of locating computer services and devices
worldwide. By providing a worldwide, distributed keyword-based redirection
service, the Domain Name System is an essential component of the functionality
of the Internet.

Domain is the unique name for the computer to which you are connecting.  All
Domain names have a 4-part number address like 207.46.130.150 but most have a
name using letters too, like www.microsoft.com. A dot character always separates
the parts of name.

There are four key steps to be followed to get a website:

1. Decide on a name and search for the domain to see if it is available.

2. If the domain name is available, then register it.
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3. Buy a webhosting account for the name and link it to the hosting account using
the nameservers.

4. Install, build and configure the website.

To find if a domain name is available, or to register your own domain name, a lot of
vendors are available in website search list.  The following are the few examples of
domain seller sites.

1. http://www.net4.in

2. http://www.domainindia.org/

3. http://www.networksolutions.com/

These companies are responsible for registering .com, .net, and .org domain names.

The site contains a simple form that lets you enter a domain name to see if it is
already registered. If the domain name is available, you can register online and the
payment can be made through your debit card, credit card or by any net-banking
payment method. Domain names currently must be renewed every two years.

For an additional fee, your ISP often can register your website and provide network
solutions with all the details, such as the server’s primary and secondary Internet
Protocol (IP) addresses. If you prefer, you can save the cost of doing this by filling
out the online forms yourself, but you still need to contact your ISP to get the IP
addresses.

ISP Comparison Checklist

Use the following checklist when you compare ISPs.

• Is the ISP local or national?

• Does the ISP have enough local POPs in your area code?

• Is there space available on their web server for your website?

• Does the ISP offer technical support? Is the support available by 24x7?

• How many email addresses do you get with an account?

• Does the ISP provide software such as FTP client?

Upload a web page with FTP

To publish your pages on the web, you must send your files (HTML code, Image
etc) to the web host server.  This is done using an FTP program.

FTP (File Transfer Protocol) is the simplest and most secure way to exchange files
over the Internet. The most common use of FTP is to download files from the
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Internet. In addition, the ability to transfer files back-and-forth makes FTP essential
for anyone creating a web page, amateurs and professionals alike.

When downloading a file from Internet you are actually transferring a file to your
computer from another computer over the Internet. You may not know the location
of the computer that the file is coming from but you most likely to know its URL or
Internet address.

An FTP address looks a lot like an HTTP, or website address except it uses the prefix
ftp: // instead of http://.

Most often, a computer with a FTP address is dedicated to receive a FTP connection.
Just as a computer that is setup to host web pages is referred to as a webserver or
website, a computer dedicated to receive an FTP connection is referred to as an
FTP server or FTP site.

Now you will learn how to upload a file using FTP. There are lots of FTP software
programs available, and they will work on similar principles. With each you will
need the IP address of your web host, your username and your password.

There are a number of good free FTP tools (WSFTP, Cute-FTP etc) available in the
websites, so you can download and install in your computer. In fact, many website
design programs come with in-built FTP publishing tools.   It is very convenient to
use a website design tool with built in FTP but you can also get specialized FTP
software.

INTEXT QUESTIONS 6.1

1. State True and False for the following questions.

(a) The Secure Socket Layer (SSL) is an Internet communications protocol
that allows encrypted transmission of data between the user and the server.

(b) The Common Gateway Interface (CGI) is the communications bridge
between the Internet and the server.

(c) FTP (File Transfer Protocol) is NOT secure way to exchange files over
the Internet.

2. Fill in the blanks.

(a) Free web hosts will provide either _____ or _________.

(b) _________ service is paid service and you can get your own webserver
with full control over it.

(c) The most common use of FTP is to ___________.
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6.3 WEBSITE POLICIES

A website policy is a set of documents telling visitors of website what information
they can collect and what they can do with that information.

The following are the reasons for developing a website policy :

1. Create a better electronic environment on the internet.

2. Imply the laws / legislation that may pertain to your business.

3. Create a transparent environment to users/stake-holders.

4. Set down the rules and regulations to operate and manage website effectively.

By letting people know what information is collected and what is done with that
information, you can create a transparent environment in which people/consumers
gain confidence. You can eliminate stress and concerns about abuse of personal
information.

National Informatics centre (NIC), India prepared guidelines on year 2009 titled
as “Guidelines for Indian Government websites”.These guidelines are available
on the following link: guidelines.gov.in/documents/pdf/hand-book.pdf

Table 6.2 : Guidelines for Indian Government websites

S.No                                 Website Policy

1 Copyright Policy

2 Hyper linking Policy

3 Terms & Conditions

4 Privacy policy

5 Content Contribution, Moderation and Approval Policy (CMAP)

6 Web Content Review Policy (CRP)

7 Content Archival Policy (CAP)

8 Website Security Policy

9 Website Monitoring Policy

10 Contingency Management

Which legal pages should every website have? The short answer is, “It depends”.
And, there is no rule saying that a website needs to have any legal pages whatsoever.
You need to take a look at your website and evaluate it (with or without legal counsel),
to determine if you need a specific type of legal page. Here are some thoughts on
most common types of legal pages and when you might want or need them.

6.3.1Copyright Policy

Copyright is the right of the owner to reproduce or permit someone else to reproduce
copyrighted works. Copyrightable works include:
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• literary works such as articles, stories, journals, or computer programs.

• pictures and graphics.

• blueprints of architecture.

• music and song lyrics.

• plays and screenplays.

• audio visual recordings such as movies.

• sound recordings.

So the information, content available at your website must be backed up with proper
copyright policy explaining terms and conditions of their usage and reference by
others.

Copyright violation The most common types of copyright violation on the web
are images being used on websites other than the owners. It does not matter if you
copy the image to your web server or point to it on their webserver.  If you use an
image on your web site that you did not create, you must get permission from the
owner. It is also common for the text, HTML, and script elements of a page to be
taken and reused. If you have not sought permission, you have violated the owner’s
copyright. Today, companies take this type of violations very seriously.

6.3.2Hyperlinking Policy

A feature of an accessible site is to have access keys to various parts of the pages.
Adding an accessibility key can be helpful so that new customers know the
functionality and usage of each page on your site. Accessibility information pages
can also include links to contact pages when a page is inaccessible or help finding
alternatives for things like audio/video streams.

Every website must have a comprehensive and clear-cut hyperlinking policy defined
and spelt out for those who wish to hyperlink content from any of its sections. The
basic hyperlinking practices and rules should ideally be common across the website.

6.3.3 Terms and Conditions

Many websites include terms and conditions to use documents on their site. This
explains what actions are allowed and disallowed while using the website. Clearly
defined terms and conditions including well-worded disclaimers regarding the usage
of websites must be present on every website.

Terms and conditions shall address the following aspects:

• Ownership Details.

• Usage Policy of Content.
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• Legal Aspects.

• Responsibility towards hyperlinked sites.

6.3.4. Privacy Policy

Privacy policies are one legal page that any particular website which is collecting
any type of information from their customers should have.  A privacy policy should
cover the following:

• Use of cookies and other trackers;

• How do you use personal information collected;

• To whom you distribute collected information to;

• Contact information for erasing private information;

• Information about third-party sites that might collect information (such as

advertisers);

• Editing dates when the document is changed

6.3.5 Content contribution, Moderation and Approval Policy
(CMAP)

Each and every bit of content published on website should be verified and checked
thoroughly by the experts. This policy needs three types of roles like Content
Contributor, Moderator and Approver. This will ensure all contents posted on the
website are authentic, up-to-date and latest.

The website must show the Content contribution, Moderation and Approval Policy
(CMAP) stating the responsibility, authorization and workflow details with regard

to content publishing on the site.

Table 6.3 : Shows a sample CMAP policy.

S. No Content Element Moderator Approver Contributor

1 About  Company Web Information Manager CEO Content  Manager

2 IT Acts/Rules/Regulation Web Information Manager Director Content  Manager

3 Publications/Reports Web Information Manager Director Content  Manager

4 Contact Details Web Information Manager Director Content  Manager

5 What’s New Web Information Manager Director Content  Manager

6 Tenders /Recruitments Web Information Manager Admin & Finance Content  Manager
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6.3.6Web Content Review Policy (CRP)

All webpages of a website needs  to be reviewed frequently within a specified time
period. For example, the review committee of the organization has to review the
web pages monthly/ quarterly or yearly basis. Also the Web Content Review Policy
must be published at their website.

6.3.7Content Archival Policy (CAP)

Sensitive content which expires after a certain date (e.g. tender notifications,
announcements for conference registrations, contest entries etc) a policy on whether
the content should be archived for future reference or removed altogether from the
website should be decided by the concerned Department Manager after careful
consideration about nature of content. However, ‘expired’ content must not be
presented or flashed on the website. The Departments must have a clearly laid out
Content Archival Policy (CAP) clarifying the rules set in this regard.

6.3.8Website Security Policy

With cybercrimes on the rise, protecting your corporate information and assets is
vital. Your company should have a security policy document that outlines what and
how you plan to protect your company’s information and assets. You can prepare a
security policy document in-house, or outsource the project to security consultants.

The first step in any project to prepare a security policy document is to determine
what elements to include in your policy. Be sure to consider all the key elements
your IT staff manages.  We recommend you cover each of the areas listed below.

• Security accountability: Stipulate the security roles and responsibilities of
general users, key staff, and management. Creating accountability in these three
employee categories helps your organization understand and manage
expectations and provides a foundation for enforcing all other ancillary policies
and procedures. This section should also define various classes of data, such
as internal, external, general, and confidential.  By classifying the data, you can
make stipulations as to what types of employees are responsible for, and allowed
to modify or distribute, particular classes of data. For example, you can send
out memos that say, “No confidential data may be circulated outside the company
without management sign-off.”

• Network service policies: Define your remote network access policies and
your network intrusion detection systems. Generate policies for secure remote
access, IP address management and configuration, router and switch security
procedures, and access list (ACL) stipulations. Indicate clearly, which key staff
needs to review which change procedures before they are implemented. For
example, your security team should review all proposed ACL changes before
your network administrators implement the changes.
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• System policies: Define the host security configuration for all mission-critical
operating systems and servers, tells which services should be running on which
networks, account management policies, password management policies,
messaging, database, anti-virus, host-based intrusion detection, and firewall
policies.

• Physical security: Define how buildings and card-key readers should be
secured, where internal cameras should be installed, how visitors would be
handled, and what inventory rules and regulations your shipping and receiving
folks should follow. Though this might seem a bit of a discussion of IT security,
remember that no organization is secured from attack unless it’s physically
secure too.

• Incident handling and response: Specify what procedures to follow in the
event of a security breach or incident. Include policies such as how to evaluate
a security incident, how the incident should be reported, how the problem should
be eradicated, and what key personnel your organization should engage in the
process.

• Behavior and acceptable use policies: Stipulate what type of behavior is
expected of employees and your management team, and what forms and
documents need to be read, reviewed, filled out, and followed. Employees should
be required to read and sign the acceptable use policy so that management has
the option to take disciplinary action in the event that the policy is violated.

• Security training: Define a security training plan for key staff who manages
day-to-day security operations in order to sustain your security policy and keep
your security staff current with the latest techniques.

Once you have established policies that suit your organization, you should draft
procedures that outline how to comply with the policies like how you secure operating
systems, what files to edit and configure, what ports should be open and closed on
the firewall, how databases should be secured, and what updates need to be applied
on what timeframe. Also include what jobs should be run and when.

6.3.9 Website Monitoring Policy

Web being a dynamic medium, changes in terms of technologies, access devices
and even the requirements and expectation levels of visitors happen fairly frequently.
Keeping this in mind, websites must have a website monitoring policy in place.
Websites must be monitored periodically in accordance with the plan to address and
fix the quality and compatibility issues around the following parameters:

a. Performance:  Website download time should be optimized for a variety of
network connections as well as devices. All important pages of the website should
be tested for this.
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b. Functionality: All modules of the website should be tested for their functionality.
Moreover, interactive components of the site such as discussion boards, opinion
polls, feedback forms etc., should be working smoothly.

c. Broken Links: The website should be thoroughly reviewed to rule out the
presence of any broken links or errors. A number of tools and techniques are
now available to easily detect the broken links in a website.

d. Traffic Analysis: The website traffic should be regularly monitored to analyze
the usage patterns as well as visitors’ profile and preferences. Traffic analysis
tools also give reports on broken links.

e. Feedback: Feedback from the visitors is the best way to judge a website’s
performance and make necessary improvements. A proper mechanism for
feedback analysis should be in place to carry out the changes and enhancements
as suggested by the visitors.

6.3.10 Contingency Management Policy

It is very important that the website is fully functional at all times. Hence, all efforts
should be made to minimize the downtime of the website as far as possible. It is
therefore necessary that a proper contingency plan to be prepared in advance to
handle any eventualities and restore the website in the shortest possible time. The
possible contingencies include:

Defacement of the website: All possible security measures to be taken for a
website to prevent any possible defacement/hacking by unscrupulous elements.
However, if despite the security measures in place, such as eventuality occurs, there
must be a proper contingency plan, which should immediately come into force.

Data Corruption: A proper mechanism has to be worked out, in consultation with
web hosting service provider to ensure that appropriate and regular back-ups of the
website data are being taken. These enable a fast recovery and uninterrupted
availability of the information to the citizens in view of any data corruption.

Hardware/Software Failure: Though such occurrence is a rare, still in case the
server on which the website is being hosted crashes due to some unforeseen reason,
the web hosting service provider must have enough redundant infrastructure available
to restore the website at the earliest.

Natural Disasters: There could be circumstances like due to some natural calamity,
the entire data center where the website is being hosted gets destroyed or ceases
to exist. In such cases well planned contingency mechanism has to be in place for
such eventualities whereby it should be ensured that the hosting service provider
has a ‘Disaster Recovery Centre (DRC)’ set up at a geographically remote location
and the website is switched over to the DRC with minimum delay and restored on
the net.
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Apart from the above, the well defined contingency plan for all such eventualities
must be in place within all organizations, so that the emergency information/contact
help-lines could be displayed on the website without any delay.

6.3.11 Website Disclaimer

A Website Disclaimer is a common method used to limit the liability of the owner
of the website. Providing a disclaimer is an approach that can be used to ensure a
website’s information is not improperly relied upon.

For example, if anyone is to rely on the website’s information the site will not be
held responsible for any loss or other result. A disclaimer will also state that
information on the website may at any time be changed or updated, without notice.

Another important aspect of website disclaimers is when a website provides links
to others sites or articles, there will be a disclaimer providing that the expression
and content in these linked sites is not necessarily the views of that of website or

company. As a result, it is essential to post a website disclaimer to protect your site

from making any representations outside the scope of your control.

INTEXT QUESTIONS 6.2

1. Fill in the blanks:

(a) ________________ policy is the right of the owner to reproduce or permit
someone else to reproduce copyrighted works.

(b) Each and every bit of content published on website should be verified and
checked thoroughly by the expertise of organizations. This policy needs
three types of roles like Content Contributor, ____________ and
____________.

2. Which policy helps to protect your company assets and information?

a) Copyright policy

b) Hyperlinking policy

c) Privacy policy

d) Website security policy

3. What is CAP?

a) Content Archival policy

b) Content achieved policy
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WHAT YOU HAVE LEARNT

In this lesson you have learnt about what is webhosting, different types of webhosting
service, terms associated with these services, features of ISP.  Now you are aware
with the process of buying domain and steps to publish the website.  You have also
learnt the importance of website policies and how and whan it will be used for your
website/your organizations website. you have also learnt different website policies
and legal aspects while designing website.

TERMINAL EXERCISE

1. What are the terms associated with website hosting and Domain registration
process?  Explain in more details.

2. What do you know about “Guidelines for Indian Government websites”?  List
out the various website policies in details.

3. What is copyright violation?

4. What is privacy policy?

5. Write  a short note on website security policy?

6. Are you thinking that do we have to monitor our websites. If yes then why?

ANSWERS TO INTEXT QUESTIONS

  6.1

1.

(a) True

(b) True

(c) False

2.

(a) Sub domain, a directory

(b) Dedicated web hosting

(c) Download files (from internet) or exchange files

  6.2

1.

(a) Copyright

(b) Moderator and Approver

2. d) Website security

3. a) Content Archival Policy
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7

UNIVERSAL  ACCESSIBILITY

In web designing, the concept of accessibility is of prime importance for persons
with disabilities.  You may aware that National Informatics Centre (NIC), Government
of India has issued Guidelines for  Indian Government websites (GIGW) which
includes the accessibility norms for websites as an important component.  However,
before we proceed further in explaining the accessibility norms for web designing,
it is important for you to understand the terms disability, accessibility, types of
disabilities, types of barriers and barrier free design especially for website.  In this
lesson, we shall learn about the disability, types of disabilities, types of barriers and
use of universal design (it refers to an idea to produce a product which is inherently
accessible to old people, people with and without disabilities) for designing a website.

OBJECTIVES

After reading this lesson, you will be able to :

• define disability;

• describe the types of disabilities;

• identify types of barriers;

• describe web accessibility;

• use universal web design.
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7.1 WHAT IS DISABILITY?

A disability may be physical, cognitive, mental, sensory, emotional and
developmental or some combination of these. A disability may be present from birth,
or occur during a person’s lifetime.  Disability is an umbrella term (a broader term)
covering impairments, activity limitations, and participation restrictions.

7.1.1 Types of Disabilities

If you think quietly, you will feel that we are all physically disabled at some time in
our lives. An individual, a person with a broken leg, a parent with a pram, an elderly
person, etc., are all disabled in one way or another.

The two categories of disabilities are:

(i) Mental Disabilities – related to the brain like cerebral palsy, learning disability.

(ii) Physical Disabilities – like visual impairment, hearing impairment.

� Mental Disabilities - Related to the Brain

�  Mentally Challenged/ Mental Sub-normality / Mental Retardation (MR) 

Mentally challenged means a condition of incomplete development of
mind of a person that is characterized by ‘sub-normality of intelligence’.

� Cerebral Palsy (CP) 

Cerebral Palsy (CP) is the name given to a group of conditions
characterized by brain damage that produces a disorder of movement or
posture.

These ‘individuals’ have multiple handicaps, hearing impairments, speech
defects, epilepsy, etc. These individuals may have difficulty with fine
motor tasks, such as writing or cutting with scissors; experience trouble
with maintaining balance and walking; or be affected by involuntary
movements, such as uncontrollable writhing motion of the hands or
drooling.

�  Autism 

Autism is an information processing disorder for which the causes are not
known. But it is not a disease an individual can catch, nor is it something
one can cause or create.

It affects in the areas of communication, socialization, cognition,
imagination and intuitive thought of the individual.  Autistic individuals
can hear, see and feel, yet have difficulty in understanding and expressing
what their senses tell them indicating that they suffer from learning
difficulties. Skills that a normal individuals picks up naturally have to be
TAUGHT to individuals with autism.
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�  Learning Disability (LD) 

Learning disability means a disorder in one or more of the basic psychological
processes involved in understanding or in using a language, spoken or
written, which may manifest in an imperfect ability to listen, think, read,
write, spell or do mathematical calculations.

There are different kinds of learning disabilities.

• Dyslexia - Reading disorders.

• Dysgraphia - Disorders of written expression. Extremely poor
handwriting or the inability to perform the motor movements required for
handwriting.

• Dyscalculia - Mathematical disabilities.

� Physical Disabilities - Related to Body and  Sensory Functions

The following are the major physical disabilities.

• Orthopaedically Handicapped/ Locomotor Disabilities 

In orthopedically/ locomotors disabilities polio victims, accident victims
(where limbs and trunk have been affected) and individuals who have
congenital physical handicaps are included.  The mobility of an individual
gets affected in orthopedically/ locomotors disabilities. The mobility of
an individual with disability can be greatly improved by using various aids,
appliances and equipments.  These equipments also help such learners in
accessing the web.

• Visual Impairment 

A person whose vision is affected is referred to as visually impaired. When
our vision is impaired, 60 to 70% of inputs from the outside world are
affected. 

There are different causes for blindness like diseases of the eye and its
nerves.  Blindness can also result from damage to that part of the brain
which interprets the nerve sensations sent from the eye.

• Hearing Impairment 

Hearing loss can be of different degrees varying from total deafness to
hard of hearing.
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 INTEXT QUESTIONS 7.1

1. State True or False.

(i) A disability may be physical, cognitive, mental, emotional and developmental
or some combination of there.

(ii) Mental and physical disabilities are the two categories of disabilities.

2. Fill in the blanks:

(i) Disability is either ——————————— or ———————.

(ii) Dyslexia is a kind of ——————————  disability.

(iii) Individuals suffering from Cerebral Palsy are also referred to as ———
————————— individuals.

7.2 TYPES OF BARRIERS

Barriers are obstacles that make it difficult and sometimes impossible for people
with disabilities to do the things most of us do it at case.

When we think of barriers to accessibility, most of us think of physical barriers
like a person who uses a wheelchair not being able to enter a public building because
there is no ramp.  The fact is that there are many kinds of barriers. Some are visible
and many are invisible.

7.2.1  Information and Communications Technology barriers

Such type of barriers are also very common and such barriers happen when a person
can not easily understand information or when a technology can  not be modified
to support various assistive devices.  The following are examples of such ICT
barriers:

• Print is too small to read.

• Websites that can not be accessed by people who are not able to use a mouse.

• Signs that are not clear or easily understood.

• A website that does not support screen-reading software or large print option
large text option or contrast scheme.

In modern societies with developed technologies, access to information and
communication is a basic prerequisite for all areas of living and working. However,
many types of communication, such as telephone, radio and television are not
accessible for persons with impaired hearing, just as many information and services
are not accessible for persons of impaired sight.

The majority of information prepared for the public in print is not accessible to
persons who are blind or with impaired vision because these infomation are not



154 :: Universal Accessibility

Notes

WEB DEVELOPMENT

printed in large fonts or in Braille, or the material is not available in audio format.
Communication at all levels presents people with impaired hearing with a huge
problem due to lack of devices for voice synchronisation or sign language
interpreters.

Due to all these, a huge number of persons with disabilities suffer from discrimination
in the field of communication and access to information. However, with the
development of technology and software for converting text into speech and vice
versa, there is certainly technological empowerment of certain categories of persons
with disabilities.

7.2.2 Attitudinal barriers

The attitudinal barriers are detrimental for any knowledge society.  Such barriers
are those that discriminate against people with disabilities.  For example:

• thinking that people with disabilities are inferior

• assuming that a persons with disabilities need not have access to information.

7.2.3  Barrier Free Design

In today’s Internet era, the web is an increasingly important resource in many aspects
of life: education, employment, government, commerce, health care, recreation, and
more. It is essential that the website you are planning to develop be accessible in
order to provide equal access and equal opportunity to people with disabilities.

An accessible web can also help people with disabilities to be more independent
and participate actively in the society. The web offers the possibility
of unprecedented access to information and interaction for many people with
disabilities. That is, the accessibility barriers to print, audio, and visual media can
be much more easily overcome through barrier free web technologies.

Another important consideration for organisations is that web accessibility is
required by laws and policies in some cases. The organisations are required to follow
the Web Content Accessibility Guidelines (WCAG) while designing and developing
a website. These guidelines are considered as the international standard for Web
accessibility.

 INTEXT QUESTIONS 7.2

1. Fill in the blanks:

(a) Website that does not support screen reading software or large print option.
This is an example of  ———————— barrier.

(b) Organisations are required to follow the webcontent —————
guidelines.

(c) Eyes send the sensations to the ___________________.
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(d) Mental disability is related to brain and physical disability related to
___________________.

2. State True or False for the following:

(a) Blindness related with mental disability.

(b) website is a collection of webpages.

(c) U.S government issued guidelines for Indian Government Websites.

7.3 WHAT IS ACCESSIBILITY?

Accessibility

Accessibility is the degree to which a product, device, service, or environment is
available to as many people as possible.  Accessibility can be viewed as the “ability
to access” and benefit from some system or entity. The concept of accessibility often
focuses for people with disabilities or special needs and their right of access,
enabling the use of assistive technology.

Accessibility is strongly related to universal design when the approach involves
“direct access”.  This is about making things accessible to all people (whether they
have a disability or not). An alternative is to provide “indirect access” by using
person’s assistive technology to achieve access (for example, computer screen
readers).

7.3.1  Web Accessibility

Web accessibility means that people with disabilities can also perceive, understand,
navigate, and interact with the web, and that they can contribute to the web. It
encompasses all disabilities that affect access to the web, including visual, auditory,
physical, speech, cognitive, and neurological disabilities.

When websites are correctly designed, developed and edited, all users can have
equal access to information and functionality. For example, when a website is coded
with semantically meaningful HTML, with textual equivalents provided for images
and with links named meaningfully, this helps blind users using text-to-speech
software or text-to-Braille hardware. When text and images are large or enlargeable,
it is easier for users with low vision to read and understand the content. When links
are underlined (or otherwise differentiated) as well as colored, this ensures that color
blind users will be able to notice them. When clickable link areas are large, this
helps users who cannot control a mouse with precision.

When pages are coded so that users can navigate by means of the keyboard alone,
this helps users who cannot use a mouse due to locomotor problem. When videos
are having text captioned or a sign language version is available, deaf and hard-
of-hearing users can understand the video. When the websites are correctly built
and maintained, all of these can be accommodated without decreasing the usability
of the website for non-disabled users.
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7.3.2 Accessibility Area

The following are the dimensions for the persons with disability that you need to
address while designing or developing accessible websites:

• Visual: Visual impairments including, blindness various common types of low
vision and poor eyesight, various types of color blindness;

• Locomotor/Mobility: difficulty or inability to use the hands, loss of muscle
control etc. due to conditions such as Parkinson’s Disease, muscular
dystrophy, cerebral palsy, stroke;

• Auditory: Deafness or hearing impairments, including individuals who are hard
of hearing;

• Seizures: Photo epileptic seizures caused by visual strobe or flashing effects.

• Cognitive/Intellectual: Developmental disabilities, learning disabilities
(dyslexia), and cognitive disabilities of various origins.

7.3.3 Accessibility Guidelines

Website should be designed and developed in such a way that it should be accessible
by all people, whatever may be their hardware, software, language, culture, location,
or physical or mental ability. When the web meets this goal, it is accessible to people
with a diverse range of hearing, movement, sight, and cognitivedis ability as well
as to normal people.

Thus the impact of disability is radically changed on the web because the web
removes barriers to communication and interaction that many people face in the
physical world.  If you will design websites badly it can create barriers that exclude
people from using the web.  It is essential that the web be accessible in order to
provide equal access and equal opportunity to people with diverse abilities.

Examples of Web Accessibility

There are many sites which are developed with accessibility barriers that make it
difficult or impossible for some people to use them, for example an image is  inserted
or displayed in the Website. The image information is inaccessible as  image can
not be read by the people who cannot see, as well as the screen reader does not

Fig. 7.1: Picture for ALT text
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read the image and it becomes inaccessible for the person with visual disability.

To overcome the problem, alternative text can be provided that reads aloud the
information on a page, including the alt text for the visual image.  Below are just a
few examples for alternative text for images as shown in Fig 7.1.

<img src="images/slide4.jpg" alt="Group 7:Student taking examination"
width="357"  height="185" />

Alt text is the classic example. Images should include equivalent alternative text
in the markup/code.

If alternate text is not provided for images, the image information is inaccessible.
When equivalent alt text is provided, the information is available to everyone including
blind, or those who turned off images on their mobile phone to lower bandwidth
charges.

Keyboard Input

Some people cannot use a mouse, including many older users with limited fine
motor control. An accessible website does not rely on the mouse; it provides  all
functionality via a keyboard , then people with disabilities can use assistive
technologies that mimic the keyboard, such as speech input.

Text Transcript

Just as images are not available to people who can not see, audio files are not
available to people who can not hear. Providing a text transcript makes the audio
information accessible to people who are deaf or hard of hearing, as well as to search
engines and other technologies that can not hear. It’s easy and relatively inexpensive
for website developers to provide transcripts for podcasts and audio files.
Accessibility is an essential component for developers that will help in creating
high quality websites and web tools, and not exclude people from using their
products and services.

7.3.4 Web Content Accessibility Guidelines (WCAG)

Web Content Accessibility Guidelines (WCAG) 2.0 covers a wide range of
recommendations for making webcontent more accessible. Following these
guidelines will make content accessible to a wider range of people with disabilities,
including blindness and low vision, deafness and hearing loss, learning disabilities,
cognitive limitations, limited movement, speech disabilities, photosensitivity and
combinations of these. Following these guidelines will also often make webcontent
more usable to users in general.

WCAG 2.0 success criteria are written as testable statements that are not technology-
specific. WCAG 2.0 succeeds Web Content Accessibility Guidelines
1.0 [WCAG10], which was published as a W3C Recommendation May 1999.
Although it is possible to conform either to WCAG 1.0 or to WCAG 2.0 (or both),
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the W3C recommends that new and updated content use WCAG 2.0. The W3C
also recommends that web accessibility policies reference WCAG 2.0.

Four Principles and 12 Guidelines of Web Accessibility

The guidelines and success criteria for any website are organized around the following
four principles of web accessibility, which lay the foundation necessary for anyone
to access and use web content. The four principles of  accessibility is also known
by the acronym POUR that means the content of your website must be Perceivable,
Operable, Understandable and Robust. Anyone who wants to use the web must
have content that is:

� Perceivable

Information and user interface components must be presentable to users in
ways they can perceive. This means that users must be able to perceive the
information being presented. It can not be invisible to all of their senses. Under
Perceivable the following 4 guidelines have to be adhered :-

• Provide text alternatives for any non-text content so that it can be  changed
into other forms people need, such as large print, braille, speech, symbols or
simpler language.

• Provide alternatives for time-based media.

• Create content that can be presented in different ways (for example simpler
layout) without losing information or structure.

• Make it easier for users to see and hear content (include separating foreground
from background).

� Operable

User interface components and navigation must be operable. This means that
users must be able to operate the interface. The interface cannot require any
such interaction that a user cannot perform. Under Operable the following 4
guidelines has to be adhered :-

•  Make all functionality available from a keyboard.

•  Provide users enough time to read and use content.

•  Do not design content in a way that is known to cause seizures.

•  Provide ways to help users navigate, find content, and determine where they
are available.

� Understandable

Information and the operation of user interface must be understandable. This
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means that users must be able to understand the information as well as the
operation of the user interface.  The content or operation cannot be beyond
their understanding. The following  guidelines have to be taken care of under
understandable:-

• Make text content readable and understandable.

• Make web pages appear and operate in predictable ways.

• Help users to avoid and correct mistakes.

� Robust

Content must be robust enough that it can be interpreted reliably by a wide variety
of user agents, including assistive technologies. This means that users must be able
to access the content as technologies advance.

The following guideline has to be taken care of

• Maximize compatibility with current and future user agents, including assistive
technologies.

If any one of the above guidelines is not followed then users with disabilities
will not be able to use the web.

7.4 ASSISTIVE TECHNOLOGIES FOR WEB BROWSING

Many times you will notice that persons with disability use various technologies
for browsing the web which are called Assistive Technologies.  Some of these
assistive technologies which enable and assist them in web browsing are as under:

Screen reader: It is a software, which can read out, using synthesized speech, either
selected elements of what is being displayed on the monitor (helpful for users with
reading or learning difficulties), or which can read out everything that is happening
on the computer (used by blind and visually impaired users).

Braille terminals: It consists of a refreshable Braille display which renders text
as Braille characters either a QWERTY or Braille keyboard.

Screen magnification: It is software, which enlarges what is displayed on the
computer monitor, making it easier to read for visually impaired users.

Speech recognition: It is software that can accept spoken commands to the
computer, or turn dictation into grammatically correct text - useful for those who
have difficulty using a mouse or a keyboard.

Keyboard overlays: It makes typing easier and more accurate for those who have
motor control difficulties.

7.5 MAKING YOUR WEBSITE ACCESSIBLE

Making a website accessible can be simple or complex, depending on many factors
such as the type of content, the size and complexity of the site, and the development



160 :: Universal Accessibility

Notes

WEB DEVELOPMENT

tools and environment. Many accessibility features are easily implemented if they
are planned from the beginning of website development or redesign. Fixing
inaccessible websites can require significant effort, especially sites that were not
originally “coded” properly with standard XHTML markup, and sites with certain
types of content such as multimedia.

7.5.1 Web Accessibility Features

There are various norms for the accessibility features.  The following are the
important accessibility features you must incorporate while designing or developing
your website:

� Alternate description for Images & Audio/Video.

� Display settings.

� Ease of navigation.

� Content readability & structure.

� Keyboard support.

� Forms.

� Alternate description for images & Audio/Video content

Alternate Text: Brief description of an image is required to be provided for users
with visual disability. If you are using a browser that supports only text or have
turned off the image display, you can still know what the image is all about by reading
the alternate text in absence of an image. In addition, some browsers display the
alternate text in the form of a tool tip when the user moves the mouse pointer over
the image.

� Display settings

Text size: The provision for changing the size of the text on the web pages should
be incorporated either through the browser or you may provide the text sizing icons
present at the top of each page for changing the text size by clicking on these icons.
This helps the learners with low vision.

Text Size: 

Contrast schemes: The website should provide different contrast schemes to enable
users with visual impairments, such as low vision and color blindness as well as
users with learning impairments to view the web page information with ease.
Different contrast schemes include Black on White.

Contrast Scheme: 
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� Ease of Navigation

Skip to Main Content: Quick access to the core content of the page must be
provided for keyboard and screen reader users without requiring them to go through
repetitive navigation links.

Descriptive Link Text: Brief description of a link needs to be provided using clear
and descriptive phrases instead of just using words such as ‘Read more’ and ‘Click
here’ as link text. Further, if a link opens a website in a new window, the description
must specify the same.

Consistent Navigation Mechanism: Consistent means of navigation and style of
presentation throughout the website should be incorporated.

�  Content Readability & Structure

Icons: Text needs to be supplemented with icons to enable users with learning
disabilities understand the information easily. Icons are required to be provided along
with text labels for key navigation options as well as important features, such as
print, email, text size etc.

Identification of file type and file size: Information about alternate file types, such
as PDF, documents, spreadsheet along with the file size must be provided within
the link text to help users identify the same. In addition, icons for different file types
can also be provided with the links. This helps users in deciding whether they wish
to access the link.

Table Headers: The table headings should be marked and associated with their
corresponding cells in each row. This enables a screen reader to read out the column
and row header of any cell for the user.

Table caption and summary: Table captions are specified that act as labels, which
indicate what data is provided in the table. In addition summary is specified to provide
description for screen reader users to enable them understand the table information
easily.

Headings: The web page content should be organized using appropriate headings
and subheadings that provide a readable structure. H1 indicates the main heading,
whereas H2 indicates a subheading. In addition, wherever required appropriate
headings should be provided to improve readability.

Page titles: An appropriate name for each web page must be specified which helps
users especially screen reader users to understand the page content easily.

Large Print: Option of large print should be provided in order to help users with
low vision and senior citizens to print the web page with large font size.

�  Keyboard Support

Keyboard support for drop-down menus: Drop-down menus are used to display
the top navigation options across the website.   For this you need to provide keyboard
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access.  Tab key and Enter key along with up and down arrow keys are used to
navigate the drop-down menu.

Keyboard support for navigating across the website: Interactive elements of
the website, such as links and forms can be browsed using a keyboard by pressing
the Tab or Shift + Tab keys.

�  Forms

Form instructions: Clear and easy to understand instructions should be provided
to help users to fill up the form details successfully.

Clear and unique form labels: Each form field, such as text boxes, radio button
group, check boxes etc should have form labels to help users to identify the purpose
of the field.

Explicit form label association: A label should be linked to its respective control,
such as text box, check box, radio button, and drop-down list. This enables the
assistive technologies to identify the labels for the controls on a form.

Descriptive error messages: In case of errors that occur while filling up a form,
users are informed about errors using descriptive messages to help them to rectify
the error and complete the form.

 INTEXT QUESTIONS 7.3

1. Persons with disability use various technologies for browsing the web
which are called _____________.

2. Four principles of web accessibility is also known by the acronym POUR.
POUR stands for ______________, __________, ____________,
____________.

3. The web page should be provided with large print option in order to help
users with _______________ and senior citizens to print the web page
with large font size.

 WHAT YOU HAVE LEARNT

In this lesson you have learnt about what is disability, types of disabilities i.e.,  mental
disabilities, physical disabilities, types of barriers, web accessibility, principles and
guidelines of web accessibility.  Also you have learnt about assistive technologies
and how to make your website accessible to all.
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 TERMINAL EXERCISE

1. What are the different dimensions of the disabilities that need to be addressed
for web accessibility?

2. What are the four principles of accessibility? Explain each of them.

3. Why is it necessary to make your website accessible?

4. What do you mean by a barrier?

6. What is Information and Communication Technology barrier?

 ANSWER TO INTEXT QUESTIONS

  7.1

1. (i) True

(ii) True

2. (i) Mental or Physical

(ii) Learning

(iii) Spastic

  7.2

1. (a)  ICT (b)  accessibility

(c)  brain (d)  body

2. (a) False (b) True (c) False

  7.3

1. Assistive technology

2. Perceivable, Operable, Understandable, Robust

3. low vision
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8

WORKPLACE PRACTICES

A workplace refers to any physical space where people work.  As a learner, it is
very important for you to understand the importance of a workplace. At a workplace,
a person generally spends most of the time, as it is the place where a person grows
professionally.

Workplace practices differ from industry to industry, but there are a few common
practices which should be adopted by everyone to give their best and make their
company rely on their capabilities. In this lesson we shall learn about good
workplace practices, plan the available resources at a workplace, and decide how
to share resources at a workplace and ethical work practices.

OBJECTIVES

After reading this lesson, you will be able to:

• follow good workplace practices;

• plan the available resources at a workplace;

• decide how to share resources at a workplace;

• adopt ethical work practices.

8.1 WORKPLACE PRACTICES

A good workplace is a place where everyone works to achieve organizational goals
and objectives, all the employees give the best of their capabilities, everyone learns
to work in a team and as a family in an environment of trust, each person works
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and contributes in a healthy and hassle-free environment, thereby building cordial
relationships.

There is always need to set and follow ethical rules that are conducive to a strong,
healthy work environment.  In every organisation there are some general rules which
must be followed by the employees to coordinate with their colleagues, subordinates
and superiors are as follows:

To make the workplace a better place to work, employees should

• give respect to each other.

• be punctual and honest to the organisation.

• be polite with his or her colleagues.

• use humble words while communicating.

Also the actions or words of an employee that could be considered as hostile,
improper, or offensive must be avoided.

8.2 RESOURCE PLANNING AND SHARING

The resource planning and sharing plays a vital role in any organisation. Every
organisation has limited resources as per the specified requirements. It is the
responsibility of the team members to share and use the resources effectively, for
which they need to do proper planning to get the desired results. However, it is as
much important to implement those plans effectively, as it is to draw them. Simply
drawing the plans over paper does not good for any organisation.

An efficient worker always:

• appropriately utilises resources for maximum efficiency and with due regard to
the environment.

• plans his/her daily work responsibly. Planning is essential regardless of the job
role or responsibilities.

• implements the plans formulated by him/her wisely.

• takes time and resource constraints into account while fulfilling work
requirements.

• shares information relevant to the work with co-workers.

Planning helps you to work effectively. The planned strategies allow the individual
to develop effective work habits.

These strategies are likely to include:

• Setting priorities and managing the time to meet deadlines.



166 :: Workplace Practices

Notes

WEB DEVELOPMENT

• Setting and achieving goals.

• Effectively organising the daily actions.

• Consistently adopting better methodologies to improve productivity and
outcomes.

• Working towards the common organisational goals collectively as a team, and
not running behind achieving individual targets.

8.3 TIME SCALE

Time is the most important factor considered while completing any task. If we
complete the task without taking time into consideration, then the task will lose its
value. Running short of time in finishing a job can be a disaster for many reasons,
such as, causing you to land up in a trouble with your boss, disappointing a customer,
and even be demoted or fired.  So, a worker or a team should be careful enough
and take special care of the time while completing any assigned task.

At the workplace, whenever there is a need to start a new project, one should always
prepare a schedule which should include activity, sequence, duration of each activity
and the resource requirements/allocation for each activity, as the most important
factors.

There are many software packages which help you to save time and assist you in
developing a reliable and accurate project schedule. In a technology-driven world
that we are living in, things as common as smartphones can also help in preparing
the project schedules.

As part of the schedule, charts can be made in order to visually monitor the activities
and the milestones, and to compare data and information across all charts, thus
enabling us to visually understand the individual increase or decrease happening in
various aspects currently taking place in the organisation.

INTEXT QUESTIONS 8.1

1. Choose the appropriate answer.

a. An efficient worker always:

i. Appropriately utilises resources for maximum efficiency and with due
regard to the environment.

ii. Implements the plans formulated by him/her wisely.

iii. Takes time and resource constraints into account while fulfilling work
requirements.
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iv. All of the above.

b. Running short of time in finishing a job can be a disaster for many reasons,
such as _________.

i. You will get appraisals from your boss.

ii. Will get appreciation from a customer.

iii. You will be promoted at your work.

iv. None of the above.

2. State True or False for the following:

a. Planning helps to work effectively with the managers only at workplace.

b. Time is the most important factor in completing any task.

8.4 COMMUNICATION SKILLS

Communication is a way to express and share your views and opinions with other
individuals in the team or a team, on the whole. It is important to have healthy
communication amongst the employees at a workplace, otherwise the work will be
affected and the environment will not be a congenial one to work in.

There are different types of communication:

1. Verbal Communication, in which the information flows through verbal
mediums like words, speeches, presentations, etc. Through this type of
communication, the sender shares his/her thoughts in the form of words,
dialogues, speech, presentations, discussions, etc. The speaker must have a clear
idea about the content that he/she wants to convey.

2. Non-verbal Communication, in which sender gives the message through facial
expressions, gestures, hand movements, body postures. Any communication
made between two people without words and simply through facial movements,
gestures or hand movements is called non-verbal communication. In other
words, it is a speechless form of communication where content is not put into
words, but simply expressed through expressions.

3. Written Communication, in which sender sends the messages in the written
form. It can be in the form of emails, written notes, presentations etc. Message
must be complete and meaningful. If the written message will be incomplete
or meaningless, then the work will suffer and there will be a gap in the
relationship of employees, which in turn will affect the work and the
management, both.
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Communication incorporates both ‘top-down’ communication and ‘bottom-up’
communication.

• Top-down communication refers to when managers pass information about
the business to employees. For example, include financial data for making the
decisions. At a workplace, on different levels of the management, transparency
helps to build trust amongst the employees which is a foundation for successful
and sustainable workplace.

• Bottom-up communication ensures the involvement of the employees in
completing the work in the workplace. It gives the opportunity to all the
employees to offer suggestions to management about the improvements made
in production and work processes, more commonly known as ‘Feedback’. This
type of communication generates real improvements in productivity and
performance, as well as making employees feel like management is listening
to them and that they are contributing to the success of the business.

8.5 WORK ETHICS

Ethics are set of moral values or principles to be held by an individual or group.
Sometimes they need to be modified in order to work comfortably and for the benefit
of our clients in the workplace.  But an individual should be aware of personal values
and how it might impact his/her work, as it is so closely related to ethics.

• Integrity Practices

Integrity here refers to the courage to do what is right despite the popular
opinion.  All the employees must practice integrity in the workplace so that
they would support what is morally right and what must be represented to the
staff and to the customer. Integrity requires consistent practice at workplace.

• Confidentiality

Confidentiality and privacy laws and practices play a vital role in every
organisation. A healthy work culture refers to respecting each employee’s
privacy.  Employees must practice confidentiality by refraining themselves from
gossiping about colleagues’ private issues. Trust is the only bond which helps
the employees of an organisation to work as a team. Confidentiality
encompasses set of rules or promises that limits access or places restrictions
on certain types of information.

• Originality

The content of the work must be original. Originality is an important legal
concept with respect to copyright. Originality is the key point of a created or
invented work that makes it new, and thereby distinguishes it from
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reproductions, clones, forgeries, or derivative works.  An original work always
stands out because it is not copied from the work of others.  Therefore, originality
requires not only that the author does not copy the work from another source,
but also that there is “at least some minimal degree of creativity”.

• Plagiarism

The term “Plagiarism” refers to the content which is copied from somewhere
and presented in your name, which is against the laws and effects of the dignity
of the individual.  The following points are considered as plagiarism:

• Presenting someone else’s work as your own.

• Copying words or ideas from someone else without giving credit to the
person.

• Giving a quote in quotation marks and mentioning your name as author
name.

• Giving incorrect information about the source of information.

Plagiarism must always be avoided in the work. You must know that it is against
the laws and it is a punishable act which can land you in serious trouble.

8.6 COPYRIGHT

Copyright is a form of intellectual property, applicable to certain forms of creative
work. Copyright is also one of the types of plagiarism when the content or brand
name or organisation name, etc. is used by a person, illegally.  Copyright is a legal
right which grants the creator of an original work exclusive right for its use and
distribution. It is only for a limited time. Copyright gives ownership over things
originally created by an individual or a company. Copyright law assures the
ownership with several rights that you, as the owner, have exclusively.

The rights include:

• to reproduce your own work.

• to distribute copies of your work which can be paid or free.

• to perform the work anytime, anywhere.

• to present the work publicly.

A major limitation on copyright is that copyright protects only the original expression
of ideas, and not the underlying ideas, themselves.
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INTEXT QUESTIONS 8.2

1. Fill in the blanks.

a. ___________ is a way to express and share your views and opinions
with other individuals in the team or a team, on the whole.

b. The different types of  communication are __________, ____________
and __________.

2. State True or False for the following:

a. Work Ethics refer to the courage to do what is right despite the popular
opinion.
b. Copyright is a form of intellectual property, applicable to certain forms of
creative work.

c. Plagiarism refers to the presenting someone else’s work as your own.

WHAT YOU HAVE LEARNT

In this lesson, you have learnt about the factors which can make a workplace better
to work. There are different factors which help the employees to work comfortably
at a workplace such as resource sharing and planning, time scale, communication
and work ethics. All these factors play an important role in the growth of the
organisation.

TERMINAL EXERCISE

1. Explain resource sharing and planning.

2. Describe all types of communication.

3. What is the importance of time scale at a workplace?

4. Differentiate between plagiarism and copyrights.

ANSWERS TO INTEXT QUESTIONS

  8.1

1. a. (iv)

b. (iv)
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2. a. False

b. True

  8.2

1. a. Communication

b. Verbal, Non Verbal and Written

2. a. False

b. True

c. True
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9

ADVANCED HTML

In the lesson 2 you have learnt the core concepts of CSS.  An effective way to
organize web documents, visually, and also logically can be achieved by dividing the
page into different parts. In each part of the document, presentation of information
in a well design layout with proper placing of text, images, audio and video is also
very important.  The creation of document with different layouts, dividing the page
into different parts and getting user information can be possible by using some
advance HTML elements such as table, frames and forms in your web page.

In this lesson, we shall learn some more advanced features of HTML such as nesting
frames and tables; adding effects to anchor tag; positioning of HTML elements;
layers and layout settings in web page.

OBJECTIVES

After reading this lesson, you will be able to:

• create table and use of its various attributes;

• create nested table;

• use the guidelines for making tables accessible;

• use forms to accept data;

9.1 TABLES

Tables are used to display data in tabular format, containing rows and columns, on
the screen.  The HTML tag <TABLE> is used to define table. The table tag can
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contain the following elements:

• <CAPTION>: It is used to specify the caption (Label) for the table. The
CAPTION element, by default is center-aligned at the top of the table. It’s
ALIGN attribute can take value left, right, center to align the
caption.

• <TR>: Table Row is to specify the row in the table,

• <TH>: Table Header is used for giving heading to a table.

By default, header elements contents are in bold font and center-aligned.

• <TD>: Table Data, within the row you create columns by <TD> tag.  The table
data can consist of lists, images, forms and other element. The TD is a true
container that can hold other HTML elements and more tables.

Example: A simple table in HTML

<HTML>
<HEAD>

<TITLE> A SIMPLE TABLE IN HTML </TITLE>
</HEAD>
<BODY>
<TABLE>

<CAPTION> TEST TABLE </CAPTION>
<TR>

<TH> HEADING 1 </TH>
<TH> HEADING 2 </TH>
<TH> HEADING 3 </TH>

</TR>
<TR>

<TD> CELL 1 </TD>
<TD> CELL 2 </TD>
<TD> CELL 3 </TD>

</TR>
<TR>

<TD> CELL 4 </TD>
<TD> CELL 5 </TD>
<TD> CELL 6 </TD>

</TR>
</TABLE>
</BODY>

<1HTML>
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The output of simple table HTML code is shown in fig 9.1

Fig 9.1  A simple Table without border view in browser

Attributes of <TABLE>

CELLSPACING: used to set the space between the cells in a table. It takes
value in pixel.

CELLPADDING: used to set the space between the cell data and cell wall in a
table. It takes value in pixel.

WIDTH: used to set the width of the table, as either an absolute with in pixels,
or a percentage of the documents width. For example: <WIDTH= width in pixel
or percent>

COLSPAN:  Specifies the number of columns the cell can span. The default
COLSPAN for any cell is 1.

ROWSPAN: Specifies the number of rows the cell can span. The default ROWSPAN
for any cell is 1.

<HTML>

<HEAD><TITLE> Use of Table Attributes </TITLE></HEAD>

<BODY>

<TABLE >

<TR>

<TD>CELL 1 </TD>

<TD COLSPAN=2> Cell Spans 2 Columns</TD>

</TR>

<TR>
<TD> CELL 2 </TD>

<TD> CELL 3 </TD>
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<TD> CELL 4 </TD>

</TR>

</TABLE>

</BODY>

</HTML>

The output of COLSPAN code is shown in fig 9.2

Fig 9.2 A sample view - COLSPAN

Nested Tables

Nested tables means making a table inside another table. Since only the TH and
TD tags can hold data, you will have to code a full table inside the TH or TD tag of
another table.

Hint: Code the first table completely then between the <TD> and the </TD> tags
(or between the pair of TH tags) code another table. The second table must begin
and end in the same cell.

Following is the example of using another table and other tags inside a table cell.

<TABLE border = 2>

<TR>

<TD>

<TABLE border = 2>

<TR>

<TH>Name</TH>

<TH>Salary</TH>
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</TR>

<TR>

<TD>Ram Kumar</TD>

<TD>5000</TD>

</TR>
<TR>

<TD>Sheela Agarwal</TD>

<TD>7000</TD>

</TR>

</TABLE>

</TD>

<TD>

<UL>

<LI>This is another cell</LI>

<LI>Using list inside this cell</LI>

</UL>

</TD>

</TR>

<TR>

<TD>Row 2, Column 1</TD>

<TD>Row 2, Column 2</TD>

</TR>

</TABLE>

This will produce following result:

Fig. 9.3 Nested table
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Effect of Nested Tables on Webpages

A single table on a web page will generally not affect speed of downloading process.
But, the moment you put one table within another table, it gets more complicated
for the browser to render, and so the page loads slowly. And the more tables nested
inside one another, the slower the page will load.

Normally, when a page loads, the browser starts at the top of the HTML and loads
it sequentially down the page. However, with nested tables, it has to find the end of
the table before it can display the entire thing.  To avoid the above problem, you can
convert nested tables into slightly more complex single tables by using the rowspan
and colspan attributes on your table cells.

Guidelines for making Tables Accessible

Screen readers read the content of web pages as if there were no HTML tags at all.
They read everything in the order that it appears in the source markup. Center for
Persons with Disabilities at Utah State University in USA suggest the following
guidelines for making HTML table accessible to people with disabilities.

1. Avoid tables with more than two levels of row and/or column headers.

2. Use proportional sizing, rather than absolute sizing. The rule that applies to layout
tables also applies to data tables. Let the browser window determine the width
of the table whenever possible, to reduce the horizontal scrolling required for
those with low vision.

3. Provide names or titles for data tables using the <caption> tag. Tables ought to
have some sort of title or caption to them. It is not absolutely necessary to have
caption tags on every data table for the sake of accessibility, but it is still a good
practice.

4. Header Tags: When you use the table header (<th>) tag, most browsers provide
the text to become bold and centered, which can be a nice visual effect, but the
<th> tag should only be used in data tables. Do not use it in layout tables because
you may confuse screen reader user.

5. Use the simplest possible table configuration. Visually challenged users will see
all the contents from tables. Their screen readers will inform the number of rows
and columns in the table. When they try to navigate from one area to the other
within the table, they may become disoriented. The rule of thumb here is, the
simpler the better.

6. Designate row and column headers using the <th> tag. The very first step
towards creating an accessible data table is to designate row and/or column
headers. This is easy enough to do. In the markup, the <td> tag is used for table
data cells and the <th>tag is used for table header cells.
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  INTEXT QUESTIONS 9.1

1. State True or False for the following:

(a) WIDTH specifies the height of a cell.

(b) CELLPADDING used to set the space between the cell data and cell wall
in a table.

(c) Table in HTML is defined row by row. The <TR> tags define a new row.

2. Fill in the blanks.

(a). ___________  tag is used for giving a heading to a table in HTML.

(b)  For providing titles for tables ____________ tag will be used in HTML.

9.2 FORMS

Forms are used in HTML for getting inputs from the users. It can be a registration
form, feedback form, order form and so on.  To take appropriate data inputs, form
has components like text fields, radio buttons, check boxes, list boxes and so on.
When data entry is complete, the user submits the form by clicking the submit button
on the page. After submission, the data will be sent to server for processing and the
processing is done through CGI Scripts, PHP, ASP, or servlet etc. This CGI scripts
resides at the server side.

After the user fills the form and clicks the submit button, the data pass either through
method POST (used to pass large amount of data) or GET (used to pass small amount
of data, passed along with the URL) to the server side. Then the server handles data
and performs appropriate action.

Form elements are like text fields, textarea fields, drop-down menus, radio buttons,
checkboxes, etc., which are used to take information from the user.

A simple syntax of using <form> is as follows:

<FORM action="back-end script" method="posting method">
    form elements like input, textarea etc.
</FORM>

Most frequently used <FORM> attributes are:

• name: This is the name of the form.

• action: Here you will specify any script URL which will receive uploaded data.

• method: Here you will specify method to be used to upload data. It can take
various values but most frequently used are GET and POST.
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• target: It specifies the target page where the result of the script will be displayed.
It takes values like _blank, _self, _parent etc.

• enctype: You can use the enctype attribute to specify how the browser encodes
the data before it sends to the server. Possible values are like:

application/x-www-form-urlencoded - This is the standard method most
forms use. It converts spaces to the plus sign and non-alphanumeric
characters into the hexadecimal code for that character in ASCII text.

mutlipart/form-data - This allows the data to be sent in parts, with each
consecutive part corresponding the form control, in the order they appear
in the form. Each part can have an optional content-type header of its own
indicating the type of data for that form control.

There are different types of form controls that you can use to collect data from a
visitor to your site.

• Text input controls

• Buttons

• Checkboxes and radio buttons

• Select boxes

• File select boxes

• Hidden controls

• Submit and reset button

Forms - Text Input Controls:

There are actually three types of text input used on forms:

• Single-line text input controls: Used for items that require only one line of
user input, such as search boxes or names.

• Password input controls: Single-line text input that mask the characters a user
enters.

• Multi-line text input controls: Used when the user is required to give details
that may be longer than a single sentence. Multi-line input controls are created
with the <textarea> element.

Single-line Text Input Controls

Single-line text input controls are created using an <input> element whose type
attribute has a value of text.  Here is a basic example of a single-line text input used
to take first name and last name:

<FORM action="/cgi-bin/hello_get.cgi" method="get">
       First name:
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       <INPUT type="text" name="first_name" />
       <BR>
       Last name:
       <INPUT type="text" name="last_name" />
       <INPUT type="submit" value="submit" />
</FORM>

This will produce the following result:

Fig. 9.4 : Single line text input

Following is the list of attributes for <input> tag.

• type: Indicates the type of input control you want to create. This element is also
used to create other form controls such as radio buttons and checkboxes.

• name: Used to give the name part of the name/value pair that is sent to the server,
representing each form control and the value the user entered.

• value: Provides an initial value for the text input control that the user will see
when the form loads.

• size: Allows you to specify the width of the text-input control in terms of
characters.

• maxlength: Allows you to specify the maximum number of characters a user
can enter into the text box.

Password Input Controls

This is also a form of single-line text input controls created using an <input> element
whose type attribute has a value of password.

Here is an example of a single-line password input used to take user password:

<FORM action="/cgi-bin/hello_get.cgi" method="get">
        Login :
        <INPUT type="text" name="login" />
        <BR>
        Password:
        <INPUT type="password" name="password" />
        <INPUT type="submit" value="submit" />
</FORM>
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This will produce the following form:

Login :

Password : Submit

Fig. 9.5 : Single line password input

Multiple-Line Text Input Controls

If you want to allow a visitor to your site to enter more than one line of text, you
should create a multiple-line text input control using the <textarea> element.

Here is a basic example of a multi-line text input used to take item description:

<FORM action="/cgi-bin/hello_get.cgi" method="get”>
    Description : <br />
    <TEXTAREA rows="5" cols="50" name="description”>
    Enter description here...
    </TEXTAREA>
    <INPUT type="submit" value="submit" />
</FORM>

This will produce the following form:

Fig. 9.6 : Multiline text input

Following are the details of  attributes for <textarea> tag.

• name: The name of the control. This is used in the name/value pair that is sent
to the server.

• rows: Indicates the number of rows of text area box.

• cols: Indicates the number of columns of text area box.

Checkboxes Control

Checkboxes are used when more than one option is required to be selected. They
are created using <INPUT> tag.
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Following is the list of important checkbox attributes:

• type: Indicates that you want to create a checkbox.

• name: Name of the control.

• value: The value that will be used, if the checkbox is selected. More than one
checkbox should share the same name only, if you want to allow users to select
several items from the same list.

• checked: Indicates that when the page loads, the checkbox should be selected.

Radio Buttons Control

Radio buttons are used when only one option is required to be selected. They are
created using <input> tag as shown below:

Here is an example HTML code for a form with two radio button:

<FORM action="/cgi-bin/radiobutton.cgi" method="post">
        <INPUT type="radio" name="subject" value="maths" /> Maths
        <INPUT type="radio" name="subject" value="physics" /> Physics
        <INPUT type="submit" value="Select Subject” />
</FORM>

The result of this code is the following form :

Fig. 9.7 : Radio button

Following is the list of important radiobox attributes:

• type: Indicates that you want to create a radiobox.

• name: Name of the control.

• value: Used to indicate the value that will be sent to the server if this option is
selected.

• checked: Indicates that this option should be selected by default when the page
loads.

9.2.1 Accessible Forms

Forms are not the easiest of things to use for people with disabilities.

Labels

Each form field should have its own label. The label tag sorts this out, with a for
attribute that associates it to a form element, example:

<FORM>
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<LABEL for="yourName">Your Name</label> <input type="text"
name="yourName" id="yourName" />
...

Labels have the added bonus of visual browsers rendering the labels themselves
clickable, thus putting the focus on the associated form field.

Note: name and id are both required - the name for the form to handle that field and
the id for the label to associate it to.

Fieldset and legends

In order to have combined input, you can create group fields, for example name
(first, last, middle, title etc.) or address (line 1, line 2, district, state, country, postal
code etc.) using the fieldset tag.

Within the field set, you can set a legend with the legend tag.

Visual browsers tend to represent fieldsets with a border surrounding them and
legends breaking the left of the top border.

<FORM action="somescript.php" >

     <FIELDSET>

          <LEGEND>Name</LEGEND>

<P>First name <input type="text" name="firstName" /></P>

<P>Last name <input type="text" name="lastName" /></P>

    </FIELDSET>

      <FIELDSET>

<LEGEND>Address</legend>

<P>Address <TEXTAREA name="address" ></TEXTAREA></P>

<P>Postal code <input type="text" name="postcode" /></P>

      </FIELDSET>
...

Select box Control

Drop down box is used when you have many options available but only one or two
option can be selected from the list of options.

Here is an example HTML code for a form with one drop down box:

<FORM action="/cgi-bin/dropdown.cgi" method="post">

    <SELECT name="dropdown”>

      <OPTION value="Maths">Maths</OPTION>
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      <OPTION value="Physics" selected>Physics</OPTION>

      <OPTION value="Science">Science</OPTION>

      <OPTION value="Hindi">Hindi</OPTION>

    </SELECT>

    <INPUT type="submit" value="Submit" />

</FORM>

This will produce the following form:

Fig.  9.8 : Drop down box

Following is the list of important attributes of <select>:

• name: This is the name for the control.

• size: This can be used to present a scrolling list box.

• multiple: If set to “multiple” then allows a user to select multiple items from

the menu.

Following is the list of important attributes of <option>:

• value: The value that is sent to the server if this option is selected.

• selected: Specifies that this option should be selected initially when the page

loads.

• label: An alternative way of labeling options.

Option groups

The <optgroup> tag is used to group related option groups in a drop-down list.

If you have a long list of options, then you can group related options.  Group of related

options are easier to handle for a user. It requires a label attribute, the value of which

is displayed as a non-selectable pseudo-heading preceding that group in the drop-

down list of visual browsers.
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Example source code and their output result are given below:

<SELECT name="country">

<OPTGROUP label="Asia">
<OPTION value="India">India</OPTION>

<OPTION value="China">China</OPTION>

<OPTION value="Pakistan">Pakistan</OPTION>

</OPTGROUP>
<OPTGROUP label="Europe">

<OPTION value="fra">France</OPTION>

<OPTION value="rus">Russia</OPTION>

<OPTION value="uk">UK</OPTION>

</OPTGROUP>

<OPTGROUP label="North America">

<OPTION value="can">Canada</OPTION>

<OPTION value="mex">Mexico</OPTION>

<OPTION value="usa">USA</OPTION>

</OPTGROUP>

</SELECT>

This will produce the following form:

Fig. 9.9 : Option groups : Label attributes

File Select Boxes

If you want to allow a user to upload a file to your website from his /her computer,
you will need to use a file upload box, also known as a file select box. This is also
created using the <input> element.
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Here is an example HTML code for a form with one file select box:

<FORM action="/cgi-bin/hello_get.cgi" method="post" name="fileupload"
enctype="multipart/form-data">

<INPUT type="file" name="fileupload" accept="image/*" />
</FORM>

This will produce the following form:

Fig. 9.10 : File Select Box

Submit and Reset Button
These are special buttons which can be created using <input>. When submit button
is clicked, then forms data is submitted to the back-end application. When reset button
is clicked, then all the form controls are reset to default state.

You already have seen submit button above, we will give one reset example here:

<FORM action="/cgi-bin/hello_get.cgi" method="get">

         First name:
         <INPUT type="text" name="first_name" />
         <BR>

        Last name:
        <INPUT type="text" name="last_name" />
        <INPUT type="submit" value="Submit" />

        <INPUT type="reset" value="Reset" />
</FORM>

Type something and click reset button. This will produce following result.

First name :

Last name:       Submit      Reset

Fig. 9.11 : Submit and Reset button

9.3 ACCESSIBLE LINKS

Links are the most important interactive element of websites and it is also accessible
to those people with disabilities.

Tabindex

Users who do not or cannot use pointing devices, can tab through links and, as such,
links should be in a logical tabbing order. The Tabindex attribute allows you to define
this order although if the HTML is linear, as it should be, a logical tabbing order
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should automatically fall into place.

<UL>

    <LI><A href="here.html" tabindex="1">Here</A></LI>

    <LI><A href="there.html" tabindex="3">There</A></LI>

    <LI><A href="limbo.html" tabindex="2">Limbo</A></LI>

</UL>

The above example shows that tabbing would jump from “Here” to “Limbo” to
“There”.

Access keys

Access keys allow easier navigation by assigning a keyboard shortcut to a link (which
will usually gain focus when the user presses “Alt” or “Ctrl” + the access key).

<A href="somepage.html" accesskey="s">Some page</A>

For users who do not use pointing devices, this can be a quick way to navigate. The
trouble is that the user may not be knowing what are different access keys unless
these are explicitly stated, although some assistive software will tell the user about
it.

 INTEXT QUESTIONS 9.2

1. State True or False for the following:

(a) RADIO button is used for attributes.

(b) Drop down menu is not supported in HTML.

(c) Text Input Controls may be used for multi-line input.

(d) End user can see the hidden form controls.

2. Fill in the blanks.

(a) ____________ attribute allows you to specify the maximum number of

characters a user can enter in the text box.

(b) If you want to enter more than one line of text __________ tag be to used

in HTML.
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WHAT YOU HAVE LEARNT

In this lesson, you have learnt about advanced features of HTML – mainly how to

create tables and use its various attributes, accessible forms.  You have also learnt

that tables and their guidelines to design the page for people with disabilities. Also
you have learnt to create nested table.

 TERMINAL EXERCISE

1. Write a HTML code to create the following Table:

Name Mathematics Science English Hindi

Ram 55 65 69 60

Shyam 50 49 82 67

Alok 92 72 62 60

2. What is a nested table in HTML? Can nested table be embedded inside a cell in
another table?

3. What kind of accessible guidelines need to be followed for people with
disabilities?

 ANSWERS TO INTEXT QUESTIONS

  9.1

1. (a) False (b) True (c) True

2. (a) TH (b) Caption.

  9.2

1. (a) True (b) False

(c) True (d) False

2. (a) maxlength

(b) TEXTAREA
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10

SCRIPTING

In the previous lesson,  you have learnt how to create HTML pages for displaying
information on Internet using a web browser. Many times you require to store and
display dynamic information on website i.e., the information which keeps on changing
and is stored in some database. So, let us know how to access that information online
by multiple users simultaneously. Scripting languages allows users to create an active
and dynamic web page that can display dynamic information. Scripting allows to
create a page interactive for instances i.e., display real time information. The web
page can prompt questions to users, which  accepts the answer, and validates the
answer.

The script execution can happen at various places i.e., different computers (machines,
servers).  The script that is run in the web browser can be called as client side script
and the script that is run on the webserver or other servers is called as server side
script. In this lesson, we shall learn about JavaScript and handle JavaScript events.

OBJECTIVES

After reading this lesson, you will be able to :

• write a JavaScript program;

• use conditional and loop statements;

• write methods (functions);

• handle JavaScript events.
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10.1 WHAT IS SCRIPTING?

Script is normally a short program rather a sequence of instructions which are
interpreted. The scripting language runs in a environment which contains a script
language interpreter. An Interpreter is a program which interprets and executes the
script line by line. The script can be categorized broadly in two types:

• Client side Scripting

These are the programs which are executed at users’ computer by user’s browser.
The commonly used client scripting languages are ECMA Script, JavaScript ,
VBScript and PHP (Hypertext Preprocessed).

• Server side Scripting

These are the programs which run at server computer. It usually accesses interactive
website and interface with databases. Few popular server scripting programs are
ASP, JSP, PHP, Python.

Now let us learn about JavaScript.

10.1.1 Characteristics of JavaScript
JavaScript is scripting language developed by Netscape Communication
corporation. It is a platform independent and can run on Windows, Linux etc. All
commonly used browsers support JavaScript. The following are the characteristics
of JavaScript.

1. Scripting language - It is a simple programming language with limited features
of full-fledge programming language and is easy to learn and understand.

2. Object based - It depends on collection of built-in objects for functionality.

3. Platform independent - JavaScript can be embedded into HTML document are
not tied to any specific hardware platform/ operating system and is interpreted
by almost browsers.

4. Event driven - It responds to users actions by the use of input devices.

10.1.2 Embedding JavaScript in HTML

There are two ways to include JavaScript in HTML.  One way, you can store your
script in a separate text file and include this file in HTML document other way,
you can directly write your script inside HTML document.
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The basic structure of an HTML file with JavaScript is shown below:

<HTML>

<HEAD>

<TITLE> First example in JavaScript </TITLE>

<SCRIPT LANGUAGE = "JavaScript">

Write the JavaScript code here

</SCRIPT>

</HEAD>

<BODY>

Write your Document text here

<SCRIPT LANGUAGE = "JavaScript">

You can write the JavaScript code here

</SCRIPT>

You can also write document text i.e. HTML text here

</BODY>

</HTML>

Example 1 : Use of HTML file with JavaScript:

<HTML>

<HEAD>

<TITLE>

First example of JavaScript

</TITLE>

</HEAD>

<BODY>

<H4>This example shows the use of JavaScript in html</H4>

<BR>

<SCRIPT LANGUAGE="JavaScript">

document.write ("Learn JavaScript with ease")

</SCRIPT>

</BODY>

</HTML>

‘Document’ – predefined JavaScript object refer to the HTML document

‘write (  )’–It is a predefined method of document object that is used to write text
to the HTML document.
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10.1.3 Variables in JavaScript

� Variable Name

Variable is a name given to storage area which is capable of storing text, numbers
including decimals in JavaScript. You can store a value into a variable.  For
example, color = “red” is a text value, stored into a variable say color.

A variable name can start with uppercase letters [A-Z], lowercase [a-z] or
underscore (_) character. Remaining characters may be letters, underscore,
digists (0-9).  Also, note that JavaScript is case sensitive i.e., variable name
abc and ABC represent two different variables.

� Variable Data type

In JavaScript,  variable can store number, string, boolean values data types.
For example (99, "table",  true).  Variable declaration is not compulsory in Java
Script.

Variable Data Types

Various data types are :

• String i.e., hello learners

• Number i.e. 1,2,3,..

• Boolean i.e. true/ false

� Variable Declaration

Variables are declared using the keyword var. For example, var item; var price;
you can also assign a value  to the variable at the time of declaration. For
example, you can assign “table” to variable item and 2000 to variable price.

Fig. 10.1 : Use of JavaScript in html
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Declaring Variables

Keyword var is used to declare a variable in JavaScript followed by a variable name.
For example,

var partname;

var part_price;

you can also assign value to the variable at the time of declaration. For example,

var item_price=5000;

� Arrays

These are used to store a sequence of values of same data type. These values
are stored in the indexed location within the array.

For example, you want to store 3 items in an array i.e.,

item[0]="chair"

item[1]="sofa"

item[2]="almirah"

You can also store all the 3 values in an array in a single line as

item=new array("chair", "sofa", "almirah")

You can access these stored values as :

document.write(item[0])

document.write(item[1])

document.write(item[2])

10.1.4 Operators

An operator is used to transform one or more values into a single resultant value.
These are used in expressions to calculate/store or return a value.

Operators are classified as :

• Arithmetic Operator

• Assignment Operator

• Logical Operator

• Comparison Operator

• String Operator
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The following table shows the list of operators used in JavaScript:

Table 10.1  List of operators used in JavaScript

Category Operator                         Name

Arithmetic + Addition

- Subtraction

* multiplication

/ Division

% Modulus

++ Increment and then return value

– – Decrement and then return value

Assignment = Assigns the value.

Logical || Logical OR evaluates to true when either
operand is true.

&& Logical AND evaluates to true when both
operand is true.

< > Logical NOT evaluates to true if the operand
is false.

Comparison  = Equal to

!= NOT equal

< Less than

<= Less than or equal

> Greater than

>= Greater than or equal

String + Concatenate strings

Example 2: A JavaScript program to store the values of part name and part prices
of 4 hardware items and display them.

<HTML>

<HEAD>

<TITLE> JavaScript program using Arrays</TITLE>

</HEAD>

<BODY>

<SCRIPT language = "JavaScript">

         partname= new Array("RAM", "HDD", "KBD", "MBD");

         partprice= new Array(1000, 1100, 500, 8000);

document.write("Hardware 1 - "+ partname[0] + " , Price - Rs." +
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partprice[0]);
document.write("<BR>");
document.write("Hardware 2 - "+ partname[1] + ", Price - Rs." +
partprice[1]);
document.write("<BR>");
document.write("Hardware 3 - "+ partname[2] + " , Price - Rs." +
partprice[2]);
document.write("<BR>");
document.write(“Hardware 4 - "+ partname[3] + " , Price - Rs." +
partprice[3]);

         document.write("<BR>");
</SCRIPT>
</BODY>
</HTML>

The output of the above code is :

Fig. 10.2 : JavaScript programs using Arrays

10.1.5 Conditional Statements

Conditional statements allow to execute a portion of the program  based on a condition
repeatedly. For example, if, if..else, switch ..case

(a) (ii) if syntax:
if (condition)
{
statement1;
statement2;
}

Example : A JavaScript program to display marks if average is less than 40

<HTML>
      <HEAD>
           <TITLE>Display message depending upon average marks</TITLE>
      </HEAD>
      <BODY>
             <SCRIPT language="JavaScript">
                    english=35;
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maths=40;
science=39;
name="Bhrigu Das";
document.write(“Name : " + name );
averagemarks = (english + maths + science) / 3;
document.write("<BR>"+ "Averagemarks:"+averagemarks);
if (averagemarks < 40)

                            document.write("<BR>"+ "Improvement required");
             </SCRIPT>

     </BODY>

</HTML>

The output of the above code is :

Fig. 10.3 : Example of if statement in JavaScript

(a) (ii) if ..else syntax

if (condition)
{
statement(s)
}
else
{
statement(s)
}

Example 3: A Javascript program to display marks if average is less than 40,  else
display performance is satisfactory.

<HTML>

      <HEAD>

           <TITLE>Display message depending upon average marks</TITLE>

      </HEAD>

      <BODY>
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             <SCRIPT language="JavaScript">

english=55;

maths=40;

science=55;

name="Bhrigu Das";

document.write(“Name : " + name );

averagemarks = (english + maths + science) / 3;

if (averagemarks < 40)

                       {

                           document.write("<BR> Average marks: " + averagemarks);

                           document.write("<BR> Improvement required");

                       }

                    else

                       {

                           document.write("<BR> Average marks:" + averagemarks);

                          document.write("<BR> Performance is Satisfactory");

                       }

             </SCRIPT>

     </BODY>

</HTML>

The output of the above code is :

Fig. 10.4 : Example of if else statement

(b) Switch statement - Instead of using repeated if else you can use switch case
statement.
switch(variable)
{
case value1 :

statements(s)
break
case value1 :

statements(s)
break
default:

statements(s)

}
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Example 4: A JavaScript program to display part name, part price for different options.

<HTML>
         <HEAD>
              <TITLE> To display partname, partprice for different options</TITLE>
         </HEAD>
         <BODY>
              <TABLE BORDER=”1”>
                    <TR><TD>Sr.No</TD><TD><Part Name</TD><TD> Part

Price</TD></TR>
                   <TR><TD>1</TD><TD><RAM</TD><TD>1000</TD>
                    </TR><TR><TD>2</TD><TD><HDD</TD><TD>2100

 </TD></TR>
            </TABLE>
            <BR>
            <SCRIPT language="JavaScript">
                  choice=1;
                  Switch (choice)
                  {
                      Case 1:
                            document.write("Selected option is 1");
                            document.write("<BR>");
                            document.write("Partname : RAM, Partprice = 1000");
                            BREAK;
                      Case 2:
                           document.write("Selected option is 2");
                           document.write("<BR>");
                           document.write("Partname : RAM, Partprice = 2100");
                           breake;
                       default:

    document.write("No option selected");
                 }
                </SCRIPT>
</BODY>

 </HTML>

The output of the above code is :

Fig. 10.5 Use of  switch case
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10.1.6 Iterative Constructs

It allows to execute a portion of the program repeatedly based on a condition. Type
of iterative constructs are while, do..while and for loops.

Syntax:

a) while statement

while (condition(s))

{

statement(s)

}

Example 5: A JavaScript program to display the usage of while loop.

<HTML>
            <HEAD>
                       <TITLE>Example to display count using iterative

     constructs </TITLE>
           </HEAD>
           <BODY>
                      <SCRIPT language="JavaScript">
                               count=1;
                               WHILE (count<=5)
                               {
                                      document.write("value of count is : " + count);
                                      count++;

                                      document.write("<BR>");
                               }
                      </SCRIPT>
           </BODY>
</HTML>

b) do..while statement.
The difference between do ....while and while loop is that do .... while loop
runs once and then checks the condition if it is true then continues the process.
do
{
statements(s)
}

while (condition(s));
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Example 5: A JavaScript program to display the purpose of do ... while loop.

<HTML>

   <HEAD>
   <TITLE>Example to display count using iterative constructs/TITLE>
           </HEAD>
           <BODY>
                      <SCRIPT language="JavaScript">
                               count=1;
                               do
                               {
                                      document.write("value of count is :" + count);
                                      count++;
                                      document.write("<BR>");
                               }      while (count < = 5);
                      </SCRIPT>

           </BODY>
</HTML>

c) for statement

for (initialization; condition; variable increment/decrement)

{

statement(s))

}

Example 6: A JavaScript program for loop.

<HTML>
           <HEAD>
                     <TITLE>Example to display count using iterative constructs

  </TITLE>
           </HEAD>
           <BODY>
                     <SCRIPT language="JavaScript">

 for (count = 1; count < = 5; count ++)
                                         {
                                          document.write("value of count is: = "+count);
                                          document.write("<BR>");
                                          }
                     </SCRIPT>

         </BODY>

</HTML>
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The output will be displayed as below:

 INTEXT QUESTIONS 10.1

1. Fill in the blanks.

i) The difference between do .... while loop and while loop is that do... while
excecutes the lop statements atleast ________________ then cheeks the
canditation of the loop.

ii) ____________ is the increment operator.

10.1.7 Methods (Functions)
A function is a block of code designed to perform a specific task. Code written in
function block are reusable, which can be called any where in the program.

Example 7:

<HTML>
     <HEAD>
          <TITLE>Example of function </TITLE>
          <SCRIPT language="JavaScript">
          function getdata(name,age)
            {
               document.write("Name : "+name);
               document.write("<BR>");
               document.write("Age : "+age);
            }
          </SCRIPT>
     </HEAD>
     <BODY>

        <BR>

        Calling JavaScript function getdata taking 2 parameters name and age

        <BR>

        <SCRIPT language="JavaScript">

          getdata("Amit Sharma",28);

Fig. 10.6: Use of  loop
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        </SCRIPT>

     </BODY>

</HTML>

Output will be displayed as below:

Fig. 10.7 : Calling function with parameters

Functions associated with objects are called methods of objects. JavaScript has an

object and each object has methods. An object contains properties and methods.

For example, a ball is an object. The properties are characteristics of ball i.e. color,

size, weight, type of the ball i.e. tennis, cricket, golf etc. Methods are the actions

that an object can made to perform. For example, a ball can act as a toy for a children

or a ball can be used to play different games like tennis, cricket, golf etc.

Commonly used methods of window object used in JavaScript for communicating

with users are:

i) alert() method - Used to create a dialog box with a message and OK button.

Example: alert("Welcome Learners")

ii) confirm() method - It is similar to alert method, but provides Cancel button in

addition to OK button. val=confirm("Message to display")

var ans=confirm("Continue")

The method returns true if user clicks on OK and false if user clicks on Cancel

button.

iii) prompt() method - It creates a dialog box with a message and requests user

to input with a text field.

Window Object

A window object is a top level object in the JavaScript object model. It is a default

object i.e., the statement document.write(“Hello! Learners”) is expanded as

window.document.write(“Hello! Learners) by the JavaScript interpreter.
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Methods of the window object are:

Table  10.2 Methods of the window object

Method                                Description

alert(text) Pop up a window with text as message.

confirm(text) pop up a message box with OK and CANCEL button.

prompt(text, Dialog box will be displayed along with a text box to

default input) input a user data and default value in  the text box.

open(URL, name, Opens a new window, with a URL, with optional

featureList) target name, features(optional).

close() Closes the current window.

Event and event handlers of the window object:

Table  10.3 Event and event handlers - Window object

Event Event handlers                             Description

Load onLoad Processes when window finishes loading.

unload onUnLoad Processes when window finishes unloading.

Example 8:

<HTML>

        <HEAD>
             <SCRIPT language="JavaScript">
             function gamename()
              {
                  var gamename= prompt("Enter game name to play : ");
                   alert("Play"+gamename);
              }
              </SCRIPT>
        </HEAD>
        <BODY>

     Calling JavaScript function gamename… it prompts the user to input
     game name using  prompt method, accepts a variable and give
     the game name to play

                <BR>
                <SCRIPT language="JavaScript">
                gamename();
                </SCRIPT>
        </BODY>

</HTML>
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10.1.8 Event Handling

Event is an action when a user interacts with a web page or other browser related
activities. For example, when a user clicks a mouse or enters data in a form, an
event is generated. The browser waits for an event to occur, takes action based on
the type of event. The action taken by the browser is called Event Handling. The
function which is executed in response to the event is called Event Handler.

Event Handling in JavaScript takes place in two steps:

1. defining events such that they are handled by the script.

2. connecting these events to JavaScript code.

The table 10.4 shows few events, description and event handled associated with
HTML elements.

Fig. 10.8: Calling alert and prompt method

The output of example 8 is :
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Example 9: A JavaScript program of event handling .

<HTML>
        <HEAD>
             <TITLE> Example of event handling in javascript </TITLE>
               <SCRIPT LANGUAGE="JAVASCRIPT">
               function load()
               {
                 alert("onLoad event just handled");
               }
               function displayAlert()
               {
                 alert("Welcome to NIOS website");
               }
               </SCRIPT>
        </HEAD>
        <BODY>

             <BR>

Table 10.4 HTML elements and associated events

HTML Element HTML Tag Event Description event Event Handler

Document body <BODY> load Generated when page is OnLoad
loaded into the browser

</BODY> unload Generated when page is closed onUnload

Text field <INPUT TYPE Blur Text field loses focus onBlur
= “text”> Focus Text field receives current input focus onFocus

Change Generated when user changes the value onChange
select Text is selected within the text field onSelect

Form <form> submit When user submits a form onSubmit
</form>

submit <INPUT TYPE click When submit button is clicked onClick
= “submit”>

Reset <INPUT TYPE click When reset button is clicked onClick
= “reset”>

radio button <INPUT TYPE click When radio button is clicked onClick
 = “radio”

Dropdown <SELECT> Focus Selection element receives onFocus
selection input focus

Change Selection element value changed on Change
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             <A HREF="http://www.nios.ac.in" onClick = "displayAlert()">
    Visit NIOS website </A>

        </BODY>

</HTML>

Output of the above code:

10.1.9 Form validation in JavaScript

Form validation is the process of checking that a form is filled before it is processed.
The JavaScript function validate_form() performs form validation.

Example: A JavaScript program shows form validation with JavaScript.

<HTML>

         <HEAD>

               <TITLE>JavaScript form validation</TITLE>

Fig. 10.9: Example of on click event handling
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              <SCRIPT language="JavaScript>

              function validate_form()

            {

              valid = true;

              if (document.feedback_form.your_name.value == " ")

              {

                 alert ("please enter your name in the box");

                 valid = false;

              }

             return valid;

            }

           </SCRIPT>

</HEAD>

<BODY>

      <FORMNAME="feedback_form" method="post" action = http://
www.nios.ac.in/feedback.aspx on Submit="return validate_form();">

        <H1>Enter your name</H1>

        <P>Name: <input type= "text" name="your_name"></P >

        <P><input type="submit" name="send" value="Send Details"></P>

   </FORM>

</BODY>

</HTML>

The form is given the name “feedback_form”. The form uses the post method to
send data to the server side script on http://www.nios.ac.in server. The form tag
includes an onSubmit attribute to call JavaScript validation function i.e.
validate_form() when the Send Details button is pressed.

The return allows to return the value true or false from function to browser. True
means send the form to server and false means do not send the form to server (as
form is not filled correct).

The form validation function, validate_form() is embedded in the head tag near the
top of the page. In this function,

Valid = true

A variable valid is used to keep track of whether the form has filled correctly or not.
If  check fails, variable valid comes false and the form is not sent to server.

Check the value of your_name field in the following statements:

<h1>Enter your name</h1>

<p>Your name: <input type= "text" name="your_name"></p>
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If user does not fill his/her name in the prompt window then following condition is
checked.

if (document.feedback_form.your_name.value == "")

The user is warned with an alert box and the value of variable valid is set to false.
When user enters the text in the prompt window, the value of the variable is set to
true. The value if valid variable is returned to onsumit attribute and the form is sent
to server.

INTEXT QUESTIONS 10.2

1. State True or False for the following:

(i) JavaScript is a platform dependent language.

(ii) JavaScript can not be embedded with HTML document.

(iii) The for statement first initializes the variable, checks condition and then
changes the value of variable.

(iv) On click event handler is associated with submit button.

(v) The function which is exemted in response to the event is called event
handler.

(vi) Function can be called inside and outside the program and even by an
event.

2. Match the following:

(a) Script (i) block of code that has a name

(b) Method (ii) Functions associated with objects

(c) Event handling (iii) Sequence of instructions

(d) function (iv) action taken by a browser

3. Fill in the blanks:

(i) _______ is an action which occurs when user interacts with webpage
or other browser related activities.

(ii) Alert() method displays a window with text as ________.

(iii) Load event occurs when web page load into ____.
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WHAT YOU HAVE LEARNT

JavaScript is a programming language and is easy to learn.  In this lesson you have
learnt about features of JavaScript, declaring variables, looping concepts and functions
in JavaScript. You have also learnt about how to store data in JavaScript,  how to
call functions,  use window objects and handling of events to make the program more
interactive.

TERMINAL EXERCISE

1 What do you understand by Server side and Client side Scripting?

2. Write a script program to display sum of numbers from 20 to 50.

3. Explain the use of event handling? Give at least two examples?

4. Create a document to link the website of NIOS(www.nios.ac.in).

5. Create a form to display following field:

Input fields Name, Age

Display Name, Age

6. Write a JavaScript to write the table of any natural number n i.e. n x 1= n; n x
2 = 2n etc.

 ANSWER TO INTEXT QUESTIONS

  10.1

1. (i) Once (ii)  ++

  10.2

1. (i) false (ii) false (iii) true

(iv) True (v)  True (vi)   True

2. (a) (iii) (b) (ii) (c) iv (d) (i)

3. (i)  event (ii)  Message (iii)  Browser
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11

PHOTOSHOP

Adobe Photoshop is an extremely powerful photo/image editing software tool
available for designing images (photos) for web pages. Have you ever seen or heard
about Photoshop software? Probably many of you would have heard about it for
sure. This software is used by graphic artists, designers to enhance image, photos.
You can manipulate, resize, or change color of your digital images using this software.
In this lesson we shall learn about creating a new document in Photoshop, opening
an image from a disk, and saving a document in Photoshop.

OBJECTIVES

After reading this lesson, you will be able to:

• create a new Photoshop document;

• open an image from a disk;

• save a document in Photoshop;

• optimize graphics for web.

11.1  CREATING A NEW DOCUMENT

To create any Photoshop document, first start Adobe Photoshop CS6. Click on the
shortcut on the desktop or click Start All Programs Adobe Design and
Web Premium CS6  Adobe Photoshop CS6 to start Adobe Photoshop.

To create a new document, click  File  New.
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This will open a dialog box for document setup. You can enter name of the file, set
width, height, resolution and background content of the document (as shown in Fig.
11.1). Photoshop files will have .psd  (psd - Photoshop document) as an extension
name. Sometimes files will have .psb extension also (means Photoshop Big).

Fig. 11.1 : New document

In the above dialog box, various options are available for setting up  a document. It
includes:

Page Size

By entering new values for width and height you can change the page size. Page
size represents the final size of the page layout.

Page Orientation

You can get options for common sizes as letter, legal, etc. in the preset dropdown
menu.

Resolution

Resolution is a number of pixels in an image. For better quality image you can choose
high resolution.

Color Mode

Select a color mode for your document according to requirement. For example,
choose RGB for a website graphics.

Background Contents

Select the background content: white, color or transparent.
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11.2  OPENING AN IMAGE FROM A DISK

Select File  Open to open an image from a disk, and then navigate the location
of the image where your image is saved. Select the image file and click Open. To
keep original file, you can save a copy of the same file. To save your file, choose
File  Save As and  type new name of the file.

The layout of Adobe Photoshop interface is given in Fig. 11.2 :

Fig. 11.2: Interface Layout

Interface layout contains menu bar, tool bar, image, image name, adjustments and
layer etc.

Menu Bar

Menu bar is available at the top of screen which contains all the main functions of
Photoshop, for example  File, Edit, Image, Layer, Select, Filter, View, Window and
Help.
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Tool Bar

Most of the important tools like marquee, lasso, crop, eraser etc., are available in
the Tool bar.

The Image

When you open an image, you can see image on the screen.

Image Name

Name of the image is available at the top of the image as shown in
Fig. 11.2.

Palettes

Palettes contain more advanced image editing functions. Normally, palettes are
stacked in groups.  Color, Adjustments and Layers are visible palettes. You can
also select palettes from menu bar.

11.3  PALETTE

Palettes are used for more advanced image editing features. Most frequently used
palettes in Adobe Photoshop CS6 are described below.

Color, Swatches and Style palette

Photoshop has many powerful tools to modify the color and effects of images. The
Color palette displays the currently selected foreground and background colors and
RGB values. You can change colors of the foreground and background using sliders.
You can also select a color available in the color ramp from the spectrum of colors
at the bottom of the color palette.

Color palette
You can see the color values of foreground and background colors in the color palette
(as shown in Fig. 11.3).

Fig. 11.3 : Color palette
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Swatches palette

You can select a foreground or background color from the Swatch palette
as shown in Fig. 11.4.

Fig. 11.5 : Style palette

 INTEXT QUESTIONS 11.1

I Fill in the blanks.

1. Adobe photoshop files will have extension  as __________________.

2. Frequently used Palettes in Adobe Photosop CS6 are ______________ ,
______________ , ______________

3. __________________ tool selects an object by drawing a freehand
border around it.

4. __________________ tool is used to cut images into slices, which can be
exported to a webpage.

II State True or False for the following:

1. .psk is the extension of Photoshop files.

2. Menubar has the important tools like marquee, lasso and crop.

Fig. 11.4 : Swatches palette

Style palette

You can view, select, and apply preset layer styles from Style palette as shown in
Fig. 11.5.  A preset style replaces the current layer style by default.
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11.4 LAYERS

Using layers you can arrange your work into different levels that can be viewed
and edited as individual units. You can understand concept of layers as a group of
clear plastic sheets containing image pixels and transparent areas. You can see below
the layers in transparent areas. Each Photoshop document has at least one layer.
Creating multiple layers helps you to control how your image is viewed and edited.

The Layers palette (as shown in Fig 11.6) is used while creating a document, so it
is important to understand how to use it. Different icons in Fig 11.6 are described
below:

A) Layer Visibility: The icon eye shows that the selected layer is visible. To see
or to hide a layer click on or off.

B) Layer Locking Options: To lock transparency click the square icon; to lock
the image click the brush icon; to lock the position click the arrow icon; to lock
all options click the lock icon.

C) Layer Blending Mode: Describes how the layer’s pixels blend with underlying
pixels in the image. You can create  many special effects by selecting a particular
blending mode from the dropdown menu.

D) Opacity: By dragging a slider you can change the transparency of the entire
layer.

E) Fill: By dragging the slider you can change the transparency of the color of
the image or object.

F) Layer Lock: This icon shows when the layer is locked and disappears when
it is unlocked. To unlock the layer double-click the icon.

G) Layer Options Menu: You can click on the black triangle to have the following
options: New Layer, Duplicate Layer, Delete Layer and Layer Properties.

H) Link Layers: This icon can be used to link layers together.

I) Layer Styles: If a layer has a style, an “F” icon shows at the bottom of the
Layers palette.

J) Layer Mask: An image, containing parts painted in black hidden, parts painted
in white showing, and parts painted in gray shades showing in various levels of
transparency.

K) Layer Set: Click this icon to create a folder for many layers. It helps you to
organize images with multiple layers.

L) Create New Fill or Adjustment Layer: Click this icon and select an option
to create a new fill or adjustment layer. You can have the same opacity and
blending mode options like image layers and it can be hidden, rearranged, deleted
and duplicated in the same manner as image layers.
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M) Create New Layer: To create a new layer, click this icon.

N) Delete Layer: To delete a layer, choose a layer and click the icon or choose
a layer in the layers palette and drag it to the trash icon.

Fig. 11.6 : Layers

11.5 SELECTION TOOLS
Few main selection tools shown in Fig 11.7 in Adobe Photoshop CS6 are given below:

Marquee

 Click the tool button, choose a rectangular or an elliptical marquee. Drag the
marquee over the area of the image you want to select.

Move

Move tool is used to select and move objects on the page. Click the tool button, then
click on any object on the image you want to move.

Lasso
Lasso tool selects an object by drawing a freehand border around it. Click the tool
button, drag to draw a freehand border around the area of the image you want to
select.
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Fig. 11.7 : Toolbox

Polygonal Lasso

Polygonal Lasso selects an object by drawing a straight edge border around
it. Click the tool button, click on the starting point on the image, drag to
draw a straightedge border, click and drag again to select the area of the
image you want to select. Double click to finish.

Magnetic Lasso

Magnetic Lasso selects an object by drawing a border that snaps to the
edges of the defined area of the object. Click on the starting point on the
image, drag around the area of the image.

The tool will make fastening points at the edges. To finish selecting, drag
the border to the starting point and click precisely in the point.

Magic Wand

Magic wand tool selects all objects in a document with the same or similar
fill color, stroke weight, stroke color or blending mode. You can control
what the Magic Wand tool selects by specifying the color range or
tolerance.

Crop Tool 

Select the crop tool button, then click on the area of the image you wish to
select. It selects and cuts portions of an image.

Slice Tool

Slice tool is used to cut images into slices, which can be exported to a web
page.

11.6 SELECTION

There are several ways to select images or parts of images in Photoshop.
To perform selection, some  basic methods are given below:

Select the rectangular Selection tool on the Toolbox to select  area to
work on (as shown in Fig11.8).

To add to a selection, hold Shift before dragging.
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To make the selection exactly square, start dragging, then hold Shift key.

Press Ctrl+D to “deselect” and remove the selection.

Fig. 11.8 : Selection using rectangular selection tool

11.7 CROPPING

Cropping is the most basic editing techniques which can improve your images.
Cropping is the process of removing portions of an image to create focus or strengthen
the composition. Cropping also helps you to make your image a standard photo size.
You can crop an image using the crop tool and the crop command.

There are several ways to crop images in Adobe Photoshop:

1. Cropping with crop tool.

2. Crop an image using the crop command.

3. Cropping to a specific size.

Cropping with crop tool

The Crop tool helps you to have a precise selection of an image you want to edit. To
crop with the Crop tool, follow these steps:

• Open the image you want to crop (as shown in Fig. 11.9).

• Choose the Crop tool from the toolbox.

• It will automatically select entire image. Drag the sides to fit the dimensions
you want.
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Fig. 11.9 : Using crop tool

To crop an image using the Crop command

Select the portion of the image you want to keep by doing one of the following:

With the rectangle  or elliptical marquee , drag over the area you want
to select(as shown in Fig. 11.10).

Hold down shift keys as you drag to constrain the marquee to a square or circle.

Choose Image > Crop.

Fig. 11.10 : Sample image
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Cropping to a specific size

If you want to print your digital photos or other images on standard size photo paper,
you will have to crop your images to a specific size, such as 8 X10 or 5X7. To crop
an image to a specific size, follow the steps given below:

• Open the image you want to crop.

• Choose the crop tool from the Toolbox (as shown in Fig. 11.11).

• Specify the values for width and height in the option bar or choose it from the
given option.

Fig. 11.11 : Crop tool options bar

11.8 RESIZING DIGITAL IMAGES

Digital images normally have large dimensions but low resolution, which affects their
quality when their size is decreased or increased. To resize the digital images without
loosing the quality, follow the steps given below:

1. Open the digital image you want to resize.

2. Go to View > Rulers. You will see the dimension of your photo (as shown in Fig
11.12).
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Fig. 11.12 Sample image

3. Go to Image  Image Size.

4. In the Image size option, check the Resample Image check box off  (Fig. 11.13)
Enter  your desired resolution. The photo is now 5.01 x 3.78 inches.

Fig. 11.13 : Changing resolution

11.9 ADDING FLASH

If we take pictures indoors without a flash, they will turn out underexposed and dark.
To fix  underexposed images, follow these steps:

1. Open a digital image you want to correct (as shown in Fig. 11.14).
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Fig. 11.14 : Underexposed image

2. Go to Layers  Duplicate. Name the layer Layer 1.

3. Make sure that Layer 1 is selected in the Layers palette. Select Image 
Adjustments  Exposure (as shown in Fig. 11.15). Select the amount of
exposure as per requirement.

The whole image will become bright (as shown in Fig. 11.16).

Fig. 11.15 : Selection of exposure
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Fig. 11.16 Image

11.10 ENLARGING

To make your digital image into a poster size image, you can perform it in the Image
Size dialog box. Increasing the dimensions will make the image appear blur and
pixilated. To enlarge the image without losing the quality, the following steps will
help you :

1. Open the digital image you want to enlarge.

2. Go to Image > Image Size.

3. In the Image Size dialog box, make sure the Resample Image check box is
checked off and choose Bicubic Smoother from the dropdown box (as shown
in Fig 11.17).

Fig. 11.17 Increasing the size
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4. Change the document size measurements to percent. If you type 110 it will
increase the size of the image by 10 percent.

5. Continue enlarging by 10 percent until you are satisfied with the size.

11.11 SAVING A DOCUMENT

To save a document in Photoshop

1. Click File  Save As.

2. Navigate to the place you would like your document to be saved by using the
drop down menu and the navigation window.

3. Enter the desired name of your document in the Save As text field.

4. Choose a file format to save your document from the Format drop-down menu.

5. Click the Save button in the right corner (as shown in Fig. 11.18).

Fig. 11.18 : Saving a file
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11.12 OPTIMISE GRAPHICS FOR WEB

If you are planning to design a website using images/photos you have to adjust the
quality of the image and size (file size) of the image.

For this you can use “Save for Web and Devices” option from File menu. In Save
for Web and devices, you can view multiple copies of an image/photo at a time and
modify optimization settings as you preview the image and choose the best for your
purpose.

 INTEXT QUESTIONS 11.2

I Fill in the blanks.

1. Each Photoshop document will have at least ______________ number of
layers.

2.  __________________ is the process of removing portions of an image to
create focus or strengthen the composition.

II State True or False for the following:

1. There is only one method is there to crop images in Photoshop.

2. You will not enlarge you digital image using Photoshop.

 WHAT YOU HAVE LEARNT

Photoshop software is famous among graphic designers and photographers, which
will help you resize and crop an image. This software allows users to edit, crop,
resize, change the color on digital photos. In this lesson you have learnt that Photoshop
is an an image editing software tool.  You can create a new document open an image
from a disk and use layers,  select loops, crop an image, add flash to an image.

 TERMINAL EXERCISE

1. Define the term layer. Also mention few lines about its usage in Photoshop.

2. What do you mean by the term Flat Image and is there any advantage of
creating a Flat Image?

3. What is linking layer?

4. What is the purpose of adjustment layer?

5. Name any two palettes used in Adobe Photoshop CS6.

6. What is cropping?

7. What is the purpose of slice tool?
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  ANSWERS TO INTEXT QUESTIONS

11.1

1.  .psd or .psb

2. Color, Swatch, Style

3. Lasso

4. Slice

1. False

2. False

11.2

1. 1

2. Cropping

1. False

2. False
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12

OVERVIEW OF W3C
STANDARDS

In the previous lessons you have learnt about HTML language, photo editing
software Photoshop, animation software Flash and also about Dreamweaver
software for creating a website.  You have also learnt about the appropriate use of
multimedia, use of Cascading Style Sheets (CSS), Java script, playing with images
to design a good website. Developing a website consists of many phases – analysis,
design, testing and publishing. Although a good website can be created using the
web development language/tools available but it should adhere to W3C standards.
It is necessary to follow W3C standards to enjoy full potential of web.

World Wide Web Consortium (W3C) standards define an Open Web Platform for
application development that has great potential for web developers to build rich
interactive experiences and huge data stores. W3C develops technical specifications
and guidelines through a process designed to maximize consensus about the content
of a technical report, to earn endorsement by W3C and the broader community. The
W3C serves as an open forum for discussion about the Web.

OBJECTIVES

After reading this lesson, you will be able to:

� define W3C standards;

� list the advantages of W3C;

� use different protocols appropriately;

� validate websites;
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12.1 W3C STANDARDS

Web standards are set of rules and guidelines
established by the World Wide Web Consortium
(W3C) developed to promote consistency in the
design code for a website. These are the guidelines
for the markup languages which determine how
a web page looks in a visitor’s browser window.
This is an industry consortium which is there to
promote standards for the evolution of the web and
interoperability between WWW products by
producing specifications.

The founder of WWW, Tim Berner Lee’s dreamt of “One Web For All” and now
it is changing into reality by following the guidelines laid by W3C for creating
business, social, and educational sites. The web needs guidance and certain rules
to follow to realize its full potential towards growth of web based environment. It
provides the guidance and ensures that everyone has access to the information we
are providing, and also make web development faster and more enjoyable. The
guideline provides standard compliance which makes web availability easier for
people with special needs to use the web. Blind people may have their computer
read web pages to them. People with poor eyesight may have pages rearranged and
magnified for easier reading and people using hand-held devices can browse the
web just as easily as those using high-end workstations.

Although W3C is funded by industrial members, it is vendor-neutral, and its products
are freely available to all. Web standards are developed by standard organizations
and groups of interested /competing parties chartered with the task of
standardization. Working groups obtain general consensus from companies and other
organizations involved in creating applications for the web, and create working
drafts and proposed recommendations. These are then submitted to the W3C
membership and director, for formal approval as W3C Recommendations. The W3C
develops open specifications to enhance the interoperability of web-related products.

12.1.1 Brief History of W3C

The World Wide Web Consortium (W3C) is the main international standards
organization for the World Wide Web (abbreviated WWW or W3).
The consortium is made up of member organizations which maintain full-time staff
for the purpose of working together in the development of standards for the World
Wide Web.

Tim Berners-Lee invented the World Wide Web in 1989 with the basic functions
of URLs, HTTP and HTML mark-up language. He is known as the father of the

Fig 12.1 W3C standards
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Web. He coined the term “World Wide Web”, wrote the first World Wide Web server,
“http and the first client program (a browser and editor), “WorldWideWeb,” in
October 1990.  He wrote the first version of the “HyperText Markup Language”
(HTML), the document formatting language with the capability for hypertext links
that became the primary publishing format for the Web.

12.1.2 Mission and Vision

The W3C mission is to lead the World Wide Web to its full potential by developing
protocols and guidelines that ensure the long-term growth of the web. The vision
of W3C is One Web for All.  i.e., Web for everyone, and on everywhere.

Five leading global organisations supporting the modern paradigm for standards,
jointly signed an agreement on August 29,2012 to provide empowering model to
help the people around the world to develop new technologies and innovate for
humanity. W3C’s vision for the web involves participation, sharing knowledge, and
thereby building trust on a global scale.

Following are the design principles in support to vision statement of W3C:

• Web for Everyone

The primary goal of W3C is to make all web benefits available to all people,
whatever their hardware, software, network infrastructure, native language,
culture, geographical location, or physical or mental ability. It provides web
accessibility initiative, internationalization, and mobile web for social
development.

• Web on Everything

The number of different kinds of devices that can access the web has grown
immensely. Mobile phones, smart phones, personal digital assistants, interactive
television systems, voice response systems, kiosks and even certain domestic
appliances can all access the web.

• Web for Rich Interaction

For many years, the web was a “read-only” tool for many. Blogs and wikis
brought more authors to the web, and social networking emerged from the
booming market for content and personalized web experiences. W3C standards
have supported this evolution because of strong architecture and design
principles.

• Web of Data and Services

Some people view the web as a giant repository of linked data while others as
a giant set of services that exchange messages. The two views are
complementary, and which to use often depends on the application.
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• Web of Trust

People “meet on the web” rather than meeting personally as the communication
patterns are changed because of web development. W3C recognizes that trust
is a social phenomenon, but technology design can foster trust and confidence.
As it moves more online, it will become even more important to support
complex interactions among parties around the globe.

12.1.3 Advantages of W3C

Following are the advantages of W3C standards for web development

1. Consistent Interface – With standards compliant code, all styles are defined
separately in a central CSS file. Separation of style from content gives a
consistent look and feel to each web page.

2. Efficient searching – Web standards controls on clutter in the code. Search
engines will have less site crawling time with less clutter. A compliant website
will also get indexed more accurately and results in faster search.

3. Well structured code– Having a compliant website makes the site easier to
maintain since the code is cleaner which results in easier readability. Web
standards insist that you write clean, valid, modular and semantically correct
markup. For example, “font” tags are no longer used to define font attributes
of text- instead, it is defined by the style sheet. By doing so, it simplifies the
code and makes it easier for developers to troubleshoot and maintain.

4. Accessibile on all devices – Proper valid code makes it easy to display the
content of a website on different devices, like cell phones, PDAs, screen readers,
etc.

5. Helping Special need people - Complying with web standards allows the web
to be used by people with disabilities, by people with sight impairments using
Braille browsers.

6. Supporting other formats–The W3C provides standards for web scripting,
dynamic content, web graphics, audio, video besides providing HTML and CSS
standards.  The W3C also provides website privacy and security guidelines to
follow.

7. Ability to repurpose –The powerful feature of web standards is the ability to
“repurpose” the same web page content (HTML, XML) into numerous alternate
formats and data types for use by many different systems online.

8. Browser compatibility - Web standards ensure that your code works in current
and future browsers. It also caters to older browsers whereby your web page
will degrade gracefully to produce an acceptable result in many older browsers
and agents.
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9. Fast loading – W3C Standards promote the use of “Cascading Style Sheets”
(CSS) or design code which is embedded in the page. The use of style sheets
significantly reduces the page file size which results in faster page loading time
and lower hosting costs for frequently visited sites because of using less
bandwidth.

10. Cost reduction – Since the website is so easy to maintain, the time it takes
for someone to update the website will be reduced, which will save money.

12.2.W3C STANDARDS FOR HTML AND XML

12.2.1 W3C and HTML

You are aware that Hyper Text Markup Language (HTML) is the language for
describing the structure of webpage and browsers interpret these documents to
display the web pages. It is widely used on the web for adding structure to text
documents. For example, in HTML, visual browsers typically display the text in
emphasized form using <em>… </em> tag and make the text well emphasized

W3C standards for HTML enables web developers for the following:

• They can publish online documents with headings, text, tables, lists, photos,
etc.

• They can retrieve online information via hypertext links, at the click of a button.

• They can design various forms for conducting web based operations such as
transactions with remote services, use in searching for information, making
reservations, e-commerce operations, etc.

• They can include spread-sheets, video clips, sound clips, and other applications
directly in their documents.

• The web developer may define how structural elements are to be represented,
overriding the browser defaults with the help of Cascading Style Sheets (CSS).

Example of HTML Code:

</HTML>

<HTML>

<HEAD>

<TITLE>Welcome to my profile page</TITLE>

</HEAD>

<BODY>

<!— Site Navigation Menu —>

<UL type = “Square”>

<LI><A HREF=”about.html”>About Me</A></LI>
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<LI><A HREF="http://www.nios.ac.in">

My School</A></LI>

<LI><A HREF="hobbies.html">My hobbies</A></LI>

<LI><A HREF="contact.html">Contact Me</A></LI>

</UL>

<H1>My Profile Page</H1>

<P>Welcome Dear Readers!</P>

<P>I am writing about me and presenting myself amongst you all</P>

</BODY>

Following is the output of the above written HTML code.

Fig. 12.2 : Profile Page

12.2.2 W3C and XML

XML is self-descriptive markup language designed to store and transport data.
Extensible Markup Language (XML) is a markup language like HTML, but instead
of having a single, fixed set of elements, it allows you to define your own defined
set of tags and attributes. It even allows using multiple sets within a single document
– by using XML namespaces. Style sheet standards, such as CSS and
XSL(Extensible Stylesheet Language), offer a variety of options for specifying how
XML elements are to be rendered. Standards compliant support for direct rendering
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of XML and presenting information to humans using HTML with CSS-driven styling.
In today’s scenario XML is mostly used for machine-to-machine communication.

XML is more flexible than HTML, primarily because of the ability to add your own
elements and make your own structural systems. This makes it an ideal format for
the organization of large quantities of data and is already in use in many databases
and search engines. XML allows to create well-formed and well defined documents
and create own tags. It works with CSS for browser output.

Example of part of an XML document

12.3 UNICODE AND ITS SIGNIFICANCE

Unicode is a standard for representing characters as integers. Unlike ASCII, which
uses 7 bits for each character, Unicode uses 16 bits, which means that it can represent
more than 65,000 unique characters. It defines the universal character set and the
latest version of it contains a large number of characters covering most of the
currently used scripts in the world. It also contains additional characters for
interoperability with previous character encodings, and characters with control-like

Book_catalog.css

bookdetail {

background-color: #ffffff;

width:100%

}

book{

display : block;

margin-bottom : 30pt;

margin-left: 0;

}

TITLE

{

color : #FF0000;

font-size:20pt;

}

name,price {

color: #0000FF;

font-size : 18pt;

}

Book.xml

<?xml version="1.0" encoding  ="UTF-
8"?>

<?xml-stylesheet type ="text/css"
href="book_catalog.css"?>

<bookdetail>

<TITLE> Book Store</TITLE>

<book>

<name>HTML programming</name>

<price>300</price>

</book>

<book>

<name>Let us C</name>

<price>400</price>

</book>

<book>

<name>HTML for Dummies</name>

<price>200</price>

</book>

</bookdetail>

Output

Book Store

HTML programming 300

Let us C 400

HTML for Dummies 200
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functions to provide unambiguous interpretation of plain text. Unicode provides
specifications for use of all of these characters.

For document and data interchange, the Internet and the World Wide Web make

extensive use of marked-up text such as HTML and XML. Mark-up languages

provides the same or essentially similar features to those provided by format

characters in the Unicode Standard for use in plain text. Another special character

category provided by Unicode is compatibility characters. The goal of Unicode

Consortium is to replace the existing character sets with its standard Unicode

Transformation Format (UTF).

The Unicode standard has become a success and is implemented in HTML, XML,

Java, JavaScript, E-mail, ASP, PHP, etc. The Unicode standard is also supported in

many operating systems and all modern browsers. The Unicode Consortium

cooperates with the leading standards development organizations, like ISO

(International Organization for Standardization), ECMA(European Computer

Manufacturers Association) and W3C.  Unicode can be implemented by different

character sets. The most commonly used encodings are UTF-8 and UTF-16:

Character-set                                    Description

UTF-8 A character in UTF8 can be from 1 to 4 bytes long. UTF-
8 can represent any character in the Unicode standard. UTF-
8 is backwards compatible with ASCII. UTF-8 is the
preferred encoding for e-mail and web pages.

UTF-16 16-bit Unicode Transformation Format is a variable-length
character encoding for Unicode, capable of encoding the
entire Unicode repertoire. UTF-16 is used in major
operating systems and environments, like Microsoft
Windows, Java and .NET.

 INTEXT QUESTIONS 12.1

1. Fill in the blanks:

a. ___________ is the preferred encoding for e-mail and web pages.

b. _____guidelines determines how a web page looks in a visitor’s browser
window.

c. W3C stands for ___________________
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12.4 PROTOCOLS

Protocols mean the set of rules or standards designed to enable computers to connect
with one another and to exchange information with as little error as possible.
Protocols can describe low-level details of machine-to-machine interfaces (order
in which bits and bytes are sent across a wire) or high level exchange between
allocation programs (order of transferring a file across internet by two computers).

Following are some of the protocols:

HTTP (Hyper Text Transfer Protocol)

Hypertext transfer protocol, the Internet protocol that defines how a web server
responds to request for files, made via anchors and URLs.  It works at browser level
and consists of two distinct items:-

� A set of requests from browsers to servers.

� A set of responses from server to browsers.

TCP/IP

A protocol stack, designed to connect different network on which the Internet is

based.  The suite includes protocols for remote login (Telnet), File Transfer (FTP),

E-mail (SMTP) and so-on. TCP/IP can work with any hardware or operating system.

TCP (Transmission Control Protocol) - A connection-oriented transport protocol

that provides reliable data transmission between two entities, often a client and server

application. TCP is responsible for keeping track of what is being sent, how it is

being sent and whether what has been sent is received properly at the other end or

not. If not properly received, retransmission is controlled by TCP. TCP splits

messages into fixed size datagram which are then tagged with destination address

and sent to receiver where the datagram are merged to form proper message.

IP (Internet Protocol) offers a connectionless internet service. IP is the protocol

controlling addressing on the network. As and when any computer gets connected

to the network, it must owe a unique address with which it will be identified by

other systems. IP protocol assigns address to the different system on the network.

FTP

File Transfer Protocol (FTP) permits files to be transferred from one computer to
another using a TCP connection. This protocol enables files to be uploaded or
downloaded on a network and serves as client server process.
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The objectives of FTP are:

i) To promote sharing of files(computer program/data).

ii) To encourage indirect use of computers.

iii) To transfer data.

SMTP -  is the protocol used for transfer of e-mail over the network. It requires
both the sender and receiver to be online while sending or receiving the mail. The
solution to this is provided by POP. This protocol is for sending the mail.

POP (Post Office Protocol) is a protocol for mail collection and distribution that
allows creation of mailbox for each user to store the mail until they are collected.

PPP (Point to Point Protocol) is currently used Internet protocol for data transfer
on dial-up lines or leased lines.  PPP supports synchronized and asynchronized lines.

VoIP Voice Over Internet Protocol enables the transfer of voice using packet
switched network rather than using public switched telephone network.

INTEXT QUESTIONS 12.2

1. Give the name of protocol as per the statement given below:

a. This Protocol enables the transfer of voice over the internet.

b. This protocol is responsible for breaking up the data into packets to be
sent over the Internet.

c. This protocol send request from browser to server and vice-versa.

2. Expand TCP/IP.

12.5  TESTING TOOLS FOR WEBSITES

After you create a website using HTML, XML, CSS or Java Script, it must meet all
the specifications set by W3C standards.  For this you need to validate and check
your code for error free execution. W3 org provides certain free tools and add-ons
to perform these checks like code validation, CSS code checker, Link checker etc.

HTML code validation means that the code you have in your webpage should be
according to the definitions given by the doctype you have chosen for your document.
The specified doctype affect the HTML code interpretation and layout mode to be
activated in different web browsers. There are a number of online validation tools
as well as add-ons to different web browsers. Popular validation tools are W3C
Markup validiation service, W3C CSS validation service, WDG HTML validator

etc.,
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W3C Markup Validation Service

This validator checks the markup validity of web documents in HTML, XHTML,
SMIL, MathML, etc. Write URL address of website or upload the file for which
you want validation check. The Link address is https://validator.w3.org

Fig. 12.3 :  Markup Validation Service

W3C CSS Validation Service

To validate your CSS code, use the tool available on the link http://jigsaw.w3.org/
css-validator/ .  If you want to validate your CSS style sheet embedded in an HTML
document, your HTML should be valid.

Fig. 12.4 : CSS Validation Service

WDG HTML Validator

Testing tool checks the correctness of HTML code.  The link address is http://
htmlhelp.com/tools/validator/
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Fig. 12.5 :  WDG HTML Validator

• Firefox HTML validator add-on – It is an extension of Mozilla Firefox that add
HTML validation inside Firefox.

Fig. 12.6 FireFox HTML validator add-on

Link Checker

This Link checker looks for issues in links, anchors and referenced objects in a web
page, CSS style sheet, or recursively on a whole website. Use the link : https://
validator.w3.org/checklink for link checker.
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Fig. 12.7 Link Checker

12.6 TIPS FOR WEB DEVELOPMENT

While developing a quality website we need to keep in mind the important points to
take care of and what to avoid.  Following are the important do’s and don’ts to
remember for developing a website.

DOs to consider:

• Elements should have closing tags unless empty.

• Unused elements may minimise.

• Attributes should be quoted.

• Elements should be nested properly.

• Validate your HTML.

• Check your pages in as many browsers as possible.

• Use templates.

Following are some DON’Ts to consider for HTML:

• Do not use “click here” as link text. When calling the user to action, use brief
but meaningful link text that explains what the link offers.

• Do not cross the elements. Nest them.

• Do not use header tags to change font size.

• Avoid “Coming Soon” and “Under Construction” signs.
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• Don’t mix script, style and structure.

a. Do not use XML as the file name or root tag.

b. Do not make files that are too large.

c. Do not use special characters.

INTEXT QUESTIONS 12.3

1. State True of False for the following statements :

a. You should close the empty tags.

b. Your code should meet the W3C standards.

c. Simple mail transfer protocol is used for receiving mails.

d. POP stands for Post of  Protocol.

2. Fill in the blanks.

a. _______ character set is used in major operating systems and
environments, like Microsoft Windows, Java and .NET.

b. _______ is a protocol for mail collection and distribution that allows
creation of mailbox for each user to store the mail until they are collected.

c. FTP stands for ____________.

WHAT YOU HAVE LEARNT

In this lesson you have learnt about the W3C standards which are guidelines laid
down to provide a standard for designing and developing a website. With standards
compliant code, web developers can make sure that a website is properly structured
and semantically coded.  It makes the website easier to manage, more accessible,
and better for search engines.  The common problem for web developers is to run
their code on different browsers and with standards compliant code will make cross
browser compatibility much easier.  Cleaning up website errors is a tough process
and using testing tools you can make it easier. In the process of web development
you should take care of dos and don’ts for better development.  The vision of the
W3C is to make web available to all and everywhere with the mission to make the
web a better place for developers and end users by encouraging worldwide standards.
This effort will be greatly helped when web developers use the standards as a matter
of course.
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TERMINAL EXERCISE

1. What do you mean by W3C standards?

2. What is the goal of W3C?

3. What do you mean by the term web for all and web for trust.

4. What are advantages of W3C standards? Mention any four.

5. Give two points each for dos and don’ts to consider while developing a site.

6. What is UNICODE?

7. Explain TCP/IP.

8. Define Protocol. Explain any two protocols.

9. Explain two points which makes a HTML document W3C standard compliant.

10. Which testing tool you would use to test the links of a site?

11. Write URL for the testing tool to check the web page validity?

 ANSWERS TO INTEXT QUESTIONS

  12.1

1. a) UTF-8

b) W3C

c) World Wide Web Consortium

  12.2

1. a) VoIP b) TCP c) HTTP

2. Transmission Control Protocol /Internet Protocol

  12.3

1.  a) False b) True c) False d) Fasle

2. a) UTF – 16

b) POP or Post Office Protocol

c) File Transfer Protocol
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13

ANALYSIS, DESIGN AND
TESTING OF WEB BASED

APPLICATIONS

A web application is an application that can be accessed by multiple users across
the world through Internet. The web applications provide us variety of services in
almost all the fields such as medicine, education, defence, infrastructure, hospitality
etc.  It is a very dynamic field which has evolved immensely over the years. In the
last few years the popularity of web based applications has increased
tremendously.This intensive use of web applications has generated a rising interest
in the development of methodological approaches for the construction of web based
applications. Several research groups have proposed various processes, models and
techniques to build user friendly and secure web based applications.  In this lesson
we shall learn about analyse, design and test web based applications.

OBJECTIVES

After reading this lesson, you will be able to:

● analyse web based application;

●   design a web application;

●  test a web application;

●    deliver a quality of service.
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13.1 ANALYSIS OF WEB BASED APPLICATIONS

We all are familiar with the term software development.  Do you know that the

development of web systems or web based applications is usually more complex

than the construction of traditional software?  Some of the key features of web

based applications are as follows:

(i) It has diverse and volatile requirements.

(ii) The web applications have heavy content in the form of text, images, pictures,

audio and video. So content management is a very important aspect of any

web based application.

(iii) The complex architecture and design of the web application has to incorporate

server side technologies, client (usually the web browser) side scripting,

application servers and database servers concurrently.

(iv) It has the capability to handle diverse users worldwide who are of varied age,

culture, norms and values. These users are also different in terms of their

education, professional experience and computer knowledge.

(v) In addition to this, the web based systems have additional requirements for the

navigational and multimedia aspects as well as for the usability as no training

is possible for millions of users across the globe.

All the above features make web development a very complex and skilled process

and that is why it requires a multi-disciplinary web development group.

The non-web based applications consider system analysis as the most important

phase in the development process. Many models and techniques have been proposed

in this regard for various phases of system analysis and design. But unfortunately

these techniques and models are very poorly applied in web development process.

We actually require methodologies and tools for quality assurance of web based

systems but the first step is a thorough requirements analysis. Do you know that the

requirement analysis is the most critical step for designing web-based applications?

Through this we can find out the actual need of a web based system. The steps

involved for the Requirements Analysis of web based application are as follows:

(i) Requirements Elicitation.

(ii) Requirements Specification.

(iii) Requirements Validation and Verification.
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13.1.1 Requirements Elicitation

Elicitation is the practice of collecting the requirements of the web application being
developed from the users, customers and other stake holders. In simple words we
can also say that it is collecting information from the concerned people. That is why
it is also sometimes referred to as ‘requirement gathering’. It is a vital activity as
it tends to find out the requirements of the end users for the web application to be
developed. It is indeed a challenging task to discover and understand the requirements
of varied set of end users, executives and other stake holders.The requirements
elicitation can be done with the help of the following resources:

● Existing end users, customers and their requirement specifications.

● Existing documentations.

● New users and their specifications.

The above mentioned resources have to be interacted among them to gather
information. The following techniques can be used for elicitation purposes:

● Interviews.

● Group data gathering.

Interviews

Interviews are usually held one to one. The web developer (interviewer) prepares
a series of questions and seeks answers from all the end users and other stake holders
(interviewee) like executives and manager of the firm for which website is being
developed.  The web developer tries to know the complete requirements of the users
who will be using the website and also the manager and other employees of the
firm as to what they want to show and depict through their website.  Following points
should be kept in mind while taking such interviews:

(i) The interviewer should always prepare for the interview well in advance and
have a rough plan in mind before going for the interview.  He should have basic
information about the subject area for which the web application is being
developed.  For example, if the application is being developed for students of a
college, then the developer should have basic knowledge about the set up and
functioning of  educational institutions in that region.

(ii) The interviewer should ask open ended questions such that the interviewee is
able to give valid and relevant answers. If the interviewer asks closed ended
questions, the interviewee will give short answers and it will be difficult to
extract detailed information from them. The interviewer should in fact also ask
follow up questions so that the interviewee may open up. This helps in retrieving
the hidden data also from the interviewee that might not have been given at
the first instance. This practice helps in probing further so as to have a better
insight of the user’s requirements.
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(iii) The interviewer should be a good listener. He / she should also further clarify
the answers given by the interviewee by asking probing follow up questions.
This leaves no room for any ambiguity or confusion.  After listening to all the
answers he / she should be able to analyse the answers given to him / her so as
to incorporate all the requirements into his/her web development project.

Gathering data from groups

This is another technique for data elicitation or gathering.  Unlike interviewing which
was done on one to one basis, information in this case is gathered from a group of
people.  Some of the methods that can be used for gathering data from group of
people are:

● Brainstorming: This is one of the best group gathering technique in which
numerous ideas are raised among a group of people and then each of these
ideas are organized, discussed and analysed. This helps the web developer to
gain relevant and vital information about the organization, its employees and
also the end users of the web application.

● Workshops:Various users, employees and other stakeholders are brought
together and a list of requirements is put forward to them. Such workshops
are generally led by trained resource persons who take care of the interests of
each group of stakeholders who might be having conflicting interests. These
workshops bring everyone together and inculcate a sense of ownership in them.
That is why this is one of the most widely used elicitation technique.

● Sketching and Storyboarding: This technique is generally used by graphic
designers in the web development process.  It consists of schematic
representation of various sketches or drawings that may be grouped or linked
together. This gives a feel of the storyboard with multiple pages linked together.
Hence it helps in explaining the navigation process of the web application being
developed.

● Focus Groups: In this method, few experts are invited to discuss and debate
about a topic. These experts are knowledgeable and experienced people who
have sound knowledge of the topic under discussion. They generally confine
their discussion on a single topic till they have a uniform decision on a
particular requirement.

13.1.2 Requirements Specification

This process consists of forming documented specifications which are supplemented
with semi structured textual descriptions. The data collected from the elicitation
process is used to form specifications using activity diagrams to express the
workflow of complex navigations and processes. Templates are created and mock
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sketches are suggested for specifications of the site view and style guidelines.  After
all the specifications are proposed and explained, feedback forms are distributed
to all the users. The users fill in their views and comments which help in validation
of these specifications.

13.1.3 Requirements Validation and Verification

The process of validation confirms that the requirements specifications documents
formed after elicitation process were complete, consistent and unambiguous. It also
makes sure that the end users and other stake holders are satisfied with the
requirements laid down in these documents. For validation purposes one should
have knowledge of organizational standards, government rules and of course the
formed specifications.  Also it is important that the requirement documents should
be agreeable and approved by all users. This process is known as verification. Hence
the final requirement specifications should be verified by all the available
stakeholders of the web application.

13.2 DESIGNING A WEB BASED APPLICATION

While designing a web based application, the activities should be carried out in
such a manner that all the requirements specifications laid down during elicitation
process are taken into consideration and are also managed adequately. The
requirements could be of content, navigational structure, interfaces and their
protocols, data representation, software versions, security, user identification and
control etc. These multiple aspects make designing a web application a very complex
process in which all the requirements have to be given equal importance.

A web application has to be designed for repeated use. It can be visited by dozens
of people in a day; therefore it has to be very efficient.  Also it should be able to
handle complex user interactions too.  The following points should be kept in mind
while designing a web based application:

(i) Features

The users of any web application will be attracted by the features offered by the
web application. So care should be taken to include attractive and useful features
in application. For example, a movie ticket booking application should have features
like movie timings of various cinema halls, booking window, discount codes etc.

(ii) User experiences

Before styling the application, it is good to have an idea of the user experiences.
This helps the web developer to design a user friendly application. The developer
should make rough sketches to explain his/her idea to the user and then finalize
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them. This helps to focus on user’s requirements. These approved sketches can be
converted into interfaces of the web application.

(iii) Simple Interface

The web application should be designed in such a manner that it is easy to understand
and the required work/transaction can be done with fewer clicks.  User interface
of an application is so important that it is considered as one of the key success factors
of an application.   And it is not just the interface alone, the interaction of the interface
is as important too.  Interaction design defines the flow of the application and also
how each element of the interface should behave on user interaction. Therefore,
the user interface should be planned not only about how it will look but also how it
will operate.  We should decide upon which of the following events should be
incorporated and for what purposes:

● Click –to-edit.

● Drag and drop.

● Double click delete.

● Auto-saving after any action.

Adding special screens with heavy videos to perform trivial tasks should be avoided
as this slows down the application. The navigation should be smooth and with proper
feedback in response to mouse clicks and that too without page refreshes. If the
application is too complicated, its usefulness is diminished thereby reducing the usage.

(iv) Tools

For any web developer, having the right set of tools is very important as they ease
the web development process and help in easy navigation of code.  Some of the
tools available for developing web based applications are code editor, database
manager, FTP tools, image editor, database design tools etc. The web developer may
choose any of the tools depending upon the project that he /she is working on and
also depending on his / her expertise in any or all of these tools.

(v) Web Accessibility

Accessibility means to make the web application available to the users.  The web
application developed should be easily available on the World Wide Web (WWW).
You will learn more about accessibility later in this lesson.

INTEXT QUESTIONS 13.1

1. State True or False for the following.

a. Web application has diverse and volatile requirements.

b. Elicitation, specification, validation and verification are the steps involved
for the requirements analysis of web based applicaiton.
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c. New users and their specifications  are required for elicitation purpose.

2. Fill in the blanks

a. The process of ____________ confirms that the requirements

specifications documents formed after elicitation process were complete,

consistent and unambiguous.

b. ______________ is a group gathering technique in which numerous ideas

are raised among a group of people and then each of these ideas are

organized, discussed and analysed.

c. A _______________ is an application that can be accessed by multiple

users across the world through Internet.

d. __________________ is the practice of collecting the requirements of

the web application being developed from the users, customers and other

stake holders.

e. The process in which documents are formed containing requirements

supplemented with semi structured textual descriptions is called

______________.

13.3 TESTING

Testing is one of the most important phases of any web based application

development process.  It is a sort of an infinite process as there can be infinite

situations for which the project needs to be tested. Although there are various tools

and methods available for testing, yet unfortunately, very less attention is paid to it.

During this phase, the application interfaces and other functionalities hosted on the

web are tested.  Some of these types of testing techniques are as follows:

1. Usability Testing:  This type of testing technique is used to check the user

friendliness of the web application.  Some of the checks included in this

technique are :

a. To check the interface and all its controls. The icons and images used for

each control should be clearly understood by the user.

b. The navigation buttons and their functionality should also be checked.

2. Performance Testing: This testing technique is used to check the performance

levels of a web application on various grounds.  Some of these are:

a. Testing the behaviour of the application under specific load and measuring

how much load the database and the application server can take. This
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helps to find the upper limit capacity of the application. The performance

of the system can be measured if the load goes above the expected
maximum limit.  This can be done by increasing the number of users
suddenly by a very large amount.

b. Testing the endurance of the web application i.e., to determine for how
long the system can keep on working without any bugs or errors, under
continuous expected load. Issues like memory utilization and memory
leaks are also monitored in this case.

3. Functionality Testing: This type of testing technique is used to check the
various ways in which the application functions. Some of the checks that can
be done under functionality testing are:

a. To check that whether the navigation is correct or not. There should be
no dead page or invalid link in the application.

b. In case of an interactive web page, the validations on each field should
be checked. All possible inputs (including wrong inputs) should be used
for such testing.

c. The data integrity and the flow of the entire application should be verified.

4. Security testing: This is one of the most important testing techniques of a web
application. This testing is done to check the web application against
unauthorized access and data theft.  Some of the tasks performed while security
testing are:

a. Using components with known vulnerabilities for testing purposes and
then checking out the result.

b. Identifying the security misconfigurations by running the application from
all possible levels, platforms and links.

c. Identifying and removing invalid links, redirects and forwards.

d. Exposing the sensitive data and monitoring the system performance.

e. Checking for missing function level access control.

5. Compatibility Testing: This type of testing technique is used to test whether
the given web application works well with associated software and associated
tools or not. The checks covered in this type of testing are :

a. Checking the working of the application by running them on various
browsers and operating systems.

b. Checking whether the application is compatible on various devices like
tablet, notebook, mobile etc.
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13.3.1 Test Driven Development (TDD)

This is a new and evolutionary approach where a test is written before the code so
as to fulfil that test.  It starts with developing test for each of the features listed in
the specifications. The web developer then develops the code such that it passes
the test. These tests might fail as they are written before their development.TDD
aims more at specification and less at validation. Some also view TDD as a
programming technique where its goal is to write clean code that works.

The series of steps which constitute TDD are as follows:

a. Understand the specific requirement on which you want to form a test.

b. Create a test such that when executed with the web application it fails.

c. Now create a new code and make the test pass by all possible means.

d. Change the code to remove duplication in your project. This process is called
refactoring. It is done to improve the design while ensuring that all tests (even
added before the current test) still pass. You may make the overall design
changes also.

e. Rerun the tests to confirm that they still pass.

Hence we see that in case of TDD, the requirements are turned into specific test
cases (called Unit tests)  which actually drive the design of the web application.
Such type of testing is also called Unit testing. After each test, refactoring is done
and then the same or similar test is again repeated. This process continues till the
code behaves according to the desired specifications.  Some of the advantages of
TDD are as follows:

a. It reduces debugging time to a great extent. If the test fails, you know exactly
where to look for problem.

b. TDD separates the environmental dependencies such as databases, file systems,
networks etc.,

c. The code is proven to meet all the requirements.  It has near zero defects.

d. The shorter development cycles reduce the time taken by the testing process.

13.3.2 Resolving Bugs

A software bug is an error, defect or a fault that results in an erroneous or invalid
output.  A bug may also lead to system crash.  Most of the bugs are generated due
to human errors in source code or its design which affect the program functionality.
The bugs have caused great damages to the data and software worldwide. They have
spoiled the space research programs, caused explosions and even leaked deadly
radiations thereby claiming human lives.
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One of the aims of a software tester is to find these hidden bugs in the system.
Although the expertise comes with experience, however let us learn some of the
tips that can be used to do so are as follows:

(i) Before starting the testing process, you should have an in depth study of the
entire system.  Understand the minute details and functionality before actually
testing the application.

(ii) Prepare a list of varied inputs or data sets that can be used while testing the
application.  Also use these under various test conditions. This will help you
to test the system under multiple and varied situations.

(iii) Perform repeated tests with different data sets and that too on different
platforms and environments.

(iv) Generate result sheets for each set of data inputs given and then compare the
outputs produced from these result sheets.  Check out for any specific pattern
of errors or outputs being generated through these result sheets and analyse
them to find out any bugs in the application.

(v) One should also try some standard test cases that might have been used in some
other web application and were successful in finding a bug there.

Once a bug is detected, you can modify the source code and resolve the bug. Always
remember that finding a bug and resolving might be a very time consuming and
tedious process.  Sometimes it becomes very hard to resolve a single bug in the
system.  So, to avoid a bug going undetected, you should be patient while testing
the web application for bugs.  Have a methodological approach and use the tips
given above for successfully resolving bugs in a web application.

13.3.3 Test matrix

Test matrix or Traceability Matrix is simply a spreadsheet that lays the various
test cases and its results in the form of a table. It traces and maps the test cases
according to different functionalities of the web application been tested.  It can be
implemented at the module, function or even field level and is aimed at identifying
different permutations of data for each test case at that particular level. The more
permutations of data are covered in the test matrix, the better it is for the application
being tested.  Since a test matrix shows the relationship between the functional
events and the test cases, the complete test matrix defines the conditions that must
be tested during the test process so as to verify the proper functioning of the
application system.  Let us learn how to create a test matrix.  The following steps
should be completed.

● List the objects that you are testing on the rows.
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● Show the tests on the columns.

● In the cells so formed, mark the tests that you have actually completed.

A test matrix consists of the following:

● Revision history of the application: It consists of name of the software tester/
author of the application, date of testing and any other relevant information
about the testing process.

● Business Requirement of the application being tested: This part of the test
matrix indicates the ID and objective of the test case, any unsolved issue
waiting for the clarification from the client etc.

● Coverage Matrix: It consists of test condition ID , the test case being referred
with case number, the test item (whether it is a condition or data or interface
and so on), test condition with validations, if any etc. A cross is placed in front
of the test condition corresponding to the test case in which it is being tested.

● Case Objective: It consists of the test case number, aim of the test case and its
associated conditions. It also indicates if any additional information has to be
provided.

● Test Data: It consists of test case number, aim of the test case as per conditions
and the test data needed prior to the execution of that particular test case.

● Traceability: It indicates the screen that is being tested with each test case. A
cross is placed corresponding to the screen number and the test case being
referred.

● A grid of various output options and parameters of testing.

Let us consider the following example containing the login page from a website
named

WordPress.

Fig 13.1 : WordPress Login screen
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The two fields that have to be entered in the above given login page are username

and password. Also there is a check box (Stay signed in) and a Log In button on the

page. The user may enter any data in the two text boxes, may or may not click the

checkbox and then click on Login button to initiate the login process.

So the test matrix for the above login screen would need the following test cases:

● Different permutations of username and password;

● Outcome of clicking the checkbox;

● Outcome of clicking the Log in button.

Based on these parameters, the test matrix will be as follows:

Fig 13.2 : Test matrix

In the above test matrix, you can see the test cases in the first column, the data is in

the second column and the expected result is in the third column.  The details like

reference id, name of the author/software tester, date of test etc., are given on the

top right of the test matrix.  The various test cases are listed from rows 6 to 15. The

x’s denote which permutation of each parameter is to be used for that particular

test case. So you can have an overview of what full test coverage looks like. Also

any change in the system that affects any one or more of the parameters can be

easily identified using this test matrix.

Therefore a test matrix groups similar test cases through which you can check aspects

like how the field handles boundaries, if there is any unexpected input, usage of

function keys etc.
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 INTEXT QUESTIONS 13.2

1. Fill in the blanks.

a. _____________ testing is used to check the user friendliness of the web
application.

b. ______________ testing is done to check the web application against
unauthorized access and data theft.

c. ____________ is the process in which code change takes place to
remove duplication in the project.

d. A _____________ shows the relationship between the functional events
and the test cases.

13.4 QUALITY OF SERVICE (QOS)

The web services have expanded manifold over the couple of years. With this
widespread expansion, the quality of service (QoS) has become a distinguishing
factor for the selection of a particular web service.  QoS includes both service
usability and utility as it refers to the properties of the web application service such
as performance, reliability, availability, security etc. Changes in network traffic
patterns, denial-of-service attacks, infrastructural failures, low performance of web
protocols and security concerns create a need for QoS standards.  But delivering
QoS to the users of a web application is undoubtedly a challenging task because of
its dynamic and unpredictable nature. Still QoS is becoming an important selling
and differentiating point of all available web services and applications. The major
aspects for delivering a good QoS are as follows:

• Availability:  It is the aspect of QoS where the web application requested by
the user is readily available.  The web application should be available
immediately when it is invoked or requested.  Also associated with availability
is time-to-repair (TTR).  TTR represents the time taken to repair a web
application service that has failed.  Ideally smaller values of  TTR are desirable.

• Accessibility: This aspect of QoS defines the degree to which the web
application is capable of serving a client’s request.  There could be situations
when a particular web application may be available but not accessible.  This
is certainly not good quality of service.  The web application service should
be able to consistently serve the requests despite increase in the number of
requests. This can be achieved by making highly scalable systems that can
handle increased number of users efficiently.
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• Integrity:Integrity of a web application can be of two types – Data integrity
and Transaction integrity.  Data integrity checks for any modification of data
in the web application. On the other hand, transaction integrity refers to the
correctness of transaction of a web application.  For a transaction to be
complete, a series of activities have to be performed.  For example to make
online payments, selecting the payment mode, entering the account details to
be debited and credited, entering the password, confirming the details entered
and finally clicking the submit button are all part of the same transaction.  All
these activities have to be completed to make a successful transaction.  If any
of the activity fails, the entire transaction is nullified. This reduces the QoS of
the application.

• Performance: This is another aspect of QoS which measures how fast a
service request can be completed. It is measured in terms of throughput and
response time. Throughput is the number of web service requests served at a
given time period while response time is the round trip time between sending a
request and receiving a response. To achieve good performance, a web
application should have higher throughput and faster response time values.

• Reliability: This aspect of QoS measures how much service quality a given
application can maintain. That means it refers to the ability of the web service
to perform the required functions understated conditions for a specified time
interval. Reliability is ensured by ordered delivery of messages being
transmitted and received by service requesters and service providers. It is
measured by the number of failures in a given time period (day, week, month
or year).  Lower the number of failures, higher is the reliability and better is
the QoS of the web application.

• Regulatory: This is the aspect of QoS in which a given web application must
work in conformance with the laid down rules and standards and also with
established service level agreements.  It is important to adhere to the correct
versions of every standard for each and every web application.

• Security: This is one of the most important quality aspect for any web
application. Since web applications are available to anybody and everybody
on the Internet, security is a growing concern in the field of web development.
The security of a web application involves providing the following:

(i) Allowing access to only authorized users. These users must be
authenticated for using the services of the given web application.

(ii) Maintaining confidentiality of the data and users. Only authorized users
must be allowed to access or modify the data.

(iii) Data encryption.
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(iv) The service provider should be held accountable for the service being
provided. It should be possible to trace out when the request was made
and when it was serviced.

 INTEXT QUESTIONS 13.3

1. Give one word for the following.

a. This is a new and evolutionary approach where a test is written before
the code so as to fulfil that test.

b. An error, defect or a fault that results in an erroneous or invalid output.

c. A spreadsheet that lays the various test cases and its results in the form
of a table.

d. The correctness of transaction of a web application.

 WHAT YOU HAVE LEARNT

In this lesson you have learnt about web application and its features. You have also
learnt about web application development process which includes analysis, design
and testing.  While analysing, we first do requirements gathering (Elicitation), then
form specification documents and then do the validation and verification. While
designing, we must take care to incorporate all the requirements given by the users.

Testing is one of the most important steps of web development where the web
application is tested for any errors or faults known as bugs. Test driven Development
(TDD) is the latest approach in which the test is created before the code creation.This
lesson also covered the use of test matrix for testing purposes. Finally the lesson
discussed about Quality of Service (QoS) for web applications which includes qualities
like availability, accessibility, integrity, security etc.

 TERMINAL EXERCISE

1. Explain the key features of a web based application.

2. What are the techniques that can be used for elicitation purposes. Explain anyone
of them in detail.

3. Differentiate between brainstorming and sketching techniques of elicitation.

4. What points should be kept in mind while designing a web application?
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5. Differentiate between functional testing and performance testing.

6. Name any three tasks that should be performed while testing a web application

for security.

7. Explain briefly about TDD.

8. Give some tips to resolve bugs in a web application.

9. List the components of a test matrix.

10. Explain briefly the different aspects of QoS for a web application.

  ANSWERS TO INTEXT QUESTIONS

  13.1

1. a. True

b. True

c. True

2. a. Validation

b. Brainstorming

c. web application

d. Elicitation

e. Requirements specification

 13.2

1. a. Usability

b. Security

c. Refactoring

d. Test Matrix

 13.3

 1. a. Test Driven Environment

b. A software bug

c. Test Matrix

d. Transaction Integrity
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14

SAFETY AND SECURITY

We are living digital era in which the world is becoming more and more digitally
sophisticated. From the time when Internet was developed, the technology has
evolved manifold. And with this has grown the use of Internet. Today, just with the
click of a button, we can search for any information, download software, do online
transactions with e-commerce, e-governance etc. But with the growing use of
Internet, cases of cybercrime have also grown. The cases of data theft are not
uncommon on the Internet. In this lesson we shall discuss the issues related to safety
and security of a website.

OBJECTIVES

After reading this lesson, you will be able to:

• define breaches;

• classify breaches;

• learn how to report breaches;

• discuss the importance of Cyber security.

14.1 BREACHES

A security breach or a security violation is any act from a malicious intruder like
hacker or cracker that results in unauthorized access of data, application, services
etc., from a private network or application. This is done by violating the security
policies, practices or mechanisms of the affected website or web application. This
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may lead to heavy damage to the data or to organization whose web application is
being intruded. That is why the organizations regularly monitor these breaches using
various security tools like firewalls. But every organization has to understand the
different types of breaches in order to understand them and fight against them.

14.1.1 Types of breaches

Breaches can be caused due to various factors and these causes lead to various types
of breaches. The reason for the breach differentiates it from another. Based on this,
the main types of breaches are as follows:

• Human Errors

• Physical theft

• System Glitches

• Skimming

• Cybercrime

Human errors

According to a survey done of 1500 breaches in 2014, it was found that human errors
cause most of the breaches.  It was also found that these breaches cause
comparatively less damage as compared to other types/causes.  Some of the human
errors that lead to breaches are as follows:

• Losing or inadequately disposing off data. For example, the hard copies
may be disposed without destroying them and then they might fall in
wrong hands.

• Making private information publicly available on the Internet by mistake.

• Losing a laptop, mobile phone or any storage device such as hard disk
containing sensitive information. This may also be categorized as physical
theft as you will read in the next sub section.

• Delivery of sensitive information to a wrong person. This may be done
by email, fax, post, messaging or even in person.

In a potential data breach in US, ten million records of US military veterans was
reported.  It was found that the breach occurred because the agency had sent a
defective hard drive for repair and recycling without first destroying the data.

It must be noted that when the human error does not directly cause data breach or
exposure of sensitive data but creates conditions that make theft or hacking easier,
then the said breach comes under cybercrime or cyber attack. You will read about
this type of breach in the coming sections.



260 :: Safety and Security

Notes

 WEB DEVELOPMENT

Physical theft

In this type of breach, a criminal physically steals information by means of hardware
or software theft. The malicious thief may steal a computer, portable memory device
like hard disk or CDs, customer details etc., from a private computer or network.
Such incidents of physical theft account for more than 20% of the total breaches.
Stealing laptops of defence personals containing confidential information is
commonly heard.

To avoid physical theft, it is important that data storage and processing areas have
a very restricted access with frequent monitoring. Other policies and procedures
that should be encouraged are BYOD(Bring Your Own Device), giving remote
access, locking and protecting of computers and mobile devices, disposing off the
old data and giving adequate training to the employees regarding security breaches.

System Glitches

A system glitch is a sudden and unexpected technological failure of the system or
network. These may include both software and hardware failures. Generally system
glitches are temporary and are rectified after a short span of time. Some of these
are listed below:

• Programming errors, especially for transferring of data. For example a system
may be programmed for automatic backup without proper authentication.

• Loopholes in the system that allow data to be leaked corrupted or destroyed.
This is generally related with authentication program failures.

• Problems arising while updating the system or any software on the system.

• Wrongful access of data due to accidental data dumps.

• Failures while recovering data after a hard disk crash or any other such problem.

To some extent, system glitches can be reduced by taking following preventive
measures:

• Have proper staff for monitoring, measurement and review of data. This ensures
smooth functioning of the system and networks.

• Update or uninstall outdated software or hardware that is prone to crashing.

• Follow standards, policies and procedures that are laid down and accepted
internationally.

Skimming

Skimming is stealing the data contained on the magnetic strip of credit and debit
cards. The magnetic strip at the back of the debit/ credit card contains the entire
information of the card holder viz. account number, expiration date, PIN number,
cardholder’s name and address etc.  The criminals then use this information to
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withdraw money, do fraudulent online transactions or more dangerously to tamper
the personal information which can lead to identity theft and other issues.

There are two ways in which skimming can happen. In the first method, the employees
use small devices to steal information from the credit/debit cards by duping the card
holders when they are out of sight or not vigilant. For example, when you are paying
your bill through credit cards at any of the retail stores, the cashier may use a device
to skim data from your credit card. The second method is that the criminals tamper
with the card readers at POS (Point of Sale) locations such as ATM machines. They
install their own small card readers that steal information from the card when you
are using it. Even miniature pinhole cameras are used to capture the PIN when it is
being entered by the card holder.

Skimming can be avoided by being vigilant. The cardholders should closely monitor
the people around them while using the cards.  Close monitoring can prevent
tampering to a great extent. It is recommended for the banks and other such financial
institutions to open and dis-assemble the POS terminals at regular intervals in order
to check for and avoid tampering. As soon as the evidence of tampering or data
breach is found, the matter should be immediately reported to the cyber-crime cell
and also to the parent bank of which the card is issued.

Cybercrime

Cybercrime is the most common cause of data breach.  The malicious attackers
may indulge in activities like denial of service attacks, data leaks, malware activation
etc.  For example, criminals use applications called packet sniffers to steal data being
shared over secure networks, including financial information and customer’s
personal data. It must be kept in mind that this data theft does not only occur from
outsiders but many times it is seen that insiders i.e. the employees of the organization
itself are involved in these malicious activities.

Sometimes the cyber attackers get inside the organization and spend weeks and
months understanding the security mechanism of the organization so as to devise
means to steal data. That is why it is important not only to detect the breach but
also the very origin of the breach. The cyber criminals are adopting new and
innovative methods to steal data and information. Some of the common attacks being
used by them other than physical theft and skimming are:

• Phishing:Phishing is sending out bulk mails that look legitimate and luring
but these are actually meant to extract financial and personal information from
people. This information is then used to make fraudulent online transactions.
For example, a mail is sent to people saying that they have won a grand prize
and then it asks for the bank account number and other details so as to credit
the prize money to the user’s account. But actually, this information is used for
malicious purposes.  Such e-mails are sent repetitively to deceive the recipients.
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• Pharming: Pharming is installing malicious software illegally on a computer or
network. This malicious software misdirects the unaware users to fraudulent
websites where they are lured to provide personal or other sensitive information
that can be further used for malicious purposes.

• Dedicated Denial of Service (DDoS) attacks:These are designed and used
to block the availability of networks and services to the affected users.  The
hackers may use such attacks to extort money from the affected organizations.
Such type of fraudulent extortion is also known as cyber extortion. One should
always keep our anti-virus updated and should never click the weird and
unsolicited video links seen in your inbox.

• Injecting viruses, worms and Trojan horses:  A virus is a program or simply
a piece of code that affects the host computer by destroying data or corrupting
its system and application files. A virus attack can even cause the entire network
to crash. A virus can replicate itself on the host computer and then infects other
computers as well. Generally viruses spread through emails, pen drives, and
mobile application or through networks.

A worm is a program that spreads and infects the network by copying itself
repeatedly.  Unlike viruses, it does not need a host computer to replicate itself.
These can cause great deal of damage as they have the capability to spread via
the internet in just few minutes. They slow down the network and jam the
communication channels of the network.

A Trojan horse (or simply Trojan) is another category of malware that seems
to be a harmless program but is actually very dangerous. The cyber criminals
send a mail containing an attachment or link to download free software or a
game. When the user downloads it, the Trojan also gets downloaded and affects
the host system. But unlike viruses, a Trojan horse cannot replicate itself.

All these forms of malware can be used by the cyber criminals to affect the services
of an organization. So antivirus software should be installed on the system or
network and should also be regularly updated.

After going through various types of breaches, we can infer that it is very important
for any organization to monitor, identify and protect their network and data from
these breaches.  Criminals generally use a combination of any of the above breaches
to cause maximum damage.  So by installing protective software such as firewall,
unauthorized access by cyber criminals can be prevented.  If any case of intrusion
or violation is detected by the firewall, it issues a notification to the network’s security
administrator.  Some other preventive measures which should be taken as a means
of protection against cybercrime are as follows:

• Ensuring antivirus installation and updating it at regular intervals.

• Installing intrusion detection and prevention software.
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• Maintaining firewalls (as discussed before).

• Keeping activity logs on sensitive networks.

• Following industry standards for virus protection.

14.1.2 Reporting Breaches

A breach may be caused due to any of the reasons explained above. It is important
that the affected organization or person should deal with the security breach
appropriately.  As soon as the breach is found the following actions should be taken:

(i) Every organization must have a recovery plan laid down and as the breach is
detected, it should be immediately brought in to action. The recovery plan
should also include necessary steps for damage limitation.

(ii) The next step is to assess the risks associated with the breach. This includes
assessing the potential adverse consequences or damages caused to the
individuals and also predicting how serious the breach could be. The likelihood
for the breach to occur again should also be assessed.

(iii) After the assessment is done, notification of breaches should be initiated. The
concerned individuals, banks, police or any other regulatory body should be
informed about the occurrence of the breach. If feasible, the media should also
be informed so that more and more people come to know about the breach and
adequate precautions are taken from the user end also.

(iv) Finally, the cause of breach should be investigated. Although this may be a
time consuming process, yet it helps to upgrade the security system of the
organization. Any further such attacks may be avoided by doing so.

To legally punish the cyber attackers and make organizations also responsible for
appropriate security of the personal data they hold, the Data Protection Act (DPA)
has been laid down. The Data Protection Act (DPA) says that:

“Appropriate technical and organizational measures shall be taken against
unauthorized and unlawful processing of personal data and against accidental loss
or destruction of, or damage to, personal data.“

Although DPA puts responsibility and accountability on organizations for security
of their data, yet there are no legal obligations to report breaches. The Information
Commissioner’s Office (ICO) set up in United Kingdom advises to report serious
breaches to this office. Here, the term serious breaches may include any of the
following:

• Private information like one’s name, address, and date of birth, e-mail id, name
of the bank and credit card details when known to others constitutes a serious
breach.  Even if the volume of data loss is low, but if the risks are high the
breach must be reported to ICO.
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• Large volume of data loss where in individuals are at a risk of personal harm
constitutes a serious breach.

• Loss of sensitive information irrespective of the volume of data loss also comes
under the category of serious breach.

The serious breaches should be reported and notified to the ICO under the Data
Protection Act(DPA).  Section 55 of DPA also allows us to report unlawful obtaining
of personal data. In case of security breach that occurs through or within telecoms
and internet service providers, the breach should be notified to the ICO under the
Privacy and Electronic Communications Regulations (PECR).

INTEXT QUESTIONS 14.1

1. Fill in the blanks.

a. A _________________is any act from a malicious intruder like hacker
or cracker that results in unauthorized access of data.

b. ______________is stealing the data contained on the magnetic strip of
credit and debit cards.

c. ______________is sending out bulk mails that look legitimate but are
actually meant to extract financial and personal information from people.

d. _________________ Act puts responsibility and accountability on
organizations for security of their data.

2. State True or False for the following:

a. Virus is a program or piece of code that affects the host computer by
destroying data or corrupting its system and application files.

b. Skimming is stealing the data contained on the magnetic strip of credit
and debit cards.

14.2  Cyber Security

Advancements in web usage and web technology have also brought greater and
unprecedented threats with them.  Sophisticated and technology driven attackers
steal personal and sensitive information, do fraudulent financial transactions and also
try to destroy or threaten to destroy the essential services available on the web.
These attacks have substantial human and economic consequences and also threaten
national security of the country.

Cyber security is defined as the protection of data, networks and systems from
unauthorized access and malicious attacks that may destroy the data or disrupt the
available services. In today’s era, cyber security is undoubtedly one of the most
critical issues for all organizations across the world.  But before we move further
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with our study on cyber security, let us understand why it is becoming increasingly
difficult to secure the web. The points given below explain the reasons for the same:

(i) The malicious attackers can attack from any part of the globe which makes it
impossible to apprehend the origin of attackers.

(ii) The cyber intrusions are getting sophisticated day by day because of which
the risks are increasing in an exponential manner. One of the most problematic
elements of cybersecurity is the rapid and constantly evolving nature of security
risks.

(iii) The connections or linkages between cyber space and physical systems (storage
devices, servers, and user terminals) are becoming more and more integrated
and complex. This poses a big threat to the infrastructure as it is very difficult
to monitor such complex systems.

Today, organizations and governments together are putting their coordinated efforts
to ensure maximum security on the web.  Large amount is being devoted for this
cause.  Some of the elements of cyber security are as follows:

• Application Security: This element of cyber security involves enhancing the
security of various applications installed on the system or network. The security
mechanisms are embedded within the software development process.

• Network Security: The element of network security involves the network
administrator for monitoring unauthorized access, modification, misuse, denial
of service and other such resources on the network. In addition to authentication
checks of the users, the administrator also checks the privilege rights of users
before granting them access to the network.

• Recovery management:  Once the cyberattack has affected the organization’s
data and services, efforts have to be made to keep the basic functioning of the
organization running in addition to bringing down the recovery cost. This is
the aim of recovery management or disaster recovery element of cyber security.
It also assists in minimizing the damage and instructing the end users about
further course of action.

• Information security: This element of cyber security involves safeguarding
sensitive information from unauthorized access as such information can be used
for fraudulent purposes. Confidentiality, integrity and availability are the three
important attributes of information security.  All these three have to be adhered
for the system to be secured and safe for usage.

• User training and information: All the people using the web and its services
should be informed and adequately trained about cyber security issues. The
organization should conduct workshops and awareness programs for users who
interact with the highly secure systems containing personal or sensitive
information. Even after a breach has occurred, the users should not only be
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informed about the breach but they should also be given tips on data recovery,
minimum loss, reason for breach and precautions to be taken to avoid such
breaches from happening again.

14.3 INFORMATION TECHNOLOGY ACT 2000

The Information Technology Act, 2000 (IT Act 2000 or simply IT Act) is the
primary law in India dealing with cybercrime.  It was notified on 17th October 2000
and aims at providing legal infrastructure for e-commerce in India. These cyber
laws have a major impact for e-businesses and the new economy in India. So, it is
important to understand the various perspectives of the IT Act, 2000.  Its major
objectives are to deliver and facilitate lawful electronic, digital, and online
transactions, and also to diminish cyber-crimes.  The IT Act was further amended
in the year 2008.  Some of the salient features of the I.T Act (including amendments
made in 2008) are as follows:

• The act lays down the offenses, penalties, and breaches in detail.  It also
prescribes punishment for offences such as obscene electronic message
transmissions, child pornography, cheating by impersonation using computer
resource, identity theft, violation of privacy and cyber terrorism.

• It outlines the Justice Dispensation Systems for each cybercrime laid down in
the Act.

• It provides for the constitution of the Cyber Regulations Advisory Committee
as the regulatory body for issues related to cybercrime.

• It defines cyber cafe as any facility from where the access to internet is offered
by any person in the ordinary course of business to the members of the public.

• It defines ’communication device’  as cell phones, personal digital assistants
or combination of both or any other device used to communicate, send or
transmit any text, video, audio or image.

• It lays down that contracts concluded electronically shall not be deemed to be
unenforceable solely on the ground that electronic form or means was used.

• In the 2008 amendment, the word ‘digital signature’was replaced with
‘electronic signature’ to make it a more technology neutral act.

• Section 43A of the act protects sensitive personal data or information possessed,
dealt or handled by a body corporate in a computer resource which such body
corporate owns, controls or operates. If such body corporate is negligent in
implementing and maintaining reasonable security practices and procedures
and thereby causes wrongful loss or wrongful gain to any person, it shall be
liable to pay damages by way of compensation to the person so affected.
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• Section 81 of the act states that the provisions of the Act shall have overriding

effect. The provision also states that nothing contained in the Act shall restrict

any person from exercising any right conferred under the Copyright Act, 1957.

 INTEXT QUESTIONS 14.2

1. Give one word for the following.

a. The protection of data, networks and systems from unauthorized access

and malicious attacks that may destroy the data or disrupt the available

services.

b. This element of cyber security involves the network administrator for

monitoring any sort of unauthorized access.

c. This is the primary law in India dealing with cybercrime.

2. State True or False for the following:

a. Human errors cannot cause cyber breach.

b. A system glitch concerns only with hardware failures.

c. A Trojan horse cannot replicate itself.

d. A serious breach should always be reported.

e. The IT Act 2000 was never amended.

  WHAT YOU HAVE LEARNT

In this lesson you have learnt about safety and security aspects on the web.  You

have also learnt that preventive measures that should be taken by the organizations

in order to prevent cyberattacks.   If a breach occurs, then what measures should

be taken by the organization was then explained.  You have also learnt about that

cyber security and various elements of cyber security, the law governing cybercrime

in India i.e. Information Technology Act 2000.
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 TERMINAL EXERCISE

1. Name the various types of breaches. Also name any two human errors that
can lead to breaches.

2. Differentiate between phishing and pharming.

3. What can be done to avoid physical theft of data and resources?

4. What is skimming? Explain the two ways in which skimming can happen?

5. What actions should be taken as soon as a breach is detected?

6. Explain the various elements of cyber security.

7. Write short note on IT Act 2000.

8. Why is it becoming increasingly difficult to secure the web? Give any two
reasons.

  ANSWERS TO INTEXT QUESTIONS

  14.1

1. a. Security breach b. Skimming

f.  Phishing d.  Data Protection.

2. a. True b. True.

  14.2

1. a. Cyber security

b. Network Security

c. Information Technology Act 2000 

2. a. False

b. False

c. True

d. True

e. False


